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Welcome . 1

&\ 2010
“’HelpConsole  oniine Help

Welcome to the HelpConsole 2010 online help system. Browse through the help pages by clicking on the icons
below or selecting pages in the table of contents to the left. To quickly find specific product information, enter
search criteria in the search box above and click the search button.

g a Ask Us a

If you're unable to find what

Getting Started Installation Basic Functions you're looking for in this help
system, try these alternative
resources:

e 9
¥ « ExtremeEase.com
; Y « Knowledgebase
« FAQ
Advanced Functions  Toolbar Reference FAQ

or contact our support team:

Email: support@ExtremeEase.com

Most Popular Pages

* \Welcome

# General Questions

® Service Pack History

® |nstalling 11S

® Getting Started

# |nstalling the Software
# System Requirements

* |nstallation

# Basic Functions

#* How to run the software

Last Updated: June 1 2010

helpconsole 2010


http://www.extremeease.com/
http://www.extremeease.com/help/knowledgebase/
mailto:support@ExtremeEase.com
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Home > Getting Started

Getting Started

7
HeIpCoﬁ[ggle

HelpConsole 2010 is a browser-based authoring tool specifically for creating web-based
help systems and PDF User Manuals. One of the primary differences between
HelpConsole 2010 and other Help Authoring tools is that the design environment is
completely web-based. This means that HelpConsole 2010 can be installed on your local
web server or uploaded via FTP to any remote server running the .NET Framework.
Authors can design help systems and manuals from anywhere using a standard browser.

Our goal at Extreme Ease is to provide the easiest to use, yet most powerful help authoring tool on the market. Because HelpConsole 2010 is web-
based, it can be integrated into your website allowing authorized employees to instantly update product documentation at any time, from any office.

Output Formats

. Static Help System - Generate a pure HTML version of your Help System
. Dynamic Help System - Authors can update the HelpConsole on your website
. PDF Manual - Generate a user manual based on your Help Project

How to Order How to Get Support What is a Static Help ~ What is a Dynamic What is a PDF Manual?  End-User License
System? Help System? Agreement

See also

* \Welcome

# |nstallation

# Basic Functions

#* Advanced Functions
#* Toolbar Reference
* FAQ
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Home > Getting Started > How to Order

How to Order

|

=

HelpConsole 2010 can be purchased by clicking the link below. After entering your credit card information, you will receive an activation key by email

which can be entered into the evaluation version to register it.

[_Buy cv\-_jl

Also, review the edition comparison matrix at http://www.extremeease.com to view the features included in each product edition.

Credit cards accepted:

Visa

MasterCard
American Express
Discover/Novus
Eurocard

See also

How to Get Support

What is a Static Help System?
What is a Dynamic Help System?
What is a PDF Manual?
End-User License Agreement
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Home > Getting Started > How to Get Support

How to Get Support

Extreme Ease offers free technical support to our customers and companies evaluating our products.

Our technical support team is committed to providing superior support service, and is available Monday to Friday, 9AM-5PM
Pacific Standard Time. We typically answer inquiries within a few hours, and within two business days at most.

Contact Information:
Email: Support@Extremeease.com

Website: http://www.extremeease.com/support.htm

See also

* How to Order

What is a Static Help System?
What is a Dynamic Help System?
What is a PDF Manual?

L]
L]
L]
#* End-User License Agreement
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Home > Getting Started > What is a Static Help System?

What is a Static Help System?

This is a pure HTML help system that does not require a web server to be viewed. A static help system is made up of .HTM pages which can be run on
your harddrive, on a network, from a CD, etc.

A static help system will look exactly the same as a dynamic help system published from the same project. The main difference is that the dynamic help
system can be modified on the fly, whereas a Static help system must be re-published whenever changes are made.

tatic HI System i Dynamic Help System

Lagin

Authors can enter a
usermname and password
to edit the help system

e online Help

fleass a8 e O

1 o Maost Popular Pages
= L =— : . iew most commonly
viewed pages

5 [

Advantages:

« Faster than a dynamic help system

. Can be run anywhere with a standard browser

« Can be distributed on a CD or within a setup file

. Fewer files

« Can be run on any web server such as Apache, Linux, etc.
« Supports all browsers right back to Netscape 1.0 and IE 1.0

Disadvantages:

« Not editable (Updates require re-publish)

« 'Most Popular Pages' feature not supported
« 'Reader Comments' feature not supported
. 'Page views' feature not supported

« Dynamic conditional content not supported
« Dynamic skins not supported

When to Publish a Static Help System?

« If your help system will be run from a CD

« If your help system will be located in a sub folder within your application
« If your help system will be included within a setup file

« If your help system will be run from your network

« If your web server is not running 11S with .NET Framework

See also

#* How to Order

* How to Get Support

* What is a Dynamic Help System?
#* \What is a PDF Manual?

#* End-User License Agreement
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Home > Getting Started > What is a Dynamic Help System?

What is a Dynamic Help System?

A dynamic help system is a centralized help system that runs on an internal web server or on your website. A dynamic help system is made up of server
based .ASPX pages and requires Microsoft 11S and .NET Framework to be installed on the web server. A dynamic help system cannot be run from your
harddrive, on a network, or from a CD. Software developers normally host the dynamic help system on their website and include help links from their
software directly to pages within the help system.

Advantages:

« Create new help systems on the fly

« Track page views and 'most popular pages'

. If hosted on the Internet, authors can access from anywhere
« Authors can quickly make updates or add content

« Can integrate with other web-based applications

« Dynamically specify the skin in the URL

« Dynamically display conditional content

Disadvantages:

« Does not run on non-11S web servers
« Cannot be distributed on a CD or within a setup file
« Slightly slower than static help systems

When to Publish a dynamic help system?

. If you want to be able to quickly update your help system

« If your help system will be hosted on your website

« If your help system will be hosted on an internal web server

« If your authors are located at separate office locations

. If you want to centrallize your company's help documentation

A dynamic help system will look exactly the same as a static help system published from the same project. The main difference is that the dynamic help
system can be modified on the fly, whereas a Static help system must be re-published whenever changes are made.

tatic HI System i Dynamic Help System

Login

Authors can enter a
Cnline Help Ak s .ﬁ usarname and password
to edit the help system

e Cnline Help

== a8 e O

o+ Maost Popular Pages
= — > i View most commonly
viewed pages

= e

See also
How to Order
How to Get Support
What is a Static Help System?
What is a PDF Manual?
End-User License Agreement
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Home > Getting Started > What is a PDF Manual?

What is a PDF Manual?

A PDF Manual is self contained printable document which can be downloaded and distributed as needed. The "PDF" format has become a widely
accepted internet standard for printing and distributing product documentation. Click here for more information about the PDF standard. If you're
computer does not have the PDF viewer installed, it can be downloaded from Adobe's website.

Many companies provide both an online help system and a downloadable PDF manual on their website.

Advantages:

« Very portable. Easily downloaded, emailed, etc.
« Easy to print.

« Retains formatting, regardless of fonts installed.
« Widely accepted Internet standard.

When to Publish a PDF Manual?

« If you want to provide documentation in the form of a book or manual

« If you want customers to be able to download product documentation

« If you want prospects to be able to download a product brochure

. If you want to have hardcopies of your manuals printed and bound by a printshop

A PDF Manual will have the same content as a static or dynamic help system, however will look very different. See the example below:

U pmmrem——— B e
L L TR N R ==

ERIELLF A1 THIE 2 WL

IR

.-

Tm s W GO

See also

#* How to Order

How to Get Support

What is a Static Help System?
What is a Dynamic Help System?

L]
L]
L]
#* End-User License Agreement
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Extreme Ease Software Inc. End User License Agreement

1. License

In this license agreement (“'License Agreement"), you, the purchaser of the license rights granted by this Agreement, are referred to as "Licensee" or
"You." In accordance with the terms and conditions of this License Agreement, Extreme Ease Software Inc. (“Licensor") grants Licensee the non-
exclusive license to use the accompanying software ("Software") and documentation ("Documentation™). In this License Agreement, the Software and
Documentation and any copies or modifications are referred to as the "Licensed Product."”

All rights to and in the Licensed Product, including, but not limited to, copyrights, trademarks, and trade secret rights, belong to Licensor and Licensor
holds title to each copy of the Software. Licensee shall not transfer or distribute the Licensed Product to others, and this Agreement shall automatically
terminate in the event of such a transfer or distribution. Licensee shall not copy or modify the Licensed Product, except that Licensee may copy the
Software for the sole purpose of backup as long as all copyright and other notices are reproduced and included on the backup copy.

2. Term

This License Agreement is effective until terminated. Licensee may terminate this License Agreement by returning the Licensed Product to Licensor.
Licensor may terminate this License Agreement if Licensee breaches any of the terms and conditions. Upon termination of this License Agreement for
any reason, Licensee shall return the Licensed Product to Licensor. All provisions of this Agreement relating to disclaimers of warranties, limitation of
liability, remedies, or damages, and Licensor's proprietary rights shall survive termination.

3. Object Code

The Software is delivered in object code only. Licensee shall not reverse compile or otherwise reverse engineer the Software. Licensee shall not
decompile the code for the purposes of developing a competing product.

4. Limited Warranty

Licensor does not warrant that the functions contained in the Licensed Product will meet Licensee's requirements or that the operation of the Software
will be uninterrupted or error-free. Licensor does warrant that the media on which the Software is furnished will be free from defects in materials and
workmanship under normal use for a period of thirty (30) days from the date of delivery ("Warranty Period"). Any other software and any hardware
furnished with or accompanying the Software is not warranted by Licensor. Licensee's exclusive remedy under this limited warranty is the replacement of
any defective physical media on which the Software is furnished, as provided below. To receive a replacement for defective media under this limited
warranty, return the defective media to Supplier during the Warranty Period, with proof of payment.

EXCEPT AS PROVIDED ABOVE, THE LICENSED PRODUCT IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, AND THE ENTIRE
RISK AS TO THE QUALITY AND PERFORMANCE OF THE LICENSED PRODUCT IS WITH LICENSEE.

5. Limitation Of Liability

LICENSOR'S SOLE OBLIGATION OR LIABILITY UNDER THIS AGREEMENT IS THE REPLACEMENT OF DEFECTIVE MEDIA ACCORDING TO THE LIMITED
WARRANTY ABOVE. IN NO EVENT WILL LICENSOR BE LIABLE FOR ANY CONSEQUENTIAL, INCIDENTAL OR INDIRECT DAMAGES, INCLUDING, WITHOUT
LIMITATION, ANY LOSS OF DATA, OR LOSS OF PROFITS OR LOST SAVINGS, ARISING OUT OF USE OF OR INABILITY TO USE THE SOFTWARE OR
DOCUMENTATION (OR ANY HARDWARE FURNISHED WITH THE SOFTWARE), EVEN IF LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES, OR FOR ANY CLAIM BY ANY THIRD PARTY. IN NO EVENT SHALL LICENSOR BE LIABLE FOR ANY DAMAGES.

6. General

Any attempt to sublicense, assign or transfer any of the rights, duties or obligations hereunder is void, unless Licensee has been given "Reseller" status
by Licensor. This Agreement shall be governed by and interpreted under the laws of the Province of British Columbia, Canada, without regard to
conflicts of provisions.

7. Payment

Licensee shall pay the Total Fee in accordance with the terms of payment set forth by Licensor. Licensee shall pay all invoices rendered by Licensor
within thirty (30) calendar days after the invoice date, or within a time frame agreed upon by Licensor. If Licensee fails to pay any amount due within
thirty (30) days from the invoice date, Licensee shall be responsible to pay to Licensor late charges equal to the lesser of 1.5% per month or the highest
interest rate allowable by applicable law, together with all expenses and collection costs, including reasonable attorneys' fees, incurred by Licensor in
enforcing the Agreement. Licensee shall reimburse Licensor for any out-of-pocket expenses incurred in connection with duties performed by Licensor
hereunder. Upon request, Licensor shall provide Licensee with reasonable documentation evidencing the out-of-pocket expenses incurred by Licensor.

helpconsole 2010
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Home > Installation

Installation

7
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Implementation Checklist
Refer to the checklist below when installing and configuring HelpConsole 2010 on
your PC or web server.

« Check System Requirements

« Install HelpConsole 2010

« Enter the Activation Key

« Assign User Permissions (optional)

« Publish URL to Authors (optional)

« Upload HelpConsole 2010 to your website (optional)

See also

Welcome

Getting Started
Basic Functions
Advanced Functions
Toolbar Reference
FAQ
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Home > Installation > System Requirements

System Requirements

V? | Web Server

« .Net Framework 2.0 or higher

« Windows XP Professional* / Windows 2003 / Windows Vista / Windows 2008 / Windows 7
« 11S 6.0 or higher

. 256 megs RAM

« Harddrive Space: 50 megs

*Note: Windows XP Home edition does not include 1S, therefore is not supported.
*Note: Published static help systems can be hosted on any web server.

Client PC (Edit Mode)

. |E7, IE8, Firefox 3.0, Safari 4.0, Chrome 4.0

Client PC (Live Mode)

« All browsers supported

*Note: Both dynamic and static help systems support all legacy browsers right back to IE1.0 and Netscape 1.0

See also

Installing 1S

Assigning Write Permissions
Installing the Software

Upgrading from HelpConsole 2008
Entering Your Activation Key

How to run the software

URL Parameters

Service Pack History

helpconsole 2010
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Home > Installation > Installing IS

Installing 11S

Internet Information Server (11S) is included with Microsoft Windows XP, Windows 2003, Windows Vista and Windows 2008 and can be installed either
during the installation of the operating system or afterwards. Please select your operating system below for installation instructions:

0 =
4 Serverz003

Moy

Ay

Installing 11S on Installing 11S on Installing 11S on
Windows XP Windows Vista Windows 2003
See also

System Requirements

Assigning Write Permissions
Installing the Software

Upgrading from HelpConsole 2008
Entering Your Activation Key

How to run the software

URL Parameters

Service Pack History
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Home > Installation > Installing 1S > Installing IS on Windows XP

Installing IS on Windows XP

Internet Information Server (11S) is included with Microsoft Windows XP, Windows 2003, Windows Vista and Windows 2008 and can be installed either

during the installation of the operating system or afterwards.

Determine if 1S is Installed

To check if 11S is already installed on the computer you will be using as the web server, select 'Start>Settings>Control Panel>Add/Remove
Programs>Add/Remove Windows Components'. IS is installed if the checkbox next to 'Internet Information Services (11S)" is checked (as shown below).

The Microsoft Windows installation CD provides instructions on how to install 11S specific to each version of Windows.

[] 3 Indexng Service DOME -~
¥ T Intamet Informatic vices [II5]
[0 §2Management and Morstoring Tools
71 5 b e sy | e

Install 11S

Follow the instructions below to install 11S 5.1 on Windows XP:

Pick a category

-
ﬁ- Appear ance and Themes

¥e
-

2. Click the Add/Remove Windows Comionents icon.

%‘_’ Capmndly wRaad [ [ showe gt LT r— -
Chargs
Fotamre
Frograms.
e 8 Aot WETSD S 11w
Frograed
¥ oo neTan S e
D ona S LR
Aok [meriud Marcager & (8 s Ori |
Msiow It Elemerty LS ]
Pt Dt 18 Sae  WAOPE
LES LT
et Faggram 4.3
o & = IuME
Al s B Chartienctor o T = L8R
A Chortete 73 Bt ared Do See 10w ¥

3. Click the checkbox beside 'Internet Information Services (11S)'.

1. Select 'Start' > 'Settings' > 'Control Panel' > 'Add/Remove Programs'

J Printers and (her Hardsare
b

=
L Prtwork ard Interret Conneetions

6 “=

' Date, Tine, Language, and Regional Dptiens

— g# Freiormance and Mantenamcs
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Windpws Compans

Comporani
Wians caorr -k 04 pevmiren: CompOretndy o e .

T 5 oo semmem s corvporart chch S chwoibon & thaded bos mears Sl crke
ot of e Doeporend mell e irtaled T e i robaded 4 Comporend click.

QDME -

2DME
QDME
117mE_

P i gy el g0 bt FadP.
l’—.-ddu:.—un-:h-m

4. Click Next.
5. If prompted, insert your Microsoft Windows installation CD.
6. The wizard will proceed to install 11S.

7. When the installation is complete, click Finish.

See also
# |nstalling 11S on Windows Vista
# |nstalling 11S on Windows 2003

helpconsole 2010
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Home > Installation > Installing IIS > Installing IS on Windows Vista

Installing IIS on Windows Vista

Internet Information Server (11S) is included with Microsoft Windows Vista and can be installed either during the installation of the operating system or
afterwards. There are several IIS options that must be enabled in order for HelpConsole to run. Do the following to ensure that all of these options are

enabled.

1. Select "Start > Control Panel > Programs > Turn Windows Features on or off"

2. Ensure that the following options are selected:

- 1IS Management Console
- .NET Extensibility

- ASP

- ASP.NET

- ISAPI Extensions

- ISAPI filters

- Default Document

- HTTP Errors

- HTTP Redirection

- Static Content

Turn Windows features on or off

bex. A filled box means that only part of the feature is tuned on.

1 [0 4 FTP Publishing Service
= [ b Web Management Tocls
@[]}, 0S & Management Compatibility
[#] ). 05 Management Console
[T] ks 1S Management Scripts and Taols
[T] ). 05 Management Service
E] El_ Ly Word Wide Web Services
= [ |, Application Development Features
@] .MET Estensibility
Wk asp
[ Js ASP.MET
El <ot
[¥] ). ISAPI Etensions
] ), ISAPIFitters
14 server-Side Includes
= [ ), Common Http Features
E )i Default Document
1 Directory Browsing
[@].Ji HTTP Errers
] | HTTP Redirection
[¥] ). Static Content
® [[] ) Health and Diagnostics
@ [ ) Pedormence Features

To turn a feature on, select its check box. Te turn a feature off, clear its check

m

oK |

Cancel

3. Click OK to apply the changes. You may be prompted to restart the computer.

See also
Installing 11S on Windows XP
Installing 11S on Windows 2003
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Installing 1S on Windows 2003

Internet Information Server (11S) is included with Microsoft Windows 2003 and can be installed either during the installation of Windows or afterwards.
There are several 11S options that must be enabled in order for HelpConsole to run. Do the following to ensure that all of these options are enabled.

1. Select "Start > Control Panel > Add or Remove Programs > Add/Remove Windows Components"

2. Select 'Application Server' and then click 'details’
Windows Components Wizard B

Windows Components
You can add or remove components of Windows.

To add or remove a component, click the checkbos. & shaded box means that only
part of the component will be installed. To see what's included in a component, click
Detailz.

LComponents:

Accessones and Utilities 493 ME

Application Server 34.4 ME

[] [ Certificate Services 1.8ME
[ ™0 E-mail Services 1.1 MB
1 @4 Fax Servires 79MR X

Degcrption:  Includes ASP.NET, Intermet Information Services [I15], and the
Application Server Conzole,

Total disk space required: 29 mMB Detals |
Space available on disk: 21603.4 ME e

< Back I Mewut » I Cancel | H el |

3. Ensure that the following components are checked:
- Application Server Console

- ASP.NET

- Enable network COM access

4. Select 'Internet Information Services (11S) and then click 'Details’
Application Server |

To add or remove a component, click the check box. & shaded box means that only part
of the component will be inztalled. To see what's included in a component, click Details,

Subcomponents of &pplication Server:

“E‘n Application Server Consale 0.0 MB ;‘
] B ASPNET 0.0 MB
@ Enable network, COM + access 0.0 MB
O @ Enable network DTC access 0.0 MB

nternet Info

[] =2 Message Queuing T.0MB

-]

Degcription: 115 Includes Web, FTR, SMTF, and NHTF suppart, along with support
for FrontPage Server Extensions and Active Server Pages [A5P].

Total disk space required: 29 MB Bt |
Space available on disk: A1603.0 MB
Q. I Cancel |

5. Ensure that the following components are checked:
- Common Files
- Internet Information services Manager

helpconsole 2010
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- SMTP Service
- World Wide Web Service

6. Select 'World Wide Web Service' and then click 'Details’

Internet Information Services (I15) 5'

To add or remove a component, click the check box. & shaded box means that only part
of the component will be installed. To see what's included in a component, click Details,

Subcomponents af Internet Information Services [I15];

O <> Background Inteligent Transfer Service (BITS] Server Extensions  0.2ME &+
< Common Files 1.0MB
[] §|:| File Tranzfer Protacol [FTP) Service 0.1 MB
O 5@ FrontPage 2002 Server Extensions 14.6 ME
v [E'n Intermnet Information Services Manager 1.3 MB
| @ Internet Printing 0.0MB
[ &5 MNTP Service 1.0MB
i SMTP Service 1.2MB

Dezcription: A core component of 115 that uses HT TP to exchange information with
“web clientz on a TCPAAP network.

Tatal disk zpace required: 29 mMBE Bt |

Space available on disk: J1E02.8 MB

ok, I Cancel |

7. Ensure that the following components are checked:
- Active Server Pages
- World Wide Web Service

World Wide Web Service x|

To add or remove a component, click the check box. & thaded box means that only part
of the component will be inztalled. To see what's included in a component, click Details,

Subcomponents of World Wide Web Service:
™ i Pa

| Internet Data Connector 0.0 B
| Ei Femate Administration [HTRL] 5.7 MB
O Ei Femate Desktop Web Connection 0.4 MB
I @ Server Side Includes 0.0 MB
[] |=]webDay Publizhing 00ME

w] B v orld Wwide \Web Service 19ME T

Description:  Allow ASF files. Active Server Pages iz always installed.

Tatal disk. space required: 29 MB Here e
Space available on disk: HE02.7 MB —l
(6] I Cancel |

8. Click 'OK' on each dialog to save changes.

See also
Installing 11S on Windows XP
Installing 11S on Windows Vista
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Home > Installation > Assigning Write Permissions

Assigning Write Permissions

When HelpConsole 2010 is installed, the default permissions for the folder: “c:\program files\HelpConsole 2010" is ‘readonly’. The setup wizard normally
assigns write permissions automatically, however there may be cases where you need to assign these permissions manually. Please select your
operating system below for instructions specific to that version of Windows:

ay @ £

Write Permissions for Write Permissions for Write Permissions for
Windows XP Windows Vista Windows 2003

See also
System Requirements
Installing 1S
Installing the Software
Upgrading from HelpConsole 2008
Entering Your Activation Key
How to run the software
URL Parameters
Service Pack History
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Home > Installation > Assigning Write Permissions > Write Permissions for Windows XP

Write Permissions for Windows XP

When HelpConsole 2010 is installed, the default permissions for the folder: "c:\program files\HelpConsole 2010" is 'readonly’. HelpConsole 2010 must
have write permissions in order to add help pages and modify the table of contents. The setup wizard normally assigns write permissions automatically,
however there may be cases where you need to assign these permissions manually. Follow the instructions below to assign write permissions for this

folder. This assumes that HelpConsole was installed to the default installation folder.

1. Use the Windows file explorer to display the folder c:\program files\HelpConsole 2010. To load the Windows File Explorer, right click the 'Start' button

and select 'Explore’.

2. Right click the "HelpConsole 2010" folder & select "Sharing and Securi

gram Files
File Edt View Favortes Tooks Help
Qe - @ - (F O seueh |2 poites | G-
Address .f_] Ca\Program Files
Fobders
@?ﬂktm
& (L) My Documants
= T My Computer
= e Local Disk (C1)
1 Audio.temp
=3 Config.Msi
® I3 Documents and Settings
# 1 Inetpub
® 23 M50Cache

B O Adobe DiMicrasoft De ooy
o P, et b :{"lmwnftfmc Paste s

Displays the propesrtios for sharirs) the sslected fokder ;:rhm
. .

Refame

Fropertias

3. Select the 'Security" tab.
4. Select the group: "'Users(<computername>\Users)"

5. Check the 'Full Control' checkbox under the 'Allow' column.

HelpConsole 2008 Properties

| Genesal| Sharng| Secusly |Web Sharing | Customize |

[Group of user names
£ James Dean [NOTEROOK2007ames Dean) ~
€7 Power Users NDTEBOOKZ007\Power Users]
€ SvSTEM

§
§

Peirrissions for Upers
Full Control
Medity
Riead & Execute
Lizt Folder Conberds
Read
il
Commmim] Dhearninsimons

For special pemmizzons of fon advancad settings,
i

Security Tab is Hidden

If you do not see the 'Security' tab, do the following to show it:
- In File Explorer, select "Local Disk (C:)"
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- Select Tools => Folder Options => View Tab
- Unselect the 'Use Simple File Sharing' checkbox

| Gereral| View | Fila Types | Oifine Flex|

Foldet views

"o can apply the view [such as Detals o Ties) that
vou are usmng foe this folder to all Iolders,

[ AoptoslFoders | | BesetdFoides |
Advanced wllings:
] Launch fokdes wirdowe: i a separate process s

12 Managng pars of Web pages and folders
(&) Shiws and mansge the par a3 a single il
2 Shows both parts and manage them indridualy
{2 Shows both parts but manage a3 4 single fle
Remamber each fokder's view selling:
] Restons previows loides windows at logon
[ Show Control Paeedin My Computer
Show encrypied of compressed HTFS fles in color
[¥] Show poprup descriphion for folder and deskiop ibems
Lz simple fle shating [Recommerded]

=~

- Click OK
- Repeat the steps above

Write Permissions for Windows Vista
Write Permissions for Windows 2003
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Home > Installation > Assigning Write Permissions > Write Permissions for Windows Vista

Write Permissions for Windows Vista

When HelpConsole 2010 is installed, the default permissions for the folder: "c:\program files\HelpConsole 2010" is 'readonly’. HelpConsole 2010 must
have write permissions in order to add help pages and modify the table of contents. The setup wizard normally assigns write permissions automatically,
however there may be cases where you need to assign these permissions manually. Follow the instructions below to assign write permissions for this

folder. This assumes that HelpConsole was installed to the default installation folder.

1. Use the Windows file explorer to display the folder c:\program files\HelpConsole 2010. To load the Windows File Explorer, right click the 'Start' button

and select 'Explore’.

2. Right click the "HelpConsole 2010" folder & select "Properties”

)=/ = LocalDik (C) » Program Fikes »
Feiders v | Name st reveedafied Type e
o Flopgy Dick Drive (&) - WT-Tp IS8 1028 . Filie Felder
Bl Locsl Disk () L Agpphe Seftware Updite  1T/04/2008 105 FM  Fili Feskder
& dell ki Ceenmaon Files 010572008 3:56 PM e Folder
S Dareers . e HC200T S22 1370572008 235 PM File Folder
& 15 I i HelpConsole 2007 1352008 240 PR Fie Folder =
B inetpul Ju HelpConzole 2006 TIMEI08 1118 ., File Folder |
& e s Irverniet Explorer Explore
& Neticaped e Mz Maker Open
& Hetseaped 77 rxnhﬂ\h fmesn
W opERAr uid
T- *
& Opend & WS e
& Opensd ds Hetzoape Share..
& Peflog b Reference AemE  Beisers previus versions
ki Pregeam Files A Eafai
£ Temp L Windews Calends Send Ta * -
b Users =~ | cu v
N HelpConsole 2008 Cop
File Folder
|’ Dake modified: 270572008 1118 P Cikate Shofout
| Delete.
Renama
Propeties

3. Select the 'Security' tab.
4. Click the "Edit' button.
5. Select the group: "Users(<computername>\Users)"

6. Check the 'Full Control' checkbox under the ‘Allow' column and then click 'OK'

Obiact nama:  C\Program Fles'HelpCoracle 2008

GrOUD of Libar Names:
B2 CREATOR OWNER

82 5vsTEM
B&, Administratons (ExremeEase-PC' Adminisiratars)
Lsers (EdremaEase-PC Lisers)
2, Trustadintaler

Pamuizsions for Ulsam
Full cortrel

Read & secuts
Lit fisldar eantants

See also
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Write Permissions for Windows XP
Write Permissions for Windows 2003
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Home > Installation > Assigning Write Permissions > Write Permissions for Windows 2003

Write Permissions for Windows 2003

When HelpConsole 2010 is installed, the default permissions for the folder: "c:\program files\HelpConsole 2010" is 'readonly’. HelpConsole 2010 must
have write permissions in order to add help pages and modify the table of contents. The setup wizard normally assigns write permissions automatically,

however there may be cases where you need to assign these permissions manually. Follow the instructions below to assign write permissions for this
folder. This assumes that HelpConsole was installed to the default installation folder.

1. Use the Windows file explorer to display the folder c:\program files\HelpConsole 2010. To load the Windows File Explorer, right click the 'Start' button
and select 'Explore’.

2. Right click the "HelpConsole 2010" folder & select "Sharing and Security"

[ G CO-Fev Drive {01}
& @ Control Pansl

B W My Neetwark Flaces
& Recyck B

B C:\Progeam Files A =101
| e ESt Wew Favortes Dok Heb | &
Qtack = - T | O seach [0 Fobees | (% 3 X 9| -
ﬂdd'uuh;ic:lnwunm: ﬂ @
i * | | ame - Sae[Bpe 4|
3 csner e i Folde
() My Documants Chamak Flera)
= My Computer CComaan e P ra
1 e Local sk (1) (2 ComPhos Fpphcations Flerouy
3 $WINDOWS, ~8T EHelperncie 2007 e ok
1 1) Dascuments and Settiogs e
il Fiy Pl
- iy Pt
o o
5 3 WINGOWS P,
o Fir Fole
Fie Fokde
Fir Fobde—d

j Folde

e Folde
LI

3. Select the 'Security" tab.
4. Select the group: "'Users(<computername>\Users)"

5. Check the "Full Control' checkbox under the "Allow' column and then click 'OK'
HelpConsole 2008 Properties - ﬂll

General | Shaing Secuty | web Shaiing | Customize |

Group or uses names:
[ € Power Users [ANDREANPowes Uses) =
€5 SrsTEM

€7 TERMINAL SERVER USER

1]

Peireizsions for Users
Full Conirol

Mediy

Read & Execule
Lizt Folder Conterds
Read

il

il Dhmarninniomsnn.

=

Fi i 333 for advanced |
;&Mmuu sattings, Adyanced

=]
M
H
=]
=

[Tok ] comes | oo |

See also

Write Permissions for Windows XP
Write Permissions for Windows Vista

helpconsole 2010



24 . Installation

Home > Installation > Installing the Software

Installing the Software

The setup program will install 'HelpConsole 2010' to a folder that you specify. If the software will be run in a network environment, it is a good practise
to install to a designated web server. Ensure that your workstation or web server meets the recommended requirements as outlined in System

Requirements.

Follow the steps below to install HelpConsole 2010:

1. Download HelpConsole 2010 from htt| ://www.extremeease.com/Download.htm. The following message will appear. Click ‘Run’.

| Do you wand 1o A oF sive Dhis file 7

M Hame: heiprontsle 0tetup.exe
Type: Agploation, 25.TME
Frodn ears e ST

[ Bn ][ swe |[ Cocd |
e Thes fzem e Intemat mh;:qm
potentisly ham your compter. | trust the sounce, do not
Fun O s this software. 0

2.0nce downloaded, the following '"Welcome' screen will appear. Click 'Next'.

© i B Eae: Safrmare bo.

cia [pema ][ gees ]

d to accept the license agreement. Check 'l agree’ and then click ‘next' to continue the installation.
e T e

(Bl i i i S ik B4 T80 B 4 P L Pl

R L L I R —

¥ gt 50 ot e ol ol 3618 Lirenas Agreement
Ccted g ] [ gwed ]

Il to. The default installation folder is "c:\program files\HelpConsole 2010". Click 'Next'.

Destination Folber &r.]l
i deitiation fotder b schas Bes =
‘| S -

17 o wacn bl e e choew en oer , ok e,

o FleaPobtarack 2020 ]

PR AR M I, TRk Bsati TOHET M

Costed [ s | [ gwe ]
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Henis Folder ll
B i ke B L] ey b

.': Setup vl eate P0ries 1 Fe toloerg s ke
T Py (o e fder o el beloe.

HelpCorse 200 -

Costes et ] [

Completing the HelpConsale 2010
Setup Wizard

et b st hully st Pl 1903 00 e
computer,

Cick Finigh i et 5wk,

7. A shortcut will be created on your start menu
|

[ Windows Media Player
i@ Windows Mobile Device Center
& windows Updite
- KPS Viewer
b Bigeranies
. Canvtasia Shudio &
o Citrix
. DWD MovieF actory for TOSHIBA
. Epecor
. Flash Shdeshen Maker Professional
. Games
Geogle Chucene
¢ HelpConsole 2007
- HelpConsole 1008
. HelpConsole 2000
i, Helploniole0lD
. HTML Help Werkshop
o Itel® Matrix Storage Manager
Maintenance
o Micresoft NET Framework 50K w20
. Mhcresoft Office
¢ Microzoft S0L Server 2005
o Mheiededt S0 Server 2008
o Mlicrosoft Visusl Studio 2005

Back

8. HelpConsole 2010 can also be run by entering Iocalhost/heleconsoleZOlO in your browser.

E HelpConsole 2010 - Presented by TOSHIBA Leading Innovatici
N ==

@O = ‘EI localhost/helpconsole2010 v‘ ] | N | ¥ |

A Covereitnr | @000~ v mman | 1 : M
See also

System Requirements

Installing 1S

Assigning Write Permissions
Upgrading from HelpConsole 2008
Entering Your Activation Key

How to run the software

URL Parameters

Service Pack History

5. You will be given the select a menu folder. Ensure that "HelpConsole 2010" is selected and then click "Install”
e e

. Click 'Finish' to complete the installation.

6. When complete, a message will appear indicating that the installation was successfull
% Melplorssie 000 - Drtreme Lave Sofwae ﬁ
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Upgrading from HelpConsole 2008

Follow the instructions below to upgrade from HelpConsole 2008 to HelpConsole 2010.
1. As a precaution, backup any active HelpConsole 2008 help projects.
2. Refer to "Installing the Software" to install HelpConsole 2010

3. Copy any HelpConsole 2008 projects to HelpConsole 2010. This can be done by backing up the project in HelpConsole 2008 and then clicking 'upload'
on the 'manage projects' form in HelpConsole 2010.
4. Open the

project in HelpConsole 2010 by double-clicking the project name or selecting the row and clicking ‘open’

5. When the project is opened, HelpConsole will detect that it is in a previous format and ask if you want to upgrade it to 'HelpConsole 2010’
format. Once the upgrade is complete, the project can no longer be opened in HelpConsole 2008.

# Helploessle Projen Uggrade - mqmmm::‘_gﬂﬁ
G'\_J’ 8. hitp locslhant ralprcmciell w | BY ) 6| X J‘,H)., B~
i Frveies | g8 HelpCaniols Project Up- Bi= @ -0 @ - Bugee Safeys Took=
Upgrade Project

Upgrade Project: Widget Master Help s
nnmptlmwumwdudnvdﬂu-m vt beipCargoie 2000, Ore gy aded, e ot

e opaered et Bhe rvcus venmon of e saftwany [elConacie 2008, Clck e Ungrace bution
saw-uu.

[ Upgrade _

Dene VR Local intrimet | Frotected Mode: OF fir Rlms -

Note: Most aspects of the help project are upgraded when you move from HelpConsole 2008 to HelpConsole 2010, however if a skin was customized in
HelpConsole 2008, those changes will need to be re-applied after upgrading.

See also

System Requirements
Installing 11S

Assigning Write Permissions
Installing the Software
Entering Your Activation Key
How to run the software
URL Parameters

Service Pack History
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Entering Your Activation Key

While evaluating HelpConsole, the activation key prompt will appear when a project is opened or a new project is created. After the activation key is
entered, this prompt will no longer appear. The activation key is provided when the software is purchased, and when entered, registers the software.

If an activation key is not entered, the software will start in evaluation mode, and will no longer function after 30 days.

Activation Key

Please Enter Your Activation Key

Please enter your activation key. If you dick Evaluate’, you'l
have 30 days remaining to evaluate HelpConsole 2010, For

ordering information visit us at http:/fwww.ExtremeEase ., com

Activation Key:
|| | ( Activate Now

Edition to Evaluate:
' Professional Edition Ml Evaluate

If a valid activation key is not entered within 30 days of installing helpconsole 2010, a message will appear stating that the evaluation has expired and
the software will not run.

Activation Key

Please Enter Your Activation Key :’1

Your 30-day evaluation has expired,
Please wisit http: /fwww ExtremeEase.com for ordering
information.

Activation Key:

| [ Activate Mow

Note: After an activation key has been entered, a new activation key can be entered at any time. For example, a customer that initially purchases the
lite edition mayv later uparade to the professional edition. The new activation kev can be entered via the 'About’ form on the tools menu.
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HelpConsole 2010

Professional Edeion
Service Pack O
10 named users

D Extrema Ease Softwars Inc.

e Actvaen Key: Actvate Bow

Note: when a static help system is published with the evaluation version of HelpConsole 2010, a message will appear on each help page stating that the
help system was created with the evaluation version. This message will not appear after the activation key is entered.

Thiz Help System
was created with the
evaluation version of
HelpCaonsole

See also
System Requirements
Installing 11S
Assigning Write Permissions
Installing the Software
Upgrading from HelpConsole 2008
How to run the software
URL Parameters
Service Pack History
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How to run the software

If HelpConsole 2010 was installed on an individual PC and will be run by one person, the software can be run from the Start Menu as shown below. If
HelpConsole 2010 will be run in a network environment from a web server, users need to enter the URL address directly into their browser.

Running from an Individual PC
To run the software from the start menu on a computer that HelpConsole 2010 was installed to, follow the instructions below:

% Click Start > All Programs > HelpConsole 2010 > HelpConsole 2010
|

3 Windowd Medu Flayer -
g Windows Mobile Device Center
# indeud Updite
| KPS Viewer
Agcerratien
Canvtasia Studio &
Citrim
DD MovieF sctory for TOSHIBA
Epscor
Flash Sdeshenw Makes Professional
Games
Google Chioene
HelpConscle 2007
HelpConiole 2008
HelpConsode 2000
B & HelpConsoledum
HTMIL Hedp Werkshop
Il E Matrix Sorage Manager Default Programns
Maintenance
Micresoft NET Framework S0K w20 Help and Support
Mhereadt Offie
Microzoft 301 Server 2005
Mhgiedalt 300 Server 2008
Microsoft Visual Studio 2005 -

Gamses

Computer

Control Pamel

Devices and Printers

1 Back

2. The HelpConsole 2010 'manage projects' page will appear.

B oo T013 - Prmsended by TCSSEIA Lsadieg Tncvon >+ "_ S
0‘ v (B o oo v 2 - YL | v oo
W e Helploracls MUE -~ m o P ey g

W Lol st | Pt bhesde. 08

Running from a Web Server
If HelpConsole 2010 was installed to a web server, users will enter the application URL address directly into their browser.

The syntax is:  http://<servername>/helpconsole2010

Examplel: http://WebServerl/helpconsole2010  (Running on an Intranet)

Example2: http://www.MyDomain.com/helpconsole2010  (Running on the Internet)

Example3: http://www.MyDomain.com/helpconsole2010/helpprojectl  (open a specific help project)
See also
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System Requirements

Installing 1S

Assigning Write Permissions
Installing the Software

Upgrading from HelpConsole 2008
Entering Your Activation Key

URL Parameters

Service Pack History
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Home > Installation > URL Parameters

URL Parameters

& | http:/fwebserverl /helpconsole2010/helpprojectl -

Dynamic Help Console Parameters

Parameter Description

Pageid Displays the specified page when a help system is opened.

Syntax: default.aspx?pageid=<Page ID>
Examplel: WebServerl/helpconsole2010/helpprojectl/default.aspx?pageid=faq
Example2: http://www.company.com/help/helpprojectl/default.aspx?pageid=faq

Skin Applies the specified skin when a help system is opened.

Syntax: default.aspx?Skin=<SkinName>
Examplel: WebServerl/helpconsole2010/helpprojectl/default.aspx?skin=blue

Example2: http://www.company.com/help/helpprojectl/default.aspx?skin=blue

Search Lists pages matching the search text specified in the URL.

Syntax: default.aspx?Search=<SearchText>
Example 1: default.aspx?search=keyword

Example 2: default.aspx?search=keyword&condition=allwords (condition specified)
Example 3: default.aspx?search=keyword&filter=FAQ (filter specified)

Anchor Specifies the anchor to display when the page is loaded.

Example: default.aspx?pageid=Editor_Toolbar&anchor=undo

Merge Pageid Displays a page within an embedded (or merged) project when a help system is opened.

Syntax: default.aspx?pageid=<Project>:<Page ID>
Examplel: WebServerl/helpconsole2010/helpprojectl/default.aspx?pageid=projectl:faq
Example2: http://www.company.com/help/helpprojectl/default.aspx?pageid=projectl:faq

Note: Place a question mark (?) before the first parameter and an ampersand (&) before additional parameters.
Example - WebServer1/helpconsole2010/helpprojectl/default.aspx?pageid=fag&skin=blue

Static Help Console Parameters

Parameter Description

Page Displays the specified page when the help system is opened.

Syntax: default.htm?<Page Filename>
Examplel: WebServerl/helpconsole2010/helpproject/static/default.htm?fag.htm

Example2: WebServer1/MyApp/help/default.htm?fag.htm
* This assumes that your application is running under the virtual directory "MyApp" and the folder
containing your help system is named "help"

Example3: http://www.company.com/help/default.ntm?faqg.htm
* This assumes that your application is running on the domain "company.com" and the folder containing
your help system is named "help"

Anchor Loads the specified page and positions the specified anchor at the top of the page.

Syntax: default.htm?<Page Filename>#<anchor>
Examplel: WebServerl/helpconsole2010/helpproject/static/default.ntm?faq.htm#anchorl

Example2: http://www.company.com/help/default.htm?faq.htm#anchorl
* This assumes that your application is running on the domain "company.com" and the folder containing

your help system is named "help"

helpconsole 2010
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See also

System Requirements

Installing 1S

Assigning Write Permissions
Installing the Software

Upgrading from HelpConsole 2008
Entering Your Activation Key

How to run the software

Service Pack History
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Service Pack History

Download the full installation with the latest service pack from here: http://www.extremeease.com/download/HelpConsole2010Setup.exe
Refer to the following instructions to install a service pack: http://www.extremeease.com/help/knowledgebase/default.aspx?pageid=KB1032

May 28 2010 - Service Pack 1.2

Bug Fixes & Enhancements:
. Skin Error Text - If an error occurs when loading the skin, the message now says 'click the yellow triangle' instead of 'click the edit button'.

. Performance - In some cases, CPU usage went up to and stayed at 30%. This has been fixed.

. Firefox Videos - Media videos stopped working if a page containing a video was edited and saved.

. Edit Style button - When 'edit stylesheet' was clicked in the skin editor, the stylesheet for the current skin was opened, not the skin being edited.
. Project.ldb not found - When doing a backup, the error 'could not find project.ldb’ may have occurred

« Visibility by skin - In page properties, the ‘retract' icon was displayed beside ‘visibility by skin’, but should be 'expand'.

. blue Variable - A variable has been added to display the current skin name in live mode.

. Top Menu variable - The [ top menu ] variable included hidden pages and folders when published to static help.

. Password Protect Dialog - If the 'password protect this form' link was clicked and then the close icon was clicked, the project list was not
redisplayed.

. Popup Placement - Popups are now positioned correctly in Firefox and Safari. This has also been changed so that popups are positioned based on
the position of the link on the page.

. Top Menu Width - The [ top menu ] varaible can now be displayed with a width of 100% or no width defined.

. Stylesheet Scrolling - When editing a stylesheet, if the user clicked anywhere, it scrolled to the bottom.

. Orphaned Pages - A report has been added which displays pages in the database that are not in the contents.

. Hide PDF Pages - Pages in the PDF Template can now be hidden by skin.

. Static Search Title - The browser title was not displayed correctly when search results in a flat static help system where displayed.
. Conditions in Variables - Varaibles containing conditions are now supported in static help and PDF manuals.

« Local Static Help - If a static help system is run from a harddrive, scripts are disabled until the user enables them. Static help systems are now
partially displayed and usable when scripts are disabled.

. Merged Project - If a merged project has child nodes, a message is now displayed indicating that child nodes are not allowed.

« Quotes in page name - If a page name included a variable which contained a double quote, an error would occur in both dynamic help and static
help.

« Dynamic Variables - If a dynamic variable value specified in the URL contained html elements such as <strong>, an error would occur.
. Tools Permissions - The message 'you do not have permissions' may have appeared when opening the tools form.

. Delete skins - If multiple skins were deleted, the session was restarted, and the second skin was not deleted.

. Locked Project - If a project is locked, static help and PDF manuals cannot be published.

« Anchor in Static Help - Anchor specified in URL for static help was not recognized.

. Datasets - The way that dataset find and detail forms was improved.

« Search Highlighting - Text is now highlighted correctly based on the search condition (exact phrase, any words)

« Admin Permissions - The ‘admin’ username will now always have full permissions regardless of the permisisons assigned in the ‘admin’ security
group.

. Contents Width - In Static flat help sytems, long page names may have overlapped with the page.

. Search in URL - Search condition can be passed in the URL (eg: default.aspx?search=icons&condition=anywords).

. Editor Height - The variable editor and page template editor height is now correct when opened in Safari or Firefox.

. Firefox Search - The search button in the advanced window did not work in Firefox.

. Scripts in Page - A property has been added to allow <script></script> blocks in pages

. Favicon.ico - When a help system is displayed, an icon is now displayed in the browser address box based on the project type.

. Aproval Process - A property has been added to force a status to be assigned when pages are added or edited.

. & in Pagename - if the character & is included in a page name, an error will occur if the skin contains the [ top menu ] variable.

« Media Upload Size - The upload size limit for media files was changed from 200KB to 40megs.

April 8 2010 - Service Pack 1

Bug Fixes & Enhancements:

. Edit Skin Images - After inserting an image into a skin, the image path may have been incorrect when saved.

.« Document Manager - When inserting a document using the document manager, the URL format may be incorrect.

« Close Tools Window - The X on the tools window did not cause the window to close.

« HTML View - If a page is switched to HTML view, and then another page is edited, HTML view is still displayed with the previous page content.

. Contents Tabs - After applying the 'Tabs' skin and then publishing, the index tab produced an error when clicked.

« Resize Contents - The contents window can now be resized by clicking and dragging anywhere to the right of the contents. Any existing skins will
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need to be edited and then saved for this to work.
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Home > Basic Functions
Basic Functions

The information in this section explains how to use the most common features in HelpConsole 2010.

J o 4 4 d 4

Projects Context-sensitive Help Skins Table of Contents ~ Working with Tables Working with Images
:\j :\j :\j :\j
Keywords and Index Links Search Publishing
See also

#* \Welcome

®* Getting Started

#* |nstallation

#* Advanced Functions
#* Toolbar Reference
* FAQ
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Home > Basic Functions > Projects

Projects

A help project is essentially an editable help system made up of a contents and HTML pages. Click the links below for more information:

Creating a New Editing a Project Deleting a Project Copying a Project Backing up Your Uploading a Project
Project Project

Setting Project Manage Projects Form  Project Templates
Properties Password

See also
Context-sensitive Help
Skins
Table of Contents
Working with Tables
Working with Images
Keywords and Index
Links
Search
Publishing
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Creating a New Project

Follow the instructions below to create a new HelpConsole 2010 project:

1. Run HelpConsole 2010 to display the ‘'manage projects’ form. Click here for more information about running the software

2. Sel project from, such as ‘Create Help System'

ect a template to create the

3. Enter a name for the new help project, and then click ‘Create Project'.

Pame: Widget Master Helg

| (Create Project

4. Depending on the type of project being created, you will be prompted for information such as 'company name', ‘company website', etc. which will be

disilaied within the iro'ect.
Project Variables
A

These walues wil be dsplaped on various pages throughout the project.
Warables can be changed later by selecting “Tools > Variables',

A Corporalion
SUPPOMERBCTE com
555 555 5EER

hitp e acme.com

hifpfivwew, acme comKEB

skp || OK ]
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5. The new help project will be loaded.
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6. Click 'Edit Page' to edit a page.

7. In edit mode, click the 'more' button on the toolbar to access additional editing functions.

See also

Adding a Page

Publishing a Static Help System
Publishing a Dynamic Help System
Publishing a PDF Manual

Editing a Project

Deleting a Project

Copying a Project

Backing up Your Project
Uploading a Project

Setting Project Properties
Manage Projects Form Password
Project Templates
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Editing a Project
Follow the instructions below to open an existing help system project in edit mode.

1. Run HelpConsole 2010 to display the startup form. Click here for more information about running the software

2. Select the help system project in the list that you wish to edit and click 'open’. If the project doesn't have a password assigned to the '‘admin’
username, you can also click the 'edit' icon at the far right to open directly in edit mode.

Rerame Delete

3. The selected help project will be opened in live mode.

4. Click the 'login' link, and then enter a username and password that has "edit contents’ and 'edit pages' permissions. By default, the 'admin' username
does not have a pasword and has full permissions.
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5. Click 'edit page' to edit the currently selected page, or use the 'edit contents' functions to add pages, delete pages and set page properties.
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6. After clicking 'edit page’, click the 'more' button to access additional toolbar functions.

See also

Adding a Page

Publishing a Static Help System
Publishing a Dynamic Help System
Publishing a PDF Manual
Creating a New Project

Deleting a Project

Copying a Project

Backing up Your Project
Uploading a Project

Setting Project Properties
Manage Projects Form Password
Project Templates
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Deleting a Project
Follow the instructions below to delete a help project.

1. Run HelpConsole 2010 to display the startup form. Click here for more information about running the software

2. Select the project that you want to delete

3. Click the 'delete’ button

4. When prompted to confirm that you wish to delete, click 'OK’

See also

Creating a New Project

Editing a Project

Copying a Project

Backing up Your Project
Uploading a Project

Setting Project Properties
Manage Projects Form Password
Project Templates
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Copying a Project
Follow the instructions below to copy an existing help system project:

1. Run HelpConsole 2010 to display the startup form. Click here for more information about running the software

2. Select the project that you want to copy.

3. Click the copy button.

Copy of Widgea Master Halg]

[ Create Praject ]

4. When prompted, enter a name for the new help project.

5. The new project will be added to the project list on the 'manage projects' form.

See also

Adding a Page

Publishing a Static Help System
Publishing a Dynamic Help System
Publishing a PDF Manual
Creating a New Project

Editing a Project

Deleting a Project

Backing up Your Project
Uploading a Project

Setting Project Properties
Manage Projects Form Password
Project Templates
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Backing up Your Project
Follow the instructions below to create a backup of a help project.

1. Run HelpConsole 2010 to display the ‘Manage Projects’ form. Click here for more information about running the software

2. Select the help system project in the list that you wish to backup and click ‘open’. If the project doesn't have a password assigned to the ‘admin’
username, you can also click the 'edit' icon at the far right to open directly in edit mode.

Rerame Delete

3. The selected help project will be opened in live mode.

4. Click the 'login' link, and then enter a username and password that has "edit contents’ and 'edit pages' permissions. By default, the 'admin' username
does not have a pasword and has full permissions.
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5. Click the tools button to show the 'Tools' menu.
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ﬂ Translations ﬂ About HelpConsole

6. Click 'Backup' to display the ‘backup’ form

7. Specify backup options and then click the ‘Create Backup' button. These backup options allow you to exclude certain folders to reduce the size of the
backup file. This is particularly useful when creating a backup file to send to Extreme Ease Support.

8. The help system project will be compressed into a single file. A link will appear indicating that the backup file was created successfully. Click the 'Click
here to download..' link to download the backup file to your harddrive or your network.
B reate Bakup

Create Backup

9. When the 'File Download' form appears, click 'Save
File Dewnload

Do yous ward ko open or save this file?

{ Hame: Heiplondcie Ji0.dhe tip

1 Type: Compressed (zpped) Folder, £.01MB
Frem: localbhast
Do | [ Swep | [ Concd ]
o | Merys mak: hefore apeneng thia bype of fle -
‘Windes fibes doew e Indemet can b wseful, some fles ertualy
harm your computer ¥ you do nokt trust the source, donot open or
wave i Fle. VWhayt 's the ngk?

10. Next. specify a folder to save the backup file to.
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11. This project backup can be restored at any time by clicking the ‘Browse' button on the ‘Manage Projects' form. For more information see Uploading a
Project

Note: Because the backup feature compresses the help system project into a single file, the project can be moved around from Web Server to Web
Server as desired. If nessesary the file can also be emailed to Extreme Ease technical support for troubleshooting.

See also

Creating a New Project

Editing a Project

Deleting a Project

Copying a Project

Uploading a Project

Setting Project Properties
Manage Projects Form Password
Project Templates
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Uploading a Project

The 'Upload Project' function is normally used to restore a help system project that was previously backed up, or to transfer a project from one web
server to another. Follow the instructions below to upload a compressed project.

1. Run HelpConsole 2010 to display the ‘Manage Projects' form. Click here for more information about running the software

2. Click the 'Upload Project' button.

-
3. Select a project backup file to upload and 'Open’. The file must have a .dhc.zip extension.

Organice = Mew folder i 3 @

¢ Favarites =Ly Wiget Master Help.divc sip
M Deneg >

B Dowmilcads

2 Racent Pisces

4 Libearies
® Decumants
ol Mugic

i Prstustes
B videss

1 Compaber =

File pame: 'Widgen Misites Help.dhe Sip - ARl -

4. The help system project will be added to the list on the startup form. If there is an existing project with the same name, a number will be added to the
end of the project name. See example below:

See also

Creating a New Project

Editing a Project

Deleting a Project

Copying a Project

Backing up Your Project

Setting Project Properties
Manage Projects Form Password
Project Templates
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Setting Project Properties
Follow the instructions below to view and edit properties for a help project.

1. Run HelpConsole 2010 to display the ‘Manage Projects’ form. Click here for more information about running the software

2. Select the help project in the list that you wish to set properties for and click ‘open'. If the project doesn't have a password assigned to the ‘admin’
username, you can also click the 'edit' icon at the far right to open directly in edit mode.

Rerame Delete

3. The selected help project will be opened in live mode.

4. Click the 'login' link, and then enter a username and password that has "edit contents’ and 'edit pages' permissions. By default, the 'admin' username
does not have a pasword and has full permissions.
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5. Click the tools button to show the 'Tools' menu.
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6. Click 'Properties' to display the 'Project Properties' form.

Project Properties

SurtPage: [First Page] Select |

Defdt S | Hue [=]

hewamyleg  Record No Achons [=]

Help Farmat:  Framas TJ

Alow Sript: | False L]

Default Page Status [=]

Deft Contets Mode: | Edit [=]

Derfiault Coramt SIAEE | Vil E‘

Lisers Dataset: =]

Properties Overview:

Property Description

Start Page This is the page that will be displayed when the help project is loaded.

Click the 'Select’ button and select a page from the contents.
If set to [First Page], the first visible page will be displayed when the
help project is loaded.

Default Skin This is the skin that will be applied when the help project is loaded.
Activity Log This determines what user actions are recorded and displayed in the
"Activity Log'.

1. Record All Actions: Both reader and admin actions are recorded.
2. Record Admin Actions: Only admin actions such as 'add page' are
recorded

3. Record No Actions: No reader or admin actions are recorded.

Help Format This is the format in which the help project will be displayed when loaded:
- Frames: Pages are displayed within an iframe.
- Flat: The entire help system window is reloaded when a page is selected.

Allow Scripts Determines if <script></script> blocks can be included in page HTML.

Default Page Status The selected page status will automatically be assigned when new pages

are added or existing pages are edited.
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Default Contents Mode

Default Comment Status

Users Dataset

SMTP Server

This determines if the contents will be in edit mode or live mode when the
user logs in.

This is the status that will be applied when new reader comments are
added. This determines if reader comments are immediately visible to the
public or if an administrator must approve the comment first.

If the help project contains at least one dataset, a dataset can be defined
as a 'Users Dataset'. This connects the dataset with user accounts (Tools >
Users), which allows administrators to store detailed information about
each user account.

This defines the SMTP server to use when sending emails. The format
usually mail.domain.com (eg: mail.acmecorportation.com). If you're not
sure what your SMTP server is, take a look at your outgoing mail server
defined in your email software.

This setting is only required if server does not have a default SMTP server
defined, and if the help project contains at least one dataset and at least
one email trigger.

4. Click 'Save' to apply changes and return to the 'Tools' menu.

See also

Creating a New Project

Editing a Project

Deleting a Project

Copying a Project

Backing up Your Project
Uploading a Project

Manage Projects Form Password
Project Templates
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Manage Projects Form Password

If you are running HelpConsole 2010 on your desktop computer or over a company network, there is probably no need to password protect the 'Manage
Projects' form, however if you are hosting a dynamic help system on your website or a web server that is exposed to the public, it is recommended that
you assign a password to this form to prevent unauthorized users from creating new projects, or deleting existing projects.

To Assign a Password:

1. Run HelpConsole 2008 to display the ‘'manage projects’ form. Click here for more information about running the software
2. Click the 'Password Protect this form' link.

3. The password prompt will be displayed. Enter the password twice. Click 'OK’

4. You will then be prompted for the password each time that HelpConsole 2010 is run.

Yew Pammerd: w0

Confre Pasword: awswasns

To Remove the Password:

To remove the password, click the 'Remove Password' link.

ﬁ Helpro 2

See also
Creating a New Project
Editing a Project
Deleting a Project
Copying a Project
Backing up Your Project
Uploading a Project
Setting Project Properties
Project Templates
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Project Templates

The structure of project templates are exactly the same as help projects. The only difference is that project template folders begin with 'template_". If
ou look at the 'c:\program files\HelpConsole 2010’ folder using the Windows File Explorer, you'll see the directory structure as shown below:
Lol 1 ]

@‘@v .« S3ARI03D003 (C:) » Program Files » HelpConsole 2010 »

Cirganize = 4 Open Irschadde in libsary = Share with = Bumn  Bew folder i+ 0 9
T Favodites . _engine
. App Dats
i Lbraries bin Help Project
| Example Help System -—
M Computer . ternplste_Help System +__iject Ten-lplate
. ternglate_Knowledgebase
W Network . template_Reseller Consale
. ternplate Websie
£ default him

= fevicon.ico

i, HelpCenseleice

(% HelpConsche2010.e0e
HelpConsale 2010 State 73- Shared Shared with: DefaultippPool James
i P File Tl der Date medified: 3/150M10 347 Pa

Create a Project Template

To create a new project template, either copy an existing template or copy an existing help project. Make sure that the folder name begins with
‘template_".

Delete a Project Template

To delete a project template, simply delete the template folder (which begins with '_template’)

Edit a Project Template

To edit a project template, do the following:

1. Rename the template folder so that the name does not begin with 'template’. (eg. 'template_Help System' => 'xtemplate_Help System’
2. The template will appear as a help project on the 'Manage Projects' form.

3. Click the template to open it. Login as 'Admin' to modify the contents structure, page content, etc.

4. After editing the template, rename the folder so that it begins with 'template_'

When the 'Manage Projects' form is displayed, template folders beginning with ‘template_' are automatically displayed as 'Create {template name}'

See also

Creating a New Project

Editing a Project

Deleting a Project

Copying a Project

Backing up Your Project
Uploading a Project

Setting Project Properties
Manage Projects Form Password
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Home > Basic Functions > Context-sensitive Help

Context-sensitive Help

The information in this section explains how to integrate HelpConsole 2010 into your Windows based or web based application. Help links can be made at
the application level, the form level or the field level.

3 Al

Windows Applications ~ Web Applications

See also

Projects

Skins

Table of Contents
Working with Tables
Working with Images
Keywords and Index
Links

Search

Publishing
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Home > Basic Functions > Context-sensitive Help > Windows Applications

Windows Applications

The concept behind context-sensitive help is that users of an application can quickly get help for a specific function or feature that they're currently
using. The easier it is for users to access the help that they're looking for, the happier they will be and the fewer support calls your support team will
receive. Context-sensitive help may be implemented in the following ways:

F1 Key
« Application Level - user opens an application and presses F1 to display the application help system.

. Form Level - User opens a form such as an activation key dialog and presses F1 to display help for that form.
« Field Level - User clicks on a field such as a textbox and presses F1 to display help for that field.

Help Button
« Application Level - user clicks on a help link at the top of the main screen to open the application help system

« Form Level - User clicks on a help link or button beside a field to display help for that specific function.
« Field Level - User clicks on a help link or button at the top of a form to display help for that form.

z' z' z' z' z' z'
¥ ‘ v ‘ v ‘ v ‘ v ‘ v ‘

Windows Application ~ Windows Form Help ~ Windows Field Help Windows F1 Windows F1 Form Help Windows F1 Field Help
Help Button Button Button Application Help
See also

Web Applications
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Home > Basic Functions > Context-sensitive Help > Windows Applications > Windows Application Help Button

Windows Application Help Button

You can add a help button, icon or hyperlink to your Windows application that opens your help system. The instructions below assume that you're adding a help
button to the main screen of your Windows application.

Follow the steps below to add a help button to your Visual Studio 2003/2005 Windows application.

1. Open your Visual Studio Windows application.
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3. Double click the button control to open the code window.

helpconsole 2010



56 . Basic Functions

- Promc  abd o
Frho-FEd ihE o = » Do = [ vemem rREmRA-,
Toabes: & pr— Pr— *  Sckutos fxphue - windeebogicn . § %
S = | [ - DE D g
[ Pubiar Simes Farsl < ig.um-'\-m-«mm-ml
Indarine Fretes, Pindoer, Forme  Fore ¥ i e o
[ Fieies Tore Tos o soaaioie - Aemghirtn
= = LR
|1 Prveste B Berceas_CluskiBydal sssder is Systss.coyess, Friel e is
[ vent, “mLLEL
Pt
R Class
L
Properies LI
2 [80) ]
e Al 2
e W x
rtnmy -
CPudwainbenain’ baeted 00w ndews wn crersin men s ineeewsai el | 43E mecerhib Bk . Be wpabedn beaded 2
L3 »
ey -
Do v}, S Lo =13 e o

4. Add the following code to the "Sub Button1_Click" event:

Open a Dynamic Help System

Private Sub Buttonl_Click(ByVal sender As System Object, ByVal e As System Event Args) Handl es Buttonl.Click
Hel p. ShowHel p(Buttonl, http://ww.extremeease.com hel p/ hel pconsol e 2010)
End Sub

-or-

Open a Static Help System

Private Sub Buttonl Click(ByVal sender As System Object, ByVal e As System Event Args) Handl es Buttonl.Click
Hel p. ShowHel p(Buttonl, "hel p\default.htni)
End Sub

* the url above assumes that the help system is in a sub folder named ‘help*

ShowHelp Syntax: Help.ShowHelp(Parent, URL)
Parent - Name of the button control (Buttonl)
URL - The url of the help system ("http://www.extremeease.com/help/helpconsole 2010")

= e At et MO wes e -

Welbiel Authos P07

Online Help

See also

URL Parameters

Windows Form Help Button
Windows Field Help Button
Windows F1 Application Help
Windows F1 Form Help
Windows F1 Field Help
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Home > Basic Functions > Context-sensitive Help > Windows Applications > Windows Form Help Button

Windows Form Help Button

You can add a help button, icon or hyperlink to a form within your Windows application that opens a specific page of your help system. Follow the steps
below to add a help button to your Visual Studio 2003/2005 Windows application.

1. Open a form (such as a login form) within your Visual Studio Windows application.
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2. Double click the 'Button’ control to add a button to the form. Change the 'text' perty to 'Help'. Drag the button to the desired position.
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3. Double click the button control to open the code window.
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4. Add the following code to the "Sub Button1_Click" event:

Open a Dynamic Help Page (page only, no contents)
Private Sub Buttonl_ Click(ByVal sender
Buttonl. Click
Hel p. ShowHel p(Buttoni,
pagei d=Proj ect _Logi n")
End Sub

As System Obj ect,

Open a Dynamic Help Page (within help system)
Private Sub Buttonl_Click(ByVal sender
Buttonl. Click
Hel p. ShowHel p(Buttonil,
pagei d=Proj ect _Logi n")
End Sub

As System Obj ect,

Open a Static Help Page
Private Sub Buttonl_Click(ByVal sender
Buttonl. Click
Hel p. ShowHel p(Buttonl,
End Sub

As System Obj ect,

"hel p\ project |ogin.htnl)

* the url above assumes that the help system is in a sub folder named 'help’

Open a Static Help Page (within help system)
* Note: a page parameter cannot
so in order
created wi thout franes.
Private Sub Buttonl_Click(ByVal sender
Buttonl. Click
Hel p. ShowHel p(Buttonil,
End Sub

As System Obj ect,

"hel p\ proj ect |ogin.htn)

ShowHelp Syntax: Help.ShowHelp(Parent, URL)
Parent - Name of the button control
URL - The url of the help system

5. Press F5 to run the application. Click the 'Help' button.

By Val

By Val

By Val

be passed when a static help systemis opened from Vi sual
to display a specific page within the help system
See Publishing a Static Help System for

By Val

e As System Event Args) Handl es

"http://ww. extremeease. com hel p/ hel pconsol e 2010/ page. aspx?

e As System Event Args) Handl es

“http://ww. extremeease. com hel p/ hel pconsol e 2010/ def aul t. aspx?

e As System Event Args) Handl es

St udi o,
the static help system nust be

nmore information.

e As System Event Args) Handl es
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® My Windows Applicatian

Logn Help Logn

See also

URL Parameters

Windows Application Help Button
Windows Field Help Button
Windows F1 Application Help
Windows F1 Form Help

Windows F1 Field Help
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Home > Basic Functions > Context-sensitive Help > Windows Applications > Windows Field Help Button

Windows Field Help Button

You can add multiple help buttons, icons or hyperlinks to a form within your Windows application that open specific help pages. Follow the steps below to
add help buttons to your Visual Studio 2003/2005 Windows application.

]
AR E- |- R e F = PN SR Y o s e R.,

L e e " Sotson Cophew - ewdeigicn. 8 8
o BE s

20 T ot ) ot o et B | | e Bt
S

=

2. Double click the 'Button' control twice to add two buttons to the form. Change the 'text' property to 'Help' for both'. Position the buttons beside
the fields that you want to provide help for.
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3. Double click each button to open the code window.
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4. Add the following code to the "Sub Button1_Click" event:

Open a Dynamic Help Page

Private Sub Buttonl_Click(ByVal sender As System Object, ByVal e As System Event Args) Handl es
Buttonl. Click

Hel p. ShowHel p(Buttonl, http://ww.domai n.com hel p/ def aul t. aspx?pagei d=user nane)
End Sub

Open a Dynamic Help Page (within help system)

Private Sub Buttonl_Click(ByVal sender As System Object, ByVal e As System Event Args) Handl es
Buttonl. Click

Hel p. ShowHel p(Buttonl, http://ww. domai n.com hel p/ def aul t. aspx?pagei d=user nane)
End Sub

Open a Static Help Page

Private Sub Buttonl_Click(ByVal sender As System Object, ByVal e As System Event Args) Handl es
Buttonl. Click

Hel p. ShowHel p(Buttonl, "hel p\usernane. htni')
End Sub

* the url above assumes that the help system is in a sub folder named 'help’

Open a Static Help Page (within help system)

Private Sub Buttonl_Click(ByVal sender As System Object, ByVal e As System Event Args) Handl es
Buttonl. Click

Hel p. ShowHel p(Buttonl, "hel p\usernane. htni')
End Sub

* Note: a page parameter cannot be passed when a static help system is opened from Visual Studio, so in order to display a specific page within the
help system, the static help system must be created without frames. See Publishing a Static Help System for more information.

ShowHelp Syntax: Help.ShowHelp(Parent, URL)
Parent - Name of the button control
URL - The url of the help system

5. Press F5 to run the application. Click the 'Help' button.
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See also

URL Parameters

Windows Application Help Button
Windows Form Help Button
Windows F1 Application Help
Windows F1 Form Help

Windows F1 Field Help
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Home > Basic Functions > Context-sensitive Help > Windows Applications > Windows F1 Application Help

Windows F1 Application Help

You can add context sensitive help to your Windows application so that when a user presses the F1 key, the help system is displayed. Follow the steps
below to add F1 context sensitivity to your Visual Studio 2003/2005 Windows application.

1. Open your Visual Studio Windows application.
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2. Set the 'KeyPreview' property for the form to 'True'

3. Double click the form to open the code window.
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4. Select 'KeyDown' from the 'Events' list
5. Add the following code to the "Sub Form2_Keydown" event:
Open a Dynamic Help System

Private Sub Forn2_KeyDown(ByVal sender As Object, ByVal e As System W ndows. For ns. KeyEvent Ar gs)
Handl es MyBase. KeyDown
If e.KeyCode = 112 Then
Hel p. ShowHel p(Me, "http://ww. domai n. com Hel pConsol e 2010 Hel p")
End | f
End Sub

Open a Static Help System

Private Sub Forn2_KeyDown(ByVal sender As Object, ByVal e As System W ndows. For ns. KeyEvent Ar gs)
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Handl es MyBase. KeyDown
If e.KeyCode = 112 Then
Hel p. ShowHel p( Me, "hel p\defaul t.htni')
End | f
End Sub

* the url above assumes that the help system is in a sub folder named 'help’

ShowHelp Syntax: Help.ShowHelp(Parent, URL)
Parent - Reference to the current form
URL - The url of the help system

6. Press F5 to run the application. Press F1 to open the help system.

Press F1 Key
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See also

URL Parameters

Windows Application Help Button
Windows Form Help Button
Windows Field Help Button
Windows F1 Form Help

Windows F1 Field Help
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Home > Basic Functions > Context-sensitive Help > Windows Applications > Windows F1 Form Help

Windows F1 Form Help

You can add context sensitive help to any form within your Windows application so that when a user presses the F1 key, a help topic specific to that
form is displayed. Follow the steps below to add F1 context sensitivity to a form within your Visual Studio 2003/2005 Windows application.

1. Open your Visual Studio Windows application.
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2. Set the 'KeyPreview' property for the form to 'True'

3. Double click the form to open the code window.
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4. Select 'KeyDown' from the 'Events' list
5. Add the following code to the "Sub Form2_Keydown" event:

Open a Dynamic Help Page (page only, no contents)

Private Sub Forn2_KeyDown(ByVal sender As Object, ByVal e As System W ndows. For ns. KeyEvent Ar gs)
Handl es MyBase. KeyDown
If e.KeyCode = 112 Then
Hel p. ShowHel p(Me, http://ww. domai n. com hel p/ page. aspx?pagei d=pr oj ect _| ogi n)
End | f
End Sub

Open a Dynamic Help Page (within help system)

Private Sub Forn2_KeyDown(ByVal sender As Object, ByVal e As System W ndows. For ns. KeyEvent Ar gs)
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Handl es MyBase. KeyDown
If e.KeyCode = 112 Then
Hel p. ShowHel p(Me, http://ww. domai n. com hel p/ def aul t. aspx?pagei d=proj ect _| ogi n)
End | f
End Sub

Open a Static Help Page

Private Sub Forn2_KeyDown(ByVal sender As Object, ByVal e As System W ndows. For ns. KeyEvent Ar gs)
Handl es MyBase. KeyDown
If e.KeyCode = 112 Then
Hel p. ShowHel p( Me, "hel p\ project |ogin.htni)
End I f
End Sub

* the url above assumes that the help system is in a sub folder named 'help’

Open a Static Help Page (within help system)

Private Sub Forn2_KeyDown(ByVal sender As Object, ByVal e As System W ndows. For ns. KeyEvent Ar gs)
Handl es MyBase. KeyDown
If e.KeyCode = 112 Then
Hel p. ShowHel p(Me, "hel p\ project |ogin.htni)
End |f
End Sub

* Note: a page parameter cannot be passed when a static help system is opened from Visual Studio, so in order to display a specific page within the
help system, the static help system must be created without frames. See Publishing a Static Help System for more information.

ShowHelp Syntax: Help.ShowHelp(Parent, URL)
Parent - Reference to the current form
URL - The url of the help system

6. Press F5 to run the application. Press F1 to open the help topic for this form.

Press F1 Key

Project Login

.

See also

URL Parameters

Windows Application Help Button
Windows Form Help Button
Windows Field Help Button
Windows F1 Application Help
Windows F1 Field Help
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Home > Basic Functions > Context-sensitive Help > Windows Applications > Windows F1 Field Help

Windows F1 Field Help

You can add context sensitive help to any field within your Windows application so that when a user presses the F1 key while a field has the focus, a
help topic specific to that field is displayed. Follow the steps below to add F1 context sensitivity to fields within your Visual Studio 2003/2005 Windows
application.

2. Double click a field (such as a textbox) to open the code window.

3. Select 'KeyDown' from the 'Events' list
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4. Add the following code to the "Sub Textbox1_Keydown" event:

Open a Dynamic Help Page (page only, no contents)

Private Sub Text Box1l_KeyDown(ByVal sender As Object, ByVal e As System W ndows. For ns. KeyEvent Ar gs)
Handl es Text Box1. KeyDown
If e.KeyCode = 112 Then
Hel p. ShowHel p(Me, http://ww. domai n. com hel p/ page. aspx?pagei d=user nanme)
End | f
End Sub

Open a Dynamic Help Page (within help system)

Private Sub Text Box1_KeyDown(ByVal sender As Object, ByVal e As System W ndows. For ns. KeyEvent Ar gs)

helpconsole 2010



Basic Functions .

69

Handl es Text Box1. KeyDown
If e.KeyCode = 112 Then
Hel p. ShowHel p(Me, http://ww. domai n. com hel p/ def aul t. aspx?pagei d=user nane)
End | f
End Sub

Open a Static Help Page

Private Sub Text Boxl_ KeyDown(ByVal sender As Object, ByVal e As System W ndows. For ns. KeyEvent Ar gs)
Handl es Text Box1. KeyDown
If e.KeyCode = 112 Then
Hel p. ShowHel p( Me, "hel p\usernane. ht ni")
End I f
End Sub

* the url above assumes that the help system is in a sub folder named 'help’

Open a Static Help Page (within help system)

Private Sub Text Box1l_KeyDown(ByVal sender As Object, ByVal e As System W ndows. For ns. KeyEvent Ar gs)
Handl es Text Box1. KeyDown
If e.KeyCode = 112 Then
Hel p. ShowHel p( Me, "hel p\usernane. ht ni")
End |f
End Sub

* Note: a page parameter cannot be passed when a static help system is opened from Visual Studio, so in order to display a specific page within the
help system, the static help system must be created without frames. See Publishing a Static Help System for more information.

ShowHelp Syntax: Help.ShowHelp(Parent, URL)
Parent - Reference to the current form
URL - The url of the help system

6. Press F5 to run the aiilication. Click a textbox and then press F1 to open the help topic for that field.

usorname: | M—————t— Press F1 Key

See also

URL Parameters

Windows Application Help Button
Windows Form Help Button
Windows Field Help Button
Windows F1 Application Help
Windows F1 Form Help
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Home > Basic Functions > Context-sensitive Help > Web Applications

Web Applications

The concept behind context-sensitive help is that users of an application can quickly get help for a specific function or feature that they're currently
using. The easier it is for users to access the help that they're looking for, the happier they will be and the fewer support calls your support team will
receive. Context-sensitive help may be implemented in the following ways:

F1 Key
« Application Level - user opens an application and presses F1 to display the application help system.

. Form Level - User opens a form such as an activation key dialog and presses F1 to display help for that form.
« Field Level - User clicks on a field such as a textbox and presses F1 to display help for that field.

Help Button
« Application Level - user clicks on a help link at the top of the main screen to open the application help system

« Form Level - User clicks on a help link or button beside a field to display help for that specific function.
« Field Level - User clicks on a help link or button at the top of a form to display help for that form.

Web Application Help Web Form Help Button Web Field Help Button Web F1 Application ~ Web F1 Form Help Web F1 Field Help
Button Help

-
¥ ‘

Popups

See also
Windows Applications
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Home > Basic Functions > Context-sensitive Help > Web Applications > Web Application Help Button

Web Application Help Button

You can add a help button, icon or hyperlink to your Web application that opens your help system. The instructions below assume that you're adding a
help button to the main screen of your Web application.

Follow the steps below to add a help button to your Web application.

1. Open the main page of your web application using an HTML editor such as Visual Studio or a text editor such as Windows Notepad. This is an example
of a simple webpage.

<ht m ><body>
<br ><br>Hel |l o Worl d
</ body></htm >

2. Add the following code to create a 'Help' link that will open your help system when clicked. This link could also be a button or an image.

Open a Dynamic Help System

<ht m ><body>

<a href="http://www.domain.com/help" target=_blank>Help</a>
<br><br>Hell o World

</ body></ht m >

Open a Static Help System

<ht m ><body>

<a href="help/default.ntm" target=_blank>Help</a>
<br ><br>Hel |l o Worl d

</ body></html >

* the url above assumes that the static help system is in a sub folder named 'help’

3. Open the html file in your browser. Click the 'Help' link to display the help system in a new window.

-

e O P OB S

See also

URL Parameters

Web Form Help Button
Web Field Help Button
Web F1 Application Help
Web F1 Form Help

Web F1 Field Help
Popups
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Home > Basic Functions > Context-sensitive Help > Web Applications > Web Form Help Button

Web Form Help Button

You can add a help button, icon or hyperlink to a form within your Web application that opens a specific page of your help system. Follow the steps
below to add a help link to your web application.

1. Open a page (such as a login form) of your web application using an HTML editor such as Visual Studio or a text editor such as Windows Notepad. This
is an example of a simple login form.

<ht m ><body>

<br ><br >

User nane: <input><br>

Passwor d: <i nput><br><br>

<i nput type=button val ue=Logi n>
</ body></html >

2. Add the following code to create a 'Help' link that will open a help page when clicked. This link could also be a button or an image.

Open a Dynamic Help Page (page only, no contents)

<ht m ><body>

<a href="http://www.domain.com/help/page.aspx?pageid=project_login' target=_blank>Help</a>
<br ><br >

User nane: <input><br>

Passwor d: <i nput ><br ><br >

<i nput type=button val ue=Logi n>

</ body></htm >

Open a Dynamic Help Page (within help system)

<ht m ><body>

<a href="http://www.domain.com/help/default.aspx?pageid=project_login' target=_blank>Help</a>
<br ><br>

User name: <i nput ><br>

Password: <i nput><br><br>

<i nput type=button val ue=Logi n>

</ body></ ht m >

Open a Static Help Page

<ht m ><body>

<a href="help/project login.htm' target=_blank>Help</a>
<br ><br >

User name: <i nput><br>

Passwor d: <i nput ><br ><br >

<i nput type=button val ue=Logi n>

</ body></htm >

* the url above assumes that the static help system is in a sub folder named 'help'

Open a Static Help Page (within help system)

<ht m ><body>

<a href="help/default.ntm?project login.htm' target=_blank>Help</a>
<br ><br >

User nane: <input><br>

Passwor d: <i nput ><br ><br >

<i nput type=button val ue=Logi n>

</ body></htm >

* the url above assumes that the static help system is in a sub folder named 'help’

3. Onen the html file in vour browser. Click the 'Help' link to displav the help system in a new window.
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See also

URL Parameters

Web Application Help Button
Web Field Help Button

Web F1 Application Help
Web F1 Form Help

Web F1 Field Help

Popups
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Home > Basic Functions > Context-sensitive Help > Web Applications > Web Field Help Button

Web Field Help Button

You can add multiple help buttons, icons or hyperlinks to a form within your Web application that open specific help pages. Follow the steps below to
add help buttons to your Web application.

1. Open a page (such as a login form) of your web application using an HTML editor such as Visual Studio or a text editor such as Windows Notepad. This
is an example of a simple login form.

<ht m ><body>

<br ><br >

User name: <i nput><br>

Passwor d: <i nput ><br ><br >

<i nput type=button val ue=Logi n>
</ body></htm >

2. Add the following code to create 'Help' links beside each textbox to display specific help for those fields. These links could also be buttons or images.

Open a Dynamic Help Page (page only, no contents)

<ht m ><body>

<br ><br >User nane: <input>

<a href="http://www.domain.com/help/page.aspx?pageid=username' target=_blank>Help</a>
<br >Passwor d: <i nput>

<a href="http://www.domain.com/help/default.aspx?pageid=username' target=_blank>Help</a>
<br ><br ><i nput type=button val ue=Logi n>

</ body></ht m >

Open a Dynamic Help Page (within help system)

<ht m ><body>

<br ><br >User name: <i nput >

<a href="http://www.domain.com/help/default.aspx?pageid=username' target=_blank>Help</a>
<br >Password: <i nput>

<a href="http://www.domain.com/help/default.aspx?pageid=password' target=_blank>Help</a>
<br ><br ><i nput type=button val ue=Logi n>

</ body></ht ml >

Open a Static Help Page

<ht m ><body>

<br ><br >User nanme: <i nput>

<a href="help/username.htm' target=_blank>Help</a>
<br >Passwor d: <i nput>

<a href="help/password.htm' target=_blank>Help</a>
<br ><br ><i nput type=button val ue=Logi n>
</ body></html >

* the url above assumes that the static help system is in a sub folder named 'help

Open a Static Help Page (within help system)

<ht m ><body>

<br ><br >User nanme: <i nput>

<a href="help/default.htm?username.htm' target=_blank>Help</a>
<br >Passwor d: <i nput>

<a href="help/default.ntm?password.htm' target=_blank>Help</a>
<br ><br ><i nput type=button val ue=Logi n>

</ body></ ht ml >

* the url above assumes that the static help system is in a sub folder named 'help'

3. Open the html file in vour browser. Click the 'Help' link to displav the help system in a new window.
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See also

® URL Parameters

#* Web Application Help Button
#* \Web Form Help Button

#* Web F1 Application Help

#* Web F1 Form Help

#* \Web F1 Field Help

* Popups
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Home > Basic Functions > Context-sensitive Help > Web Applications > Web F1 Application Help

Web F1 Application Help

You can add context sensitive help to your Web application so that when a user presses the F1 key, the help system is displayed. Follow the steps
below to add F1 context sensitivity to your Web application.

1. Open the main page of your web application using an HTML editor such as Visual Studio or a text editor such as Windows Notepad. This is an example
of a simple webpage.

<ht m ><body>
<br ><br>My Web Application
</ body></html >

2. Add the following code to capture the F1 key and display the help system.

Open a Dynamic Help System

<htnl ><body onhel p="wi ndow. open(" http://www.domain.com/help’, '_blank');return false;">
<br><br>My Web Application
</ body></ht m >

Open a Static Help System

<htnl =<body onhel p="wi ndow. open(' hel p/ def aul t. ht ni, '_blank");return false;">
<br><br>My Web Application
</ body></htm >

* the url above assumes that the static help system is in a sub folder named 'help’

. Open the html file in your browser Press F1 to display the help system in a new window.
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See also

® URL Parameters

#* \Web Application Help Button
#* \Web Form Help Button

#* \Web Field Help Button

* Web F1 Form Help

* \Web F1 Field Help

* Popups
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Home > Basic Functions > Context-sensitive Help > Web Applications > Web F1 Form Help

Web F1 Form Help

You can add context sensitive help to any form within your Web application so that when a user presses the F1 key, a help topic specific to that form is
displayed. Follow the steps below to add F1 context sensitivity to a form within your web application.

1. Open a page (such as a login form) of your web application using an HTML editor such as Visual Studio or a text editor such as Windows Notepad. This
is an example of a simple login form.

<ht m ><body>

<br ><br>

User name: <i nput ><br>

Password: <i nput><br><br>

<i nput type=button val ue=Logi n>
</ body></ht m >

2. Add the following code to capture the F1 key and display the help system.

Open a Dynamic Help Page (page only, no contents)

<htnl ><body onhel p="w ndow. open( 'http://www.domain.com/help/page.aspx?pageid=project_login', '_blank’);return false;">
<br ><br >

User nane: <input><br>

Passwor d: <i nput ><br ><br >

<i nput type=button val ue=Logi n>

</ body></htm >

Open a Dynamic Help Page (within help system)

<htnt =<body onhel p="w ndow. open( 'http://www.domain.com/help/default.aspx?pageid=project_login', '_blank’);return false;">
<br ><br>

User nane: <i nput><br>

Passwor d: <i nput ><br ><br >

<i nput type=button val ue=Logi n>

</ body></htm >

Open a Static Help Page

<htnl ><body onhel p="wi ndow. open( 'help/project login.htm’, '_blank);return false;">
<br ><br >

User name: <i nput><br>

Passwor d: <i nput ><br ><br >

<i nput type=button val ue=Logi n>

</ body></ ht m >

* the url above assumes that the static help system is in a sub folder named 'help'
Open a Static Help Page (with help system)

<htnl ><body onhel p="w ndow. open( 'help/default.htm?project login.htm', *_blank’);return false;">
<br ><br >

User nane: <input><br>

Passwor d: <i nput ><br ><br >

<i nput type=button val ue=Logi n>

</ body></htm >

* the url above assumes that the static help system is in a sub folder named 'help’

3. Onen the html file in vour browser. Press F1 to display the help system in a new window.
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See also

URL Parameters

Web Application Help Button
Web Form Help Button

Web Field Help Button

Web F1 Application Help
Web F1 Field Help

Popups
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Home > Basic Functions > Context-sensitive Help > Web Applications > Web F1 Field Help

Web F1 Field Help

You can add context sensitive help to any field within your Web application so that when a user presses the F1 key while a field has the focus, a help
topic specific to that field is displayed. Follow the steps below to add F1 context sensitivity to fields within your Web application.

1. Open a page (such as a login form) of your web application using an HTML editor such as Visual Studio or a text editor such as Windows Notepad. This
is an example of a simple login form.

<ht m ><body>

<br ><br >

User name: <i nput><br>

Passwor d: <i nput ><br ><br >

<i nput type=button val ue=Logi n>
</ body></htm >

2. Add the following code to capture the F1 key and display help for the specific field.

Open a Dynamic Help Page (page only, no contents)

<ht m ><body>

<br ><br>

Username: <input onhel p="w ndow. open( 'http://www.domain.com/help/page.aspx?pageid=username’, '_blank’);return false;"><br >
Password: <input onhel p="wi ndow. open( ‘http://www.domain.com/help/page.aspx?pageid=password', '_blank’);return

false;"><br ><br >

<i nput type=button val ue=Logi n>

</ body></htm >

Open a Dynamic Help Page (within help system)

<ht m ><body>

<br ><br>

Usernanme: <input onhel p="w ndow. open( 'http://www.domain.com/help/default.aspx?pageid=username’, '_blank');return false;"><br >
Password: <input onhel p="wi ndow. open( ‘http://www.domain.com/help/default.aspx?pageid=password', '_blank’);return false;">

<br ><br>

<i nput type=button val ue=Logi n>

</ body></htm >

Open a Static Help Page

<ht m ><body>

<br ><br >

Username: <input onhel p="w ndow. open( 'help/username.htm’, '_blank');return false;"><br >
Password: <input onhel p="wi ndow. open( 'help/password.htm’, '_blank');return false;"><br ><br >
<i nput type=button val ue=Logi n>

</ body></ ht m >

* the url above assumes that the static help system is in a sub folder named 'help’

Open a Static Help Page (with help system)

<ht m ><body>

<br ><br>

Usernanme: <input onhel p="wi ndow. open( 'help/default.ntm?username.htm’, '_blank’)"><br >
Password: <input onhel p="w ndow. open( 'help/default.htm?password.htm’, '_blank’)"><br ><br >
<i nput type=button val ue=Logi n>

</ body></ht m >

* the url above assumes that the static help system is in a sub folder named 'help’

3. Open the html file in vour browser. Press F1 to displayv the help svstem in a new window.
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See also

® URL Parameters

#* Web Application Help Button
#* Web Form Help Button

#* \Web Field Help Button

#* Web F1 Application Help

#* Web F1 Form Help
# Popups
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Popups

Instead of opening the entire help system, you can display individual help pages in a popup window. Follow the steps below to add a popup help window
to your Web application.

¥ CxUpmp AR p. im - Windows br
i ; Pl ¥ ¥ K =

¢ # 3 oa o, x S - B o B

Lsermame:
Parpword

Logn | pajp Project Login

PAIERTT A, AR ST FRS VR
A

5 By Comguibes 1

1. Open a page (such as a login form) of your web application using an HTML editor such as Visual Studio or a text editor such as Windows Notepad. This
is an example of a simple login form.

2. Add the following code to display a link for a popup help window.

Open a Dynamic Help Page

<di v id=popup style="width:277; position:absol ute;border: 1px solid bl ack; di splay: none; background-
color:white">

<a href="#" style="cursor:pointer;" onclick="getEl enent Byl d(' popup');e.style.display='none'">
<font face=arial size=1 col or =#DOCECE>cl| ose</ f ont ></ a><br >

<iframe frameborder=no w dt h=275 hei ght =124 src='http://ww. domai n. com hel p/ page. aspx?

pagei d=proj ect _| ogi n' ></i frame></di v>

<a href=#" onclick="e=get El ement Byl d(' popup');e.style.display="";e.style.top=event.clientY
docunent . body. scrol | Top-40;e.style.left=event.clientX docunent. body. scrollLeft;">Hel p</a>

Open a Static Help Page

<di v id=popup style="wi dth:277; position:absol ute; border: 1px solid bl ack;display: none; background-
col or:white">

<a href="#" style="cursor:pointer;" onclick="getEl enent Byl d(' popup');e.style.display=
<font face=arial size=1 col or =#DOCECE>cl| ose</ f ont ></ a><br >

<iframe frameborder=no w dt h=275 hei ght =124 src='hel p/ proj ect |ogin.htn ></iframe></div>

none "~ >

<a href=#" onclick="e=get El ement Byl d(' popup');e.style.display="";e.style.top=event.clientY
docunent . body. scrol | Top-40; e.style.left=event.clientX docunent. body. scrollLeft;">Hel p</a>

3. Open the html file in vour browser. Click the 'Help' link to displav the popup help window.
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See also

® URL Parameters

#* Web Application Help Button
#* Web Form Help Button

#* \Web Field Help Button

#* Web F1 Application Help

#* Web F1 Form Help
#* \Web F1 Field Help
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Skins

The idea behind skins is that you can customize the look and feel for your particular help system without affecting any pages that make up
the documentation. The Skin interface is made up of three sections, the ‘Contents Frame', the 'Page Frame' and the 'Function Toolbar' as shown below:

G ot re e @ T U E A

Gnline Help ™~ Function Toolbar

8 O <

Contents Frame —f—#
4——Page Frame

[ -

The layout for each skin is stored in an HTML file with the format: skin_<name>.htm. (eg. skin_blue.htm).

Each help project has it's own set of skins, which means if you modify a skin or create a new skin, other projects will not be affected. A skin can,
however, be copied from one project to another by simply copying the skin file (eg. skin_blue.htm)

A A A

Applying Skins Customizing an Managing Skins
Existing Skin

See also

Projects
Context-sensitive Help
Table of Contents
Working with Tables
Working with Images
Keywords and Index
Links

Search

Publishing
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Applying Skins

Default Skin

Each help system project has a default skin which is applied when the help system is started in edit mode or live mode. The default skin is defined in Project Properties.
If the skin defined in project properties is not found, the first skin that is found in the project folder is used.

Select a Skin

To apply a different skin while logged in as an administrator, select the skin from the list at the top right corner of the screen. The skin list will only be visible for users
with 'tools', 'publish’ or 'design' permissions.

bt g e 22 - Pratied iy n..—.n.- e
O e TR o :
| et et by i e 58

[T ——r]

More Skins...
Additional skins can be downloaded from the Extreme Ease 'Skin Server'. Click ‘More Skins' and then select the skin to download and apply.

Skin Parameter

The skin can be specified in the URL when the help system is opened by including the parameter ?skin=<skin name=>.
For example: http://www.extremeease.com/help/helpconsole 2008/default.aspx?skin=majestic

See also

* Project Properties

# Customizing an Existing Skin
* Managing Skins
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Home > Basic Functions > Skins > Customizing an Existing Skin

Customizing an Existing Skin

A skin can be customized by editing one or more ‘regions' or by editing the skin stylesheet. The regions that can be edited are:
- Header

- Footer

- Contents Header

- Contents Footer

- Page Header

- Page Footer

(=
H Forbem (&=
] D Online Help
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- PAg
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Tustnat. Faly Ereal:
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Edit Skin Region:

Follow the instructions below to customize a skin region, such as the header:
1. Open the Help System that you wish to modify the skin for.
2. If you are not already logged in, log in as an administrator with 'tools' permissions.

§. Click the yellow triangle to the left of the header
€8 testT - Powered b pConsale 2010 - Presented b

@O hd [En kittp:/flocalhost/helpconsole2010/tes
i Favorites | @ test] - Powered by HelpConsole 2

4. The 'Skin Editor" will be displayed.
Most users at any experience level should be able to make minor customizations such as adding text, adding hyperlinks, adding images, etc. More
advance customizations will require some knowledge of HTML. To learn more about HTML design techniques, visit the W3 Schools website:
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http://www.w3schools.com/

9 13t - Powered by HelpConsole 010 - Presented by TOSHIA Leading lnavation 335 ! e
Q-‘__,- B g R ahes T - SER T/ Sl g B[] x 2 Googie o=
Fovorter 8 4eit] - Powared by HelpConiste 200 B e B -0 e v Bagew Gseyw Tgshe e

My Custom Header

R Local it | Protectes binde: O v RINN -

Options:

- Show More Tools: Click the 'show more tools' icon at the top right of the form to display the editor toolbar.

- Edit Region: Select the region that you want to edit (header, footer, contents header, contents footer, page header or page footer)
- Height: Specify the height of the region

- Edit Stylesheet: edit styles that are applied to the skin

5. Click the 'Save' button to save changes and close the skin editor.

See also

# Skin Editor Toolbar
#* Applying Skins

#* Managing Skins
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Managing Skins
A skin refers to the help system interface that contains the contents window and page window.Skins can be completely customized to suit your

company's specific needs. Most users at any experience level should be able to make minor customizations such as adding text, adding hyperlinks,
adding images, etc. More advance customizations will require some knowledge of HTML. To learn more about HTML design techniques, visit the W3

Schools website: http://www.w3schools.com/

Follow the instructions below to manage skins.
1. Open the Help System that you wish to create the skin for.

2. If you are not already logged in, log in as an administrator with 'tools' permissions.

3. Click the 'Tools' button to display the ‘tools menu'

i Backup i, Properties
Users 2{\ Security Groups

J Variables ) = Skins

== PFage Templates .l Styles

ut HelpConsole

B Insitens B

4. Click 'Skins' to display the 'manage skins' form.

Manage Skins

Copy Skin

1. Select the skin to copy.

2. Click the 'copy' button

3. Enter the name of the new skin.
4. Click 'Copy’

Edit Skin

1. Select the skin to edit.

2. Click the 'edit' button.

3. Select the region to edit.

4. Edit the skin region.

5. Click 'Save' to save chanaes.
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Delete Skin

1. Select the skin to delete.

2. Click the 'delete’ button

3. When the confirmation prompt appears, click 'OK'

Rename Skin

1. Select the skin to rename.

2. Click the 'rename' button

3. Enter the new name for the skin.
4. Click 'Rename’

Download Additional Skins

Additional skins can be downloaded from the Extreme Ease 'Skin Collection'.
1. Click the 'Additional Skins' button

2. Select a skin to download

See also
Applying Skins
Customizing an Existing Skin
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Table of Contents

The 'Table of Contents' provides a treeview format of your the pages in your help system. Pages can be easily added, renamed or deleted at any time
during the development of your help system. Pages can also be dragged and dropped as needed.

Click the links below for more information:

Al Al Al Al Al Al

Adding a Page Adding an External File Adding a Website or  Embedding another Renaming a Page Deleting a Page
Webpage Project

A A A A A

Page Properties Dragging & Dropping  Cutting and Pasting Customizing Page Page Approval
Pages Pages Icons
See also
* Projects
#* Context-sensitive Help
® Skins
#* Working with Tables
®* Working with Images
# Keywords and Index
® Links
® Search
® Publishing
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Adding a Page
Follow the instructions below to add a new page to your help system:

1. Open the Help Project

2. If you are not already logged in, log in as an administrator with 'edit contents' permissions.

3. Click the 'Add Page' icon.

W

4. Enter a name for the new iaie.
Mame: Getting Started
Fage Type: Hedp Fage -
S i Add Page

5. Click the 'Show Oitions' link to disilai additional fields such as filename and template.

Mame: Getting Started

Fage Type: Help Fage -
Fage Joon: [Aua] -
Add pg Chikd:

e Oiotea [ AxiPage |

'Add Page' Options

Option Description

Name Defines the name of the help page. The name can be changed at any time after it has
been added. The page ID is generated from this name when the page is saved.

Page Type Page Type can be one of the following:

- Internal HTML Page (Based on a selected template such as 'Help Page')
- External File (file or document such as docs/example.pdf)

- Website (website or webpage such as http://www.google.com)

- Merge Project (embeds another help project)

Page Icon Defines the icon that will be displayed to the left of the page in the contents. If set to
[auto], the icon will automatically be displayed as a page or folder depending on whether
the page has children.

Add as Child If this is checked, the page will be added as a child (under the selected page), otherwise it

will be added as a sibling (at the same level as the selected page)

Add as Child (added under Introduction) Add as Sibling (Same level as Introduction)

@ Welcome @ Welcome
= (f | Introduction @ Introduction
(7 W \Widget Master "

6. Click 'Add Page' to add the page.

7. The new paae will

be displaved. Click 'Edit Paae' to edit the contents of the paae.
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See also

Adding an External File
Adding a Website or Webpage
Embedding another Project
Renaming a Page

Deleting a Page

Page Properties

Dragging & Dropping Pages
Cutting and Pasting Pages
Customizing Page lcons
Page Approval
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Home > Basic Functions > Table of Contents > Adding an External File

Adding an External File

What is an external file?

An external file is typically a document such as a Word Document or PDF document that is located outside of the project folder or in a sub folder of the
project. Examples of external files include:

- Word Document with pricing information hosted on company website.

- PDF brochure hosted on company website.

- PDF user manual located in a sub folder of the project.
- Flash product demo located in a sub folder of the project.

Follow the instructions below to add an external file to your help system:
1. Open the Help System

2. If you are not already logged in, log in as an administrator with 'edit contents' permissions.

3. Click the 'Add Page' icon.

4. Enter a name for the new page.

5. Enter an absolute URL such as http://www.extremeease.com/help/helpconsole%202008/docs/example.pdf or a relative URL such

as docs/examile.idf

Hlarrur ! POF Dooument
Page Type: "Extemal File v/
External Fie: docsjexsrple.od

Example: "docs fexample. pdf

Page Tcon: [ [Auta] v
Add 8 Chid: O
Hide Opians

6. Click OK to add the page.

7. The external file will be displayed.

ardards T e e i AdraPueriey Pt L Bzt &

e HEL B e (Bee s

Note: External pages are not editable so you'll notice that the 'Edit Page" button is not visible when external pages are displayed.

See also
#* Adding a Page
#* Addina a Website or Webpaae
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Embedding another Project
Renaming a Page

Deleting a Page

Page Properties

Dragging & Dropping Pages
Cutting and Pasting Pages
Customizing Page lcons
Page Approval
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Home > Basic Functions > Table of Contents > Adding a Website or Webpage

Adding a Website or Webpage

A website or webpage can be added to the contents. Examples of websites or webpages that you might include in your help system include:
- A webpage your company knowledgebase.

- A reference to a company website such as http://www.microsoft.com

- A reference to your company website.

Follow the instructions below to add a a website to your help system:

1. Open the Help System

2. If you are not already logged in, log in as an administrator with 'edit contents' permissions.

3. Click the 'Add Page' icon.

4. Enter a name for the new page.

5. Enter the website URL.

Add Page X
Hame: geage
Page Type: Website v:
wabita: hittp: e goaghe. om

Example: hitkpz/fwenn . googie. com

Page Tcon: JAuta] v
aald 8 Child: 0
Hide Cptions

6. Click 'Add Page' to add the page.

7. The website will be displayed.

ey R T snrwe s e Sewr o
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=y Vb ol Mea Sowh Ve Ol ot e | S
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Note: Website pages are not editable so you'll notice that the 'Edit Page' button is not visible when website pages are displayed.

See also

Adding a Page

Adding an External File
Embedding another Project
Renaming a Page

Deleting a Page

L ]
L ]
L ]
L ]
L ]
® Page Properties
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Dragging & Dropping Pages
Cutting and Pasting Pages
Customizing Page lcons
Page Approval
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Embedding another Project

One or more other help projects can be embedded into your help project. This is useful if you wish to create smaller help systems (or sections) that you
later want to merge to display a larger help system. A scenario may be that you have a standard edition of your product and a professional edition. The
professional edition includes ‘featurel’, ‘feature2' and ‘feature3', but the standard edition only includes 'featurel’ and ‘feature2'.

Follow the instructions below to embed another help project into your help project:

1. Open the Help System

2. If you are not already logged in, log in as an administrator with 'design’ permissions.

3. Click the 'Add Page' icon.

v

4. Select 'Merge Project' for the page type.

5. Select the heli iro'ect that iou want to embed.

Fage Type: Merge Project w
Marge Project: 4
Example Help Syatem
HC2008 Test Results

Page Tcon: HelpConzale 2008
HelpConzole 2008 Demos

Add as Child: Widpet Master Feature1
\VWidget Master Featured
Widget Master Feature3

Hide Dpbions

6. Click 'Add Page' to embed the help project.
7. When the contents is in edit mode, a [project] placeholder will indicate where the help project will be embedded. When the contents is in live mode,

the embedded pages will be displayed.

Edit Mode Live Mode

. . |
Contents &) € o [Esavell[x]] [contents
11| welcome dj_l

11| Installation 1| Installation
Bl [project:Widget Master Feature] il | Featurel Overview
{1l FAQ (1 | Feature 1 Installation
il | Feature 1Functions
{1/ FAQ

Note: To open a page within the embedded project, use the syntax: "Default.aspx?pageid=<project>:<pageid>". For example: "default.aspx?
pageid=Widget Master:faq"

See also

#* Adding a Page

#* Adding an External File

#* Adding a Website or Webpage
* Renaming a Page

#* Deleting a Page

®* Page Properties

# Dragging & Dropping Pages
® Cutting and Pasting Pages
# Customizing Page lcons

L ]

Page Approval
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Renaming a Page
Follow the instructions below to rename a page.

1. Open the Help System

2. If you are not already logged in, log in as an administrator with 'design’ permissions.

3. Select the page in the 'Table of Contents' that you wish to rename.
@ Wiekome

ER ) irstataton

i# |} | Basic Functions

B {} ] Advanced Functions

® ) | Tutorials

o ()] rag

4. Click the page name again to make it editable. Type in the new page name.
W Velcome

B ) [tnstaling the Softeare]

& () | Basic Functions

B} | Advanced Functions

B ) | Tuterals

& {3 FAQ

5. The page can also be renamed from the 'Page Properties' form. Click the 'Page Properties' icon to display the form.

B Standard
Page Mame:  Getting Started
Page ID: getting_started
Status: |L|
Page Leon: [iita] (=]
Type: HTML Page

B Keywords

B visibility by Skin

£ Note: When the page is saved, the page ID is generated based on the page name. If the page name is changed in the future, the page 1D will

rename the same (unless it is renamed as well).

See also

Adding a Page

Adding an External File
Adding a Website or Webpage
Embedding another Project
Deleting a Page

Page Properties

Dragging & Dropping Pages
Cutting and Pasting Pages
Customizing Page lcons
Page Approval
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Home > Basic Functions > Table of Contents > Deleting a Page

Deleting a Page

Follow the instructions below to delete a page.

1. Open the Help System

2. If you are not already logged in, log in as an administrator with 'design’ permissions.

3. Select the page in the 'Table of Contents' that you wish to delete.

@ Wekome
ER ) irstataton
)| Basic Funetons
B {} ] Advanced Functions
B )| Tutoriss
)| rPAQ

2. Click the 'Delete Page' icon.

3. When asked to confirm, click 'OK'.
——

@ Delete page Tnstallation'?

oK ]_ Cancel |

See also

Adding a Page

Adding an External File
Adding a Website or Webpage
Embedding another Project
Renaming a Page

Page Properties

Dragging & Dropping Pages
Cutting and Pasting Pages
Customizing Page lcons
Page Approval
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Page Properties
To set properties for a help page, follow the instructions below.

1. Open the Help System
2. If you are not already logged in, log in as an administrator with 'edit contents' permissions.

3. Select the page that you want to set properties for.
W Velcome
£ (1) finstaing e sofward |
B |} Basic Funchions
B )| Advenced Functions
B ) Tutersis
E 1 FAG

4. Click the page properties icon.

5. The page properties will be displayed.

Page Properties

B standard
Page Mame:  Getting Started
Page ID: getting_started
Status: |L|
Page Teon: [Auto] [=]
Type: HTML Page

B Keywords

E visibility by Skin

Page Properties

Option Description

Page Name Defines the name of the help page.

Page ID The underlying page ID. This is generated from the page name when the page is first
saved.

Before the page is saved, the id will be read-only and will be displayed in the format
"Template_Help Page~!~1212604752609"

Type This is usually set to 'HTML Page'

This property is readonly

Status This property allows the author to assign a status a status to a page. The page will be
displayed with a background color in the contents. By default, the page status can be
set to one of the folowing:

- Pending
- Incomplete
- Needs Review

Additional page status entries can be added (or modified) by editing the project
stylesheet.

Page Icon Defines the icon that will be displayed to the left of the page in the contents. If set to
[auto], the icon will automatically be displayed as a page or folder depending
on whether the page has children.

Keywords Defines the keywords for the selected page which will be displayed in the Index.
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Visibility by Skin Defines which skins this page will be visible for. For more information about conditional
content see: Conditional Content

See also

Adding a Page

Adding an External File
Adding a Website or Webpage
Embedding another Project
Renaming a Page

Deleting a Page

Dragging & Dropping Pages
Cutting and Pasting Pages
Customizing Page lcons
Page Approval
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Dragging & Dropping Pages

Pages can be moved within the table of contents by dragging and dropping with your mouse. Pages can be dropped as either a child or a sibling. See
examples below:

Dropping as a child
To drop a page as a child of another page, move your mouse over the page until just the text is underlined and then release the mouse button.

@ welcome
(7 W11y Page

(1) Introduction
11| Product Reference

@ FAQ
i My Page

Dropping as a sibling
To drop a page as a sibling of another page, move your mouse over the page until both the icon and the text are underlined and then release the mouse
button.

@ Welcome

{1 Introduction
(1| Product Reference

@ FAQ
4 My Page

See also

Adding a Page
Adding an External File

Adding a Website or Webpage

Embedding another Project
Renaming a Page

Deleting a Page

Page Properties

Cutting and Pasting Pages
Customizing Page lcons
Page Approval

@ Welcome
1| Introduction
i) | Product Reference
= () Fag

@ welcome

{3 | Intraduction
(1| Product Reference
@ Fag

helpconsole 2010



102 . Basic Functions

Home > Basic Functions > Table of Contents > Cutting and Pasting Pages

Cutting and Pasting Pages

In addition to dragging and dropping, pages can be moved within the contents by cutting and pasting. Follow the instructions below to cut and paste a
page.

1. Open the Help System
2. If you are not already logged in, log in as an administrator with 'edit contents’ permissions.

3. Select the page (or folder) that you want to move. Press CTRL-X
1y | Welcome

11| Installation CTRL-X
= (§ | Basic Functions

_ Basic Function
= (4| Advanced Function:
" Advanced Function 1
* Advanced Function 2
1y | Tutorials
ﬂ]j_| FAQ

4. Select the page or folder that you want to move the cut page to. Press CTRL-V

i1 | Welcome 1| Welcome
{1 | Installation i1 | Installation
=l {} | Basic Functions =l {} | Basic Functions
:f | Basic Function 2
- saschucin?  GrRLY BN e s
=NAH Advanced Functions & === " Advanced Function 1
~ Advanced Functio " Advanced Function 2
_ Advanced Functio " Basic Function 1
i1 | Tutorials i Tutorials
{1/ FaQ () FaQ

See also

#* Adding a Page

#* Adding an External File

#* Adding a Website or Webpage
#* Embedding another Project
®* Renaming a Page

®* Deleting a Page

®* Page Properties

* Dragging & Dropping Pages
# Customizing Page Icons

L]

Page Approval
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Home > Basic Functions > Table of Contents > Customizing Page Icons

Customizing Page Icons

When a "Child Icon List" or "Sibling Icon List" system variable is included on a page, the pages are represented by folder icons, as shown below:

J 4 d J d &

Adding a Page Adding an External File Adding a Website or  Embedding another Renaming a Page Deleting a Page
Webpage Project

J 4 3 g

Page Properties Dragging & Dropping  Cutting and Pasting Page Approval
Pages Pages

These page icons can be customized by doing the following:

1. Design or obtain an image that you want to use to represent a page. Open the image with an image editing tool such as Windows paint or Photoshop.
= -an

S A e i e Ve e S - B osemens WP E

BE A/ RTAES PRI eSS LD WO

W R o O imee -

2. Resize the image to 64 pixels wide and 64 pixels high. The page icon can be any size, but 64 pixels is recommended.

3. Save the image.
- Specify GIF as the image format.

- The name of the image will be <pagename>.gif. For example if the page name is 'Basic Functions' then the image should be named 'Basic Functions.gif'.
- Save the image to the 'Images' folder. Example path: C:\program files\HelpConsole 2010\MyProject\images\Basic Functions.gif

HelpConsole 2007
Online Help Ask Us k

BF youvE Lribiie 1 Shd wfat
g b 0 e ) T ) i
FrEbem, Iy these SltEmate

Gerting §tared Temitalarsory Basic Furctors
w Fag
r..
|  ppert @l emalane com
Wit . Poapeng (] 00000
Advarnced Fungtiorn  Toolar Reference L]
See also

Adding a Page

Adding an External File
Adding a Website or Webpage
Embedding another Project
Renaming a Page

Deleting a Page

Page Properties

Dragging & Dropping Pages
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#* Cutting and Pasting Pages
* Page Approval
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Page Approval

In many cases, managers want to be able to review and approve pages that have been added or edited. This can be accomplished by setting the
‘Default Page Status' setting in project properties. This will cause a page status to be assigned when new pages are added, or existing pages are edited.

Set Default Page Status

1. Login to the project as admin.

2. Click "Tools > Properties"

3. Select a value for 'default page status’

4. Click 'Save'

5. Refresh the browser to ensure that the property is set.

B P

P_rojgct Properties

SwwtPage: [First Page]
DefsdtSin:  blue =
Acthity Logi | Record Mo Actions 3
Hep Format: | Frames E|
Alow Soipts: | False E|
Defndt Page Status | Needs _Review
Default Cortents Mode: Pandin
Defadt Comment Status: '
Ugers Datasat:

SMTP Server:

Approval Process

1. When a page is added or edited, the page status 'Needs_Review' will be assigned.
2. The manager is responsible for reviewing each page marked as '‘Needs_Review' and then change the page status.

testd711 - Powened - 33 =
@'&_}" .0 hittge/ e softwaneconsahe.comytestd 1L default aspausername = sdmi "-_.“--‘)-l EY ”".l Google B o=
7y Favorites | (@ tesd711 - Fowened by HelpConsole 210 Fi * B -3 @ v Bsgev Sfetyv Tockv @+
Coments G 3 . [@Seveis ) | [l i .1 Index < rBockmark e Frint &

Wiskome ~ Egit Paga | =

* ) Gateng Started
My Cthar N Prage:
My New Page

Thes ixpaiirny puangragh should describe th feature hal you ae documenting. Expllan hew il B commonly used and wht
the berefits are. For example: The Widget Master emal bnk allows you o easily send information about each widget o
waris departmends within your company . Often, he feshure that you sre decumeniing can be best euplsined by waldng
the reader through siep by step. Use soreenshols o lustrate the steps whene possible

1. Start S applcabion by

My Herw Bope 2. n the startup screen, chok the
_saw_page 3,
Heeds_Reves ]
See also
Weloome:
Gettng Starbed =

@ Internet | Protected Mode: On fa v HiO% v

See also
#* Addina a Paae
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Adding an External File
Adding a Website or Webpage
Embedding another Project
Renaming a Page

Deleting a Page

Page Properties

Dragging & Dropping Pages
Cutting and Pasting Pages
Customizing Page lcons
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Working with Tables

Tables are an important tool for formatting text and images on your help pages. Tables can be very simple with just one cell or very complex with
hundreds of rows and cells, embedded tables, style formats, etc.

Some uses of tables are:

- Displaying images and text side by side

- A features comparison matrix

- To display text over a background image
- To create stylish HTML buttons

- To control text paragraph width

- To display a border around a paragraph
- To align text columns

A\ A\ A\

Adding a Table Table Properties Cell Properties
See also
# Projects
#* Context-sensitive Help
# Skins
®* Table of Contents
®* Working with Images
# Keywords and Index
® Links
# Search
® Publishing
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Adding a Table

Follow the instructions below to insert a table. In the example below, we'll use a table to create a price list.

1. Click the 'Insert Table" icon.

2. On the dropdown dialog, select the number of columns and rows that the table will have.
2 g - B Tahoma - Szexr B U A - %

I
LI
I
I |
CICIE]
CICIE]

(ERE
OO0
8
0

B Table Wizard

L]
LI
L]
LI
L]

O

3. The table will be created. Additional rows and columns can be added at any time, or cells can be deleted at any time.

4. Use your mouse to adjust the width and height of the table. Note: The width and height can also be defined as a percentage of the page size in 'table
E‘roperties'.

Setting Table Properties:

There are two ways that table properties can be set:

1. Select the table and then change dynamic proerties displayed at the bottom of the editor.

2. Or riaht click the table and select "Table Properties"
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See also

# RadEditor 2009 User Manual
RadEditor 2009 Insert Table
RadEditor 2009 Table Wizard
Table Properties

Cell Properties
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Table Properties

To display table properties, right-click anywhere on the table, and select ‘Table properties’

will be displayed.

The 'Table Wizard' dialog
B Table Wizard

Takble [

Backgrouwnd Coler

Style Builder

Property Overview

Property Description

Height - If blank: the height will adjust automatically
- 123px: the height will be set to 123 pixels
- 50%: the height will be set to 50% of the page height

Width - If blank: the width will adjust automatically
- 123px: the width will be set to 123 pixels
- 50%: the width will be set to 50% of the page width

Cell Spacing Defines the space in pixels between each cell

Cell Padding Defines the extra space around text or images within each cell.
Alignment The justification of the table (Left, center or right)

Background Color The background color of the table. Tables are transparent by default, so if

'background' is undefined, the color or image behind the table will be visible.

Style Builder Loads the style bulder dialog which allows various styles to be applied such as font size,
font color, border, etc.
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CSS Class

Assigns a predefined table style.

Back Image

Sets an image to be displayed behind text and images within the table.

Border

Sets the table border width, color, and layout.

ID

Assigns an ID to the table. Mostly used for advanced table functions.

Css Class Layout

Select a predefined table style from the list. These styles can be customized by editing
the file: c:\program files\helpconsole 2010\_engine\TableLayoutCss.css

See also
RadEditor 2009 User Manual
RadEditor 2009 Insert Table
RadEditor 2009 Table Wizard

Adding a Table
Cell Properties
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Cell Properties

To display the 'Cell Properties' dialog, right-click in a table cell, and select 'Cell properties'
B Table Wizard

Property Overview

Property

Description

- If blank: the height will adjust automatically

Height - 123px: the height will be set to 123 pixels
- 50%: the height will be set to 50% of the table height
- If blank: the width will adjust automatically

Width - 123px: the width will be set to 123 pixels

- 50%: the width will be set to 50% of the table width

Content Alignment

The vertical and horizontal alignment of the cell

The background color of the cell. Cells are transparent by default, so if ‘background' is

Background undefined, the color or image of the table will be visible.

Style Builder D|sp|ayla dialog that allows styles such as font-size, font-color, border, padding, etc. to
be applied.

Css Class Select a predefined class that will apply styles to the cell. This list can be customized by

editing the project stylesheet(s).

Background Image

Sets an image to be displayed behind text and images within the cell.

ID

Assigns an ID to the cell. Mostly used for advanced cell functions.

No Text Wrapping

Prevents sentences with spaces to wrap to the next line

See also

Adding a Table

L]
L]
L]
L]
L]
* Table Properties

RadEditor 2009 User Manual
RadEditor 2009 Insert Table
RadEditor 2009 Table Wizard
Editing the 'Apply Styles' List
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Working with Images

Images are an important part of creating an effective help system. Images stored on the web server can be selected and inserted. Images can also be
uploaded from your harddrive or network to the web server.

Adding an Image Uploading an Image Pasting an Image Image Properties  Adding Hotspots to an
Image

See also

Projects
Context-sensitive Help
Skins

Table of Contents
Working with Tables
Keywords and Index
Links

Search

Publishing
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Adding an Image
Follow the instructions below to add an image to a HelpConsole page.
1. Place the cursor where you want the image to added.

2. Click the 'Add Image' icon.

3. The 'Image Manager" dialog will appear. Select an image and click 'insert'. You can also upload images from your computer or network to the
web server.

Dialog Overview
Property Description

a Refresh Refreshes the current view.
m New Folder Creates a new folder under the currently displayed folder.
ﬂ Delete Deletes the selected file or folder.
i Upload Image Click this button to upload an image
Image Editor Provides rudimentary image editing such as resize, crop, etc.
Best Fit Resizes the image to fit within the viewing window.
Actual Size Displays the actual size of the image.
ﬂ Zoom In Makes the image larger
- Zoom Out Makes the image smaller
See also

* RadEditor 2009 User Manual
Uploading an Image

Pasting an Image

Image Properties

L]
L]
L]
#* Adding Hotspots to an Image
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Uploading an Image
Images can be uploaded from your harddrive or your network to the help system project on the web server. Follow the instructions below:
1. Place the cursor where you wish to insert an image.

2. Click the 'Add Image' icon.

3. The 'Image Manager" dialog will appear.

4. Click the 'Upload Image' tab. Click 'Select'.
B Upload

Ciibempalarm_

Upload

4. The Windows file dialog will appear. Select an image to upload and click 'Open’
B Cracis Fie e Uplad -

et b Computis & SAMIAIONNE () B lev b oE I

[ r—— T — ]~ rTTe—p——

[ el

5. The file path will be displayed in the 'Image Manager" dialog. Click 'Upload’ to copy the image to the web server.

6. The uploaded image will be added to the 'Browse Files' list. Select the image and click 'Insert'.

7. The image will be added to the page. Image Properties can be set using the 'Image Properties' dialog

See also

#* RadEditor 2009 User Manual
# Adding an Image

# Pasting an Image

* |maae Properties
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# Adding Hotspots to an Image
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Home > Basic Functions > Working with Images > Pasting an Image

Pasting an Image

Images cannot be pasted directly into the HelpConsole editor the same way that you can paste images into Windows based
applications such as MS Word. This is the case for almost all web-based applications and is due to security restrictions on modern
browsers that allow text to be pasted from the Windows clipboard but not images. HelpConsole gets around this limitation by
integrating with screen capture tools such as TechSmith Snagit (http://www.techsmith.com/).

Setup for Image Pasting:
In order to capture screenshots with Snagit and paste into a HelpConsole page, do the following:

1. Download and install Snagit from here: http://www.techsmith.com/download/snagittrialthx.asp

2. Run Snagit

3. click the ‘Create Profile' icon

4. Select the 'Image Capture' option, click next’
2 Hew Profile Wicad
Sebecting Ehe Capture Mode (Step 1 of ) m
Swiect e Captire Mode you want iouse
- Cesrption
e
Emage Capture modde cagtures an
e v oA e
L]j Tt ety anp g pou e o pour compuder
seneen, EaShred, o i
i o mu-r.ﬂxﬂdu-mbu
:“&b_-d,i-p-n:-,cmd,a
e B Web s
@ | oo
==
5. Select the input. If you're not sure what to select, try either 'Window' or 'Region’, click 'next’
2aid Hew Profile Wicad
Selecting the Inpet (Step 3ol 6) E!
Swiect what pou want o capbre
et Depreton
u Eroperben.... :ﬂmwﬁ--mm
- Tres & e pson For LaptaTg
Flmgar Bt e et ot by
borders or ek Hhal Snagl can
find, (o] <BFT > Brry
capre Teales & pue.)
e Sar Properbes buSion & fre
‘wre the input.
spak [ mets | [ oo

6. For 'Output’ select 'File'

7. Click the 'Properties' button

8. Select 'Always Use this file format'

9. Select 'JPG'

10. Under 'File name' select 'Fixed file name'

11. For 'Name:' enter '_pasteimage’

12. Under 'Folder' enter 'c:\program files\helpconsole 2010\{project}\images (where {project} is the name of your project)
13. Click 'OK'
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Image File | send Email | FTP | Program | print |

File format
() Remember last used format

@ Always use this file format:

BMP - Windows Bitmap
CUR - Windows Cursor
GIF - CompuServe GIF
ICO - Windows Icon

JPG - JPEG Image

MHT - Web Page with Imac
FDF - Adobe FDF

PMG - Portable Metwork Gr
SNAG - Snagit Capture File

CLAIE A dabs Elamb

Show advanced types

File name
() Ask for file name

(@) Fixed file name

Mame: _pasteimage

) Automatic file name

SMAG-0000, PG

Folder
Use last used folder
(@ Always use this folder:

JPG

elpConsole 2010Ymages

14. Click 'next'
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16. On the 'Effect’ dialog, ensure that no effects are selected, click 'next’

17. For 'Name:', enter 'HelpConsole' for the profile name. Click ‘Finish’
i R

[ cges [ rewn | [ ol |

To Paste an Image:

1. Ensure that snagit is running and the 'HelpConsole' profile is selected.

2. Press the <prt Scr> key

15. Click the 'Preview in Editor' option to un-select it. Ensure that there are no options selected. Click 'Next'
pEER )
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3. Click the 'Insert Image' icon on the HelpConsole editor toolbar, or press <CTRL-Q>

i

See also

# Adding an Image

#* Uploading an Image

* |mage Properties

#* Adding Hotspots to an Image
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Image Properties

Follow the instructions below to set image properties.

1. Select an image and click the right mouse button. Click ‘Properties’

Width

Properties:
Property Description

Specifies the width of the image. If left blank, the width will be set automatically.

Height

Specifies the height of the image. If left blank, the height will be set automatically.

Border Color

Specifies the color of the image border

Border Width

Specifies the thickness of the image border. Select "No Border" to display the image
without a border.

Alt Text

Specifies the alternative text, which is displayed if a browser is incapable of displaying
images, or images are turned off. This also acts as a popup tooltip when the user moves
their mouse over the image.

Long Description

This is an Accessibility option. The text entered in the “"Long Description" field will be
read by the Windows Narrator tool.

Image Alignment

Sets the alignment of the image, with respect to the adjacent text/images. When you
choose left or right alignment, the text will wrap around the image.

Image Src

An absolute or relative URL pointing to the image file. Click the browse icon to select an
image in the 'images' folder.

Examplel: http://www.extremeease.com/images/logo.gif

Example2: images/logo.gif

Margin

Specifies the margin width around the image.

CSS Class

Select a predefined class that will apply styles to the image. This list can be customized
by editing the project stylesheet(s).
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See also

# Adding an Image

# Uploading an Image

# Pasting an Image

# Adding Hotspots to an Image
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Adding Hotspots to an Image

You can create clickable 'hotspots' within an image. These 'hotspots' can be linked to internal or external pages. This is commonly used to document
functions on a toolbar. For example, the toolbar shown below has hotspots for the 'tools' button, the ‘Publish Help System' button, and the 'Publish PDF
Manual' button.

The image below contains hotspots. Click the hotspots to display the linked page.

> . | Publish - Publish
" L' ) {-; Tools L Help System = PDF Manual

The image below contains hotspots with mouseover links. Move your mouse over the hotspots to display the linked page.

o . | Publish W Publish
m L' ) ‘{_.{ Tools Lgw— Help System = PDF Manual

To create a hotspot within an image, follow the instructions below:

Right click an image on the page and select 'Image Map Editor"
=] o

VS Lot

1.
]
o
o

2. The 'Image Map Editor' dialog will be displayed.
3. Use your mouse to create hotspots for the 'Tools', 'Publish Help System’, and 'Publish PDF Manual' buttons.
4. For 'URL', enter the path to the page that you wish to link to. Internal pages will have the format "default.aspx?pageid=<pageid>".

Example: "default.aspx?pageid=faq"
B Tmage Map

5. To display the linked page in a popup window, select 'Media Pane' in the 'Target' list.

6. Click OK to create the hotspots.
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Keywords and Index

The Index provides the reader an alphabetical list of keywords that helps direct them to the information that they are looking for. Each page can have
several keywords associated with it. For example, a page that explains how to install a product in Windows 7 might have keywords such as ‘Installation’,
‘install’, 'Setup’, ‘Windows', 'Windows 7, etc.

Display Keywords in  Display Index in Live
Edit Mode Mode

See also

Projects
Context-sensitive Help
Skins

Table of Contents
Working with Tables
Working with Images
Links

Search

Publishing
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Display Keywords in Edit Mode

To assist readers in quickly finding the information that they're looking for, it is a good practice to provide keywords for each page in your help
system. To add keywords for a specific page, follow the instructions below:

1. Open the Help System
2. If you are not already logged in, log in as an administrator with 'design’ permissions.

3. Select the page in the 'Table of Contents' that you wish to assign keywords to.
@ Wekome

Y stotarion

i# |} | Basic Functions

B {} ] Advanced Functions

B () Tutorisls

o ()| rag

4. Click the 'Page Properties' icon to display the keyword list.

B Standard

Page Name: Instakation

Page ID: gefting_started

Status: [=]

Page [con: [Awto] |T|
Type: HTML Page

B Keywords

Instalation -
Setup

product install

Application Setug|

B visibility by Skin

See also
Display Index in Live Mode
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Home > Basic Functions > Keywords and Index > Display Index in Live Mode

Display Index in Live Mode

1. To display the index, click the 'Index’ icon.
. Indlex

[rrepr—
e r

2. The keyword index will be displayed.
=]

| Tatle FrooerSeu =

When the user moves their mouse over each keyword, a popup tooltip will indicate the name of the page that the keyword was found on. Click the
keyword to display the associated page.

See also
Display Keywords in Edit Mode
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Home > Basic Functions > Links
Links

Links (or hyperlinks) allow authors to link text or images on a page to other internal pages or external pages.

CUBEF < I C | R |

Adding Page Links  Adding Internet Links  Adding Email Links  Adding Document Links Adding Page Anchors  Adding Popup Links

3 Al

Removing a Link Popup Example

See also

Projects
Context-sensitive Help
Skins

Table of Contents
Working with Tables
Working with Images
Keywords and Index
Search

Publishing
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Adding Page Links

A page link is a link from text or an image to another page within the help project. Follow the instructions below to create a link.

Text Link

1. Select the text on the page that you wish to create a link.

!ﬂ% installation instructions

2. Click the 'Link Page' icon

3. Select the page that you wish to link to.
= Link Page

Link Type: Mormal Link

# | Tutorials
® ol Faq
* Mdmin

4. The link will be created. The text will be blue with an underline. Note: links are not active when the page is in edit mode.
Click here for instaliation instructions

Image Link

1. Select an image on the page that you wish to create a link.
ooo

Dgﬁmduct Instalation
[m]

2. Click the 'Link Page' icon

3. Select the page that you wish to link to.
= Link Page

Link Type: Mormal Link

4. The link will be created. The image will appear the same as before but when published will display a hand cursor when the mouse is moved over it.

%mdmt Instalation

5. To remove the blue border, right click the image, select 'Set Image Properties' and then change the 'image border' to 0.
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See also

Adding Internet Links
Adding Email Links
Adding Document Links
Adding Page Anchors
Adding Popup Links
Removing a Link

Popup Example
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Adding Internet Links

1. Select the text on the page that you wish to create a link.

!ﬂﬂg@i;)r installation instructions

2. Click the 'More' button on the toolbar to show additional functions.

3. Click the 'Hyperlink Manager" icon.

4. Enter the URL of the page that you wish to link to.
B Hypernk Manager ]

Property Overview

Property scripti

URL A relative path or absolute path to the page that you wish to link to.
Examples:

http://www.extremeease.com/support.htm (absolute URL)
welcome.aspx (relative URL)

Existing Anchor Instead of linking to another page, the selected text or image can link to an anchor
within the current page. This is commonly used for FAQ pages.

Link Text Specifies the text that will be displayed for the link.

Target Determines where the page will be displayed. This is normally set to 'New Window' or
‘Same Window'

Same Window (or left blank) - Page is displayed in the same frame
New Window - Page is displayed in a new browser window

Tooltip Popup message displayed when the user moves their mouse over the link.

CSS Class Defines the style (or format) of the link. This is usually used by advanced users.

5. The link will be created. The text will be blue with an underline. Note: links are not active when the page is in edit mode.
Click here for instaliation instructions

£ Note: An Internet link can also be added by simply typing the URL into the page. Any set of characters that starts with www. or http:// and ends
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with a space will be converted to an Internet link. If the URL contains spaces, enclose the URL in double quotes and the link will be converted correctly.

See also

Adding Page Links
Adding Email Links
Adding Document Links
Adding Page Anchors
Adding Popup Links
Removing a Link

Popup Example
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Adding Email Links

To add an email link to a page, simply type the email address. The editor will convert an set of characters containing @ into a link.

Example: Sales@Extremeease.com

1. Email links can also be added via the 'Hyperlink Manager'. Select the text or image and click the 'Hyperlink Manager" icon.

2

2. The Hyperlink Manager dialog
B Hyperink Mansger

will be displayed, click the 'Email' tab. Enter the email address and click 'OK'".

Address  suppani@ o am
Link Text to send an emadl fo Support

Property

Address A relative path or absolute path to the page that you wish to link to.
Examples:

http://www.extremeease.com/support.htm (absolute URL)
welcome.aspx (relative URL)

Link Text Specifies the text that will be displayed for the link.

Subject When the email message appears, this text will appear in the subject line.

CSS Class Defines the style (or format) of the link. This is usually used by advanced users.

£ Note: An email link can also be added by simply typing the email address into the page.

See also

#* Adding Page Links

# Adding Internet Links
#* Adding Document Links
#* Adding Page Anchors
#* Adding Popup Links

#* Removing a Link

®* Popup Example
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Adding Document Links

Text or images can be linked to internal documents or documents located on the Internet such as PDF manuals, Word documents, PowerPoint
presentations, etc. When the link is clicked the document will be displayed with the HelpConsole page window.

External Document

1. The easiest way to add a link to an external document is to simply type the URL. The URL text will be converted to a link. If the url contains spaces,
enclose the url in double quotes.

Example: http://www.extremeease.com/help/helpconsole%202008/manual.pdf

2 If you want to change the link text, or any other Ilnk property, right click on the link and click ‘Properties...
all extremeshss com hels helpconsoles 202008 el pdf

URL  hthp: /o extrama: mbelphe B

ink Ted  He 0F Manual

Internal Document

1. Toinsert a link to a document located on your web server, place the cursor at the location that you want the link to be placed.
2. Click the 'Document Manager" icon.

A ]

3. Select the document that you want to insert. Documents are normall located in the 'Docs' folder.

4. If the document is located on your computer or network, click the ‘Upload Document' tab, select the file and upload it to the web server.

See also

Adding Page Links
Adding Internet Links
Adding Email Links
Adding Page Anchors
Adding Popup Links

L ]
L ]
L ]
L ]
L ]
®* Removing a Link
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®* Popup Example
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Adding Page Anchors

An anchor can be attached to text or an image on a page. Normally anchors are used to link from one section of a page to another section. For example
if a page contains a long list of questions and answers, you might include a summary at the top of the page that links to each answser further down on
the page.

Adding an Anchor

Follow the steps below to add an anchor:

1. Click 'Edit Page' to edit the page.

2. Highlight the text and you want to add the anchor to.

3. Click the "'Show More Tools" icon on the editor toolbar and then click the 'Hyperlink Manager" icon.
4. Click the 'Anchor' tab

pe the name of the anchor and then click 'OK’
B Hyperink Manager ®

Linking to an Anchor

Follow the steps below to add a link that displays an anchor on the same page:
1. Click 'Edit Page' on a page containing one or more anchors.

2. Highlight the text that you want to link to an anchor.

3. Click the 'Hyperlink Manager" Icon.

2

4. Select the anchor that you want to link to from
B Hyperink Manager *

the 'Existing Anchors' list.

5. Click 'OK'

Anchor Link Examples:

1. Display an anchor on the same page (top of this page): #pagetop

2. Open another page and display a specific anchor: default.aspx?pageid=editor toolbar#undo

3. Open a help system and display a specific page and anchor: http://www.helpconsole2010.com/helpconsole%202010/default.aspx?
pageid=editor_toolbar&anchor=undo
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See also

Adding Page Links
Adding Internet Links
Adding Email Links
Adding Document Links
Adding Popup Links
Removing a Link
Popup Example
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Adding Popup Links

You can add a page link that displays the linked page within a popup box.

Here are examples of popups that can be created:

Image Popup Image Mouseover popup
(click to display (Move mouse over text
popup) above)
-° " ] o o

Mouseover Popup
(Move mouse over text

above)

Small Popup
(click to display

popup)

Large Popup
(click to display

popup)

Follow the instructions below to add a popup link:

1. Select the text or image that you want to link to the popup.

2. Click the 'Page Link' icon )

3. For 'Link Tiie‘, select 'Small Poiui‘, 'Larie Poiui' or 'Mouseover Popup'

Link Type: | Small Popup w
Nammal Link

Wekcome Small Popup v
@ i Getting Started kf;ﬂ:e iﬁgu .

® )| Installation

& [} Basic Functions

E ] Advanced Functions
& i Tookar Reference
# ff FaQ

4. Click the iaie that iou want to link to.

Link Type: | Small Popup -

O e

B g Context-sersitve Help

B Skins

B () Table of Contents

B gl Werking with Tables

B | Working with Images

B i Keywords and Index

= 4 Links
| Adding Page Links
1 hdding Internet Links
| Adding Emad Links
1 Addirsg Docurment Links
| Adding Popups to Text
1 Adding Popups to Images
| Removing a Link

5. The 'popup’ link will be added to the paae.
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Popup Example

_/\__ Popup Example

< # Thiz i an example of 2 popup page
that can be displayed in a popop box
OF & MOUSSOVEr popUp window,

See also

Adding Page Links
Adding Internet Links
Adding Email Links
Adding Document Links
Adding Page Anchors
Removing a Link
Popup Example
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Removing a Link

To remove a link from text or an image, right click the text or image and select 'Remove Link'.
HelpCongsole Manual

Or

Move your cursor to the end of the link text and press the '‘Backspace' key.

See also

Adding Page Links
Adding Internet Links
Adding Email Links
Adding Document Links
Adding Page Anchors
Adding Popup Links
Popup Example
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@_-e Popup Example
% This is an example of a popup page that can be displayed in a popop box or a mouseover popup window.

helpconsole 2010



Basic Functions . 141

Home > Basic Functions

Search

The search function allows readers (and authors) to search for pages containing specific search terms.

A
N\

Searching for Text

See also

* Projects

#* Context-sensitive Help
# Skins

® Table of Contents

# Working with Tables

#* Working with Images
# Keywords and Index
® Links

L ]

Publishing

Search

A
N

Page Search and
Replace

T A
N N

Global Search and  Passing Search Terms
Replace in URL
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Home > Basic Functions > Search > Searching for Text

Searching for Text

To search for pages containing specific search terms, simply enter the search text in the 'Search' textbox and
press <enter>. Pages containing the search text will be listed on the left side of the screen. When a pages is
opened from the search results, the search term(s) will be highlighted in yellow.

Search Advanced  Search Term Search
Results Options Highlighted Textbox

ﬂmm-v-!w-um.sb—_ny‘ujpn_m)n
. U" [ @] mrtpacmentfeisconsmin 0 Hep a2 st at ot '| = ‘rl |40 Goopie
-8 -

Exact Prumse - !
el sactiana) =l Keywords and Indax
The Indiex provacen. he reader an schatetoal et of imywerds Fat heipn dnect Shem bo the rformation $at ey ane boking for. Each

et TV S B B w2, e ok, B Dt L plene o 10l & 00T P Windred T eghthurve
Iywands wict an Tratslator, , Setup’, “Wirdowe, Wrdowe T, ek

[}

\H i
Cieighan in Desplay Indes in e

At Mocke ok

Sae also

# Progees

# Conten!-paraires el
* Srn

® Tabie §f Covienis
® Workrg weh T

» Wik =t eages
& Lrka

* Sewn

& Publafing

Pages are listed by relevance in "Search Results". The following factors affect the order that pages are listed:
- How many times the search term is found in the page name.
- How many times the search term is found in the page content.

Search Condition

When performing a search, the following conditions are available:

Exact Phrase: If a user searches for “online help", only pages where "online help" is found together will be listed.

All Words: If a user searches for "online help", pages containing the word "online" and "help" anywhere on the page will be listed.
Any Words: If a user searches for "online help", pages containing either the word "online™ or the word "help" will be listed.

Page Names Only: If a user searches for "online help", only pages with "online help™ in the name will be listed.

Search Filter

When performing a search, the following filters can be applied:

All Sections: The search engine will search all pages for the search term(s).
{Chapter Name}: Select a specific chapter (or section) to search.

Search in Static Help

The search engine in static help systems works much the same way as a dynamic help system (described above), with the following exceptions:
1. The 'Search Filter' option is not included.

2. There is a 'Preview' option that when checked. displavs a previiew of the paae content in the search results list.

helpconsole 2010



Basic Functions . 143

Search Results

feature

@ prywords () all words
exactphrase | preview

11 matches found for ‘feature’

See also

#* Page Search and Replace

#* Global Search and Replace

#* Passing Search Terms in URL
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Page Search and Replace

Follow the steps below to replace multiple instances of a specific term within a help page:
1. Click 'Edit Page' to edit the current page.

2. Click the 'more' button on the editor toolbar.

-

3. Click the 'Find and Replace' icon.

&

4. Click the 'Replace' tab.
5. Enter the text that you want to replace in the 'Find' field.
6. Enter the replacement text in the 'Replace with' field.

7. Click 'Replace All' to replace all instances of the text.
B Find And Replace

Find

Index Find Next

ord Indas Replace

8. A message will appear stating how many replacements were made.

Message from webpage .

! . 4 cccurrences in the text have been replaced!

See also

#* Searching for Text

#* Global Search and Replace

® Passing Search Terms in URL
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Home > Basic Functions > Search > Global Search and Replace

Global Search and Replace

Follow the steps below to replace text (or HTML) across all pages within a help project:
1. Click 'Edit Page' to edit the current page.

2. Click the 'more' button on the editor toolbar.

3. Click the 'Global Search and Replace' icon. If the current page needs to be saved, you will be prompted to save
the page.

4. Enter the text that you want to replace in the 'Find' field.
5. Enter the replacement text in the 'Replace with' field.

6. Click 'Replace All' to replace all instances of the text.

Imiortant: This action cannot be undone, and therefore you may want to make a backup of your help project first.

This function replaces text (or HTML code) across al pages in your
help project. This cpération cannot be undans. If you are
replacing Xt on many pages, it i recommended mhat you badawp
the praject by selecting Tools > Badun’

Fnd What:  Index

Replace With: | Keyword Indes]

7. A message will appear stating how many replacements were made.
Message from webpage

i 4 pages updated.

See also

# Searching for Text

# Page Search and Replace

® Passing Search Terms in URL
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Home > Basic Functions > Search > Passing Search Terms in URL

Passing Search Terms in URL

Search text can be specified in the URL to automatically display a list of matching pages. For example to list all
pages that contain the search text "Keyword", specify "?search=keyword" in the URL.

Example: default.aspx?search=keyword

Search Condition
The search condition can be specified in the URL (allwords, anywords, exactphrase)
Example: default.aspx?search=keyword&condition=allwords

Search Filter

Example: default.aspx?search=keyword&filter=FAQ

8 Help - Powered by HelpC

@O - IE, http://localhost: 2482 /Help/default.aspxisearch=install HelpConsole8icondition= allwordséifitter= installation - | g [41- | b4 |

i Faverites | @ Help - Powered by HelpConsgi8010 ' St

Search Results -ﬂm 1 Index

Search For: |install HelpConsole
Condition: | All Words

17 Bookmark % Print

][] !

Filter: | Installation . . -
Upgrading from HelpConsole 2008
the Software Follow the instructions below to upgrade from HefpConscle 2008 to HelpConsole 2010,
g R s & 1. As a precaution, badup any active FelpCansole 2008 help projects.
mﬁh - 2. Refer to “Ingialing the Software” to install Helponsale 2010
m&mmmm 3. Copy any HelpConsole 2008 projects to HelpConsole 2010. This can be done by backing up the prc
E15 b 5 Your Activation Key on the ‘manage projects’ form in HelpConsole 2010,

4, the project in 2010 by double the project name or selecting the row and

HelpConsole 2010 - Enterprise Edition Copyrigh

http://lee ? i i €& Local intranet | Pr

See also

# Searching for Text

# Page Search and Replace
# Global Search and Replace
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Publishing

Output Formats

There are essentially three output formats.

Static Help System - Generate a pure HTML version of your Help System
Dynamic Help System - Authors can update the help system on your website
PDF Manual - Generate a user manual based on your Help Project

N A\ A\ A\

Publishing a Static Help  Uploading to your Legacy Help System  Publishing a Dynamic

System Website Help System
See also
Customizing the PDF Template
Projects
Context-sensitive Help
Skins

Table of Contents
Working with Tables
Working with Images
Keywords and Index
Links

Search

Publishing a PDF
Manual
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Publishing a Static Help System

Follow the instructions below to publish a static help system.

1. Open the Help System

2. If you are not already logged in, log in as an administrator with ‘publish’ permissions.

3. Click the 'Publish’ button.
Fublish

ﬁhﬂ Puah Sumic Help Satam

Publdih PDF Mastusl
/:3 g Ger HF marl, RS

4. The Publish form will be disilaied.

Publish Options:

Option

Publish Folder

Selected Node

Flat Format

Previously Published

Delete Static Help System

Description

Defines the name of the folder that the help system will be published
to.

If checked, only the currently selected page and child pages will be
published.

By default, the published static help system will display both the
contents and pages in <iframe> tags. If you wish to publish the help
system without using frames, check the 'Flat Format' checkbox.

A list of previously published static help systems will be displayed.
Click the link to open the help system.

Click the red X beside a previously published help system to delete
the folder.

6. Click 'Create Static Help Svstem'. A messaae will be displaved indicatina that it was created successfully.
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Enabe Help Crenied Suloriatily

Static Help Created Successiully...

Ot Hislp Systam

¥ Puish B URL: it s
1 oot e bt Syvters: L

I Suabe Fles Path: £ Wragrem FlestepCansls 2l et ¥imwn:

The following paths are also provided:

Publish this URL Click to display the static help system that was created. This URL can
be published internally or on your website.

Download zipped Help System When the static help system was created, it was also compressed into a Zip
file. This Zip file can be downloaded and unzipped to your harddrive,
network, website, etc.

Static Files Path Instead of downloading the zip file, the static help system files can be copied
directly from this folder.

See also

Uploading to your Website
Legacy Help System

Publishing a Dynamic Help System
Publishing a PDF Manual

helpconsole 2010



150 . Basic Functions

Uploading to your Website
Upload Static Help System

A static help system is made up of standard html pages and can be uploaded to any ISP or remote server via FTP. You should have received an email
from your ISP explaining how to FTP files to your website.

When you published the static help system, a path was displayed, showing the location of the static help system files. Copy these files to your website.

If you copied the files to a sub folder named "Help" then the URL will be http://www.domain.com/help (assuming that ‘domain’ is the name of your
website

Enabe Help Crenied Suloriatily

Static Help Croated Successiully...

Ot Hislp Systam

¥ putich B LRL:
1 Emernied scpe iy Syvtems:

Stane Fles Path: £ Pragram Flesteblonole Xl aeirvdnam:

Upload Dynamic Help System

To upload HelpConsole 2010 to your website so that help systems can be edited from anywhere at any time, do the following. This assumes that your
website is hosted with an ISP (Internet Service Provider) or other remote server.

1. Confirm that the remote web server is running .NET Framework 2.0 or higher. To check this, type a URL with an .ASPX page that you know will not
exist such as http://www.ExtremeEase.com/dummy.aspx.

.NET Framework Installed

If the message "Server Error in '/* Application." appears and the
version is 2.0 or higher, then the .NET framework is installed.

.NET Framework Not Installed

If the message 'The page cannot be found' appears, then the .NET
framework is not installed.

7 The revsurce cansed be jsund. - Windaws Infeinet fxplarar 3 HTTP 404 Hai Found . Micresalt Internel Explorer
G.-‘., P —————— P e B Edt Wew Fgoeies Dwks  peo [
T - B b reees Drghe " Qe - - ¥ [F] 0 D sewth 57 Rt et Seriy i~
T . . i ] g s, papr b et ARy S * o s borton At 48 -
Server Error in /' Application. <
i] The page cannot be found
The resource cannot be found.
Drmacriphion: ATTE 424 Tra reecurce you 58 Goarg bor or one o N Senoances | COUD "l Dean emcred Fad Tt rage ‘"d'" "‘:""u"”_l"m_“"l‘:"" remaed, had it
i e chirged b ity whialabie. Medih rvre B Slrwng UL sl Sikn bt Ball 8 soeked direclly ine hinged, of id Lenparanly uhimislabls,
Erquested Ui oo s
Floarce try the folloesng
Viersion [alsrmatisnd e T Frampwon Vs § BERET, 1430, A AT vippioa h § S4FI7 i1
& I yau Srpad he page sddress i the Address bar, maks
dure that # i dpalied cerectly
4 Opdn the nen SCERI0ICHENELIA Mema Bage, a0 than
loak far ks o the nfermatisn pos mant.
i g o o = & Chok the b Baman b try snomher bk
w Chek a B3 lack for mformatisn on Sha nternet.
a
] Done A et

2. Make an FTP connection to your website. This is usually done by typing the following into your browser:

ftp://www.%3cdomain%3e.com/
example: ftp://www.mydomain.com/

Your ISP should have provided a username and password. Enter vour username and password on the 'Loa On As' form.
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? Ethar ta perver doss not: slkw anorymous kging or e n-mall addhes mas not
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b, FIP b ik e ypk o vt it i dati befrs sevding theba the
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3. Create a subfolder named "help”

note to advanced users: This folder can have a different name if desired and can be located within any folder within your website.
W ¢

Arrange [cors By b
Rafresh

Login ...

Freperties

If your username and password were correct, an FTP connection will be made, and you will see the files and folders that make up your website.

4. Use the Windows File Explorer to view the folder that HelpConsole 2010 was installed to. The default folder is c:\program files\HelpConsole 2010\

Copy from c:\program files\HelpConsole 2010\

Cog& all files and folders exceﬁt the 'bin’ folder and 'web.config'

Copy to ftp://www.mydomain.com/help
Copy to the 'help’ folder on your website

Oy )

il -

5. Copy all files from the folder: c:\program files\HelpConsole 2010\bin to the folder: ftp://www.mydomain.com/bin
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6. Copy "“c:\program files\HelpConsole 2010\web.config" to the root of the virtual directory (ftp://www.mydomain.com/web.config)

7. Assign write permissions to the new "help" folder on your web server. You may need to call your ISP and ask them to do this, although many I1SPs now
provide a self serve administrative console.

8. To run HelpConsole 2010 from your website, type the following URL into your browser: http://www.mydomain.com/help (where 'mydomain.com’ is
the name of your website domain)

8 il onscie TU13 - Preweded iy TG0 Londieng rcvmon 232 [
0\ w g e e v = - iy x |ied v g
v TR el oracls BUG B~ v Pepr Seeye Tgoae e

WL Ll tniet | Bosteried e, S

See also

Publishing a Static Help System
Legacy Help System

Publishing a Dynamic Help System
Publishing a PDF Manual
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Home > Basic Functions > Publishing > Legacy Help System

Legacy Help System

HelpConsole 2010 supports all browsers including very old browsers such as Internet Explorer 1.0 and Netscape 1.0

This is an examile of a helﬁ sistem oEened with Internet EXEIorer iIEi 1.5.
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See also

Publishing a Static Help System
Uploading to your Website
Publishing a Dynamic Help System
Publishing a PDF Manual
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Home > Basic Functions > Publishing > Publishing a Dynamic Help System

Publishing a Dynamic Help System

A dynamic help system is esentially a help project displayed in live mode where a user is not logged in. To publish a dynamic help system, simply provide
the URL to your readers. The URL can be cut and pasted from the browser's address window, and will be in the following format:

<WebServer>/helpconsole2008/<project>
Example: http://serverl/helpconsole2010/WidgetMaster

See also

Publishing a Static Help System
Uploading to your Website
Legacy Help System

Publishing a PDF Manual
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Publishing a PDF Manual

Follow the instructions below to generate a PDF Manual
1. Open the Help System
2. If you are not already logged in, log in as an administrator with ‘publish’ permissions.

3. Click the 'Publish’ button.
Fublish

4. The Publish form will be disilaied.

POF Tee Wdget Wlaster
Yackude Linkss [
Sekected P

5. Click 'Publish PDF Manual'. A message will be displayed indicating that it was created successfully.

POF Warasl Croaied. 23 pagey adied

PDF Manual Created Successfully...

Cpen POF Manual d

P bl e LB

POF Manual Faftc £ Frogram Pl HeloConsols 20 L0 eet oo iman.al pof

The following paths are also provided:
Path Description
Publish URL Click to display the PDF Manual that was created. This URL can be published internally or

on your website.

File Path The path to the PDF manual file on the web server

6. Click the 'Publish URL' link to displav the PDF Manual
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Tkdger \lacrer

e [T y——r—"—

7. When the 'Publish’ form is reloaded in the future, a link will be displayed to the previously published PDF Manual.

See also

Customizing the PDF Template
Publishing a Static Help System
Uploading to your Website
Legacy Help System

Publishing a Dynamic Help System
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Home > Advanced Functions

Advanced Functions

Advanced Functions are features or product cababilities that a novice author most likely will not use, at least until they become more familiar with the
authoring environment. These functions include:

” ” ” ” ” ”
4 ‘ | 4 ‘ | 4 ‘ | 4 ‘ | 4 ‘ | 4 ‘

Movies & Animations Users Security Groups Variables Language Support Page Templates

A J \ \ \ \

Styles Reports Conditional Content Comments Import Page Objects

See also
Welcome

Getting Started
Installation

Basic Functions
Toolbar Reference
FAQ

helpconsole 2010



158 . Advanced Functions

Movies & Animations

Adding a flash or media animation to your help system is easy. Simply select the animation file and it will be inserted at the current cursor position.

Example:

Al N

Adding a Flash Adding a Media
Animation Animation
See also
Users
Security Groups
Variables

Language Support
Page Templates
Styles

Reports

Conditional Content
Comments

Import

Page Objects
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Adding a Flash Animation

Follow the instructions below to insert a Flash animation.
1. Position your cursor on the page where you with to insert the animation.

2. Click the 'Flash Manager" icon.

will be displayed.

4. Select a flash animation file and click 'Insert' to add it to the page. If the flash file is located on your computer or network, click the ‘Upload Flash' tab
to upload it to the web server.

5. The animation can be be deleted at any time by selecting the animation and pressing the 'Delete’ key.

See also
Adding a Media Animation
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Adding a Media Animation

Follow the instructions below to insert a Media animation.
1. Position your cursor on the page where you with to insert the animation.

2. Click the 'Media Manager" icon.

©

3. The 'Media Manager' dialog will be displayed.

4. Select a Media animation file and click 'Insert’ to add it to the page. If the media file is located on your computer or network, click the 'Upload Media'
tab to upload it to the web server.

5. The animation can be be deleted at any time by selecting the animation and pressing the 'Delete’ key.

See also
Adding a Flash Animation
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Home > Advanced Functions > Users

Users

Permissions are applied at the project level. This means that each help project has it's own set of usernames. Security is self contained within each

project which means that a help project can be moved from one server to another and all usernames and permissions are preserved.

Notes:
- The 'Admin’ username will always have full permissions.
- Permissions for the "public' username will be applied if a user is not logged in.

Project Login Adding a Project Editing a Project Deleting a Project
Username Username Username

See also
Movies & Animations
Security Groups
Variables

Language Support
Page Templates
Styles

Reports

Conditional Content
Comments

Import

Page Objects
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Project Login

When a help project is opened, and a user is not logged in, permissions are assigned based on the 'public' username. Normally there are no permissions
assigned and this is considered 'live mode'. To login to the he_lp project,_click the 'Login’ link at the top right corner of the screen.

48 testl - Powered by HelpConsoke 2010 - Presented by TOSHIA Leading Innovation 5 bl
Q.\/v 8 hitpe! Mescalbverst e 210 best pita IR | v F-
Favorites | g8 test] - Powered by HelpConsole 2010 fi-8 - = = Page~ Sabety~ Tgok= i~

T miich b edit mode, login s Udmn’ with
! password. Ths messsge sl rat be deplaped
e

W Lecal intranet | Protecied Mede OfF P [

Note: if the '"Admin’ username does not have a password, a message will be displayed stating this fact. To hide this message, assign a password to the
'‘Admin’ username.

See also

Adding a Project Username
Editing a Project Username
Deleting a Project Username
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Adding a Project Username

Follow the instructions below to add a new project username

1. Open the Help System

2. If you are not already logged in, log in as an administrator with 'tools' permissions.

3. Click the 'Tools' button to display the 'tools' form.

‘ Backup i, Properties
Users 2{\ Security Groups

I_I Variables = skns .

== Page Templates .l Styles

m Translations ﬂ About HelpConsole

4. Click 'Users' to display the 'Users' form.
B Users

ysers

Users

¥ s

5. Click the 'Add" button to display the ‘user detail form.

password, and security group. Click 'save' to create the new user.

6. Enter a username, fullname,

Ustriarme:  dean

Fallame:  Jpnes Dopn
Fassnurd aeaednes

Security Gouee | Adrmin [-]

See also
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Project Login
Editing a Project Username
Deleting a Project Username

helpconsole 2010



Advanced Functions . 165

Editing a Project Username

Follow the instructions below to edit a project username

1. Open the Help System

2. If you are not already logged in, log in as an administrator with 'tools' permissions.

3. Click the 'Tools' button to display the 'tools' form.

‘ Backup i, Properties
Users 2{\ Security Groups

"I ‘.!l'alla_lﬂei ) ] I-T_'_"'__ Sk:'_"_i I

== Page Templates .l Styles

m Translations ﬂ About HelpConsole

4. Click 'Users' to display the 'Users' form.

Aderinistrator

James Dean

5. Click the username in the list to display the 'user detail' form.

6. The actual username cannot be changed, but the fullname, password and security group can be changed. Click 'save' to update the user record.
B User Detsd =

User Detail  EEC= EEE=S.

Usirtiame:  ean
Full ame: Jpenes Dopn
Paasnird #RBERaes

Secuity Gous | Admin [=]

Notes:
- The 'Admin’ username will always have full permissions.
- Permissions for the 'public’ username will be applied if a user is not logged in.
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- The 'Admin’ username cannot be deleted.

See also

Project Login

Adding a Project Username
Deleting a Project Username
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Deleting a Project Username

Follow the instructions below to delete a project username
1. Open the Help System
2. If you are not already logged in, log in as an administrator with 'tools' permissions.

3. Click the 'Tools' button to display the 'tools’ form.

i Backup i, Properties

Users }f Security Groups

J \l'arla_Hﬁ ) ) ‘1.-—-_-: Sk_i_ns

== Page Templates
[ Enimee.. g

b Q e

4. Click 'Users' to display the 'Users' form.

5. Click the 'Delete’ icon beside the username that you want to delete.

Notes:

- The 'Admin’ username will always have full permissions.

- Permissions for the ‘public’ username will be applied if a user is not logged in.
- The 'Admin’ username cannot be deleted.

See also

Project Login

Adding a Project Username
Editing a Project Username
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Home > Advanced Functions > Security Groups

Security Groups

Security Groups determine what permissions are assigned. Users are added to a security group.

Permissions are applied at the project level. This means that each help project has it's own set of usernames. Security is self contained within each
project which means that a help project can be moved from one server to another and all Security Groups, Usernames and Permissions are preserved.

z' z' z'
¥ ‘ v ‘ v ‘

Adding a Security Editing a Security Deleting a Security
Group Group group

See also

Movies & Animations
Users

Variables

Language Support
Page Templates
Styles

Reports

Conditional Content
Comments

Import

Page Objects
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Adding a Security Group

Follow the instructions below to add a new security group.

1. Open the Help System

2. If you are not already logged in, log in as an administrator with 'tools' permissions.

3. Click the 'Tools' button to display the 'tools' form.

‘ Backup i, Properties
Users 2{\ Security Groups

I_I Variables = skns .

== Page Templates .l Styles

m Translations ﬂ About HelpConsole

4. Click 'Security Groups' to display the Security Groups form.
B Security Groups

Secu rity Groups

5. Click the 'Add" button to display the 'Security Group Detail' form.

the name, Default Skin and permissions for this securit

group. Click 'save' to create the new security Group.

p Dietail a

Security Group T

hame Reselany

Cefmitson: | Ooean =]
Pubskah
Teon

+| ke Pages
1 Coments
dororoe Cormmenis
Edt Hakoe Lists

Option Description
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Name Defines the name of the security group. Once the security group is added, the
name cannot be changed.

Default Skin Defines which skin will be displayed when a user belonging to the security group
logs in. If this property is set to '[default]’, the skin defined in properties will be
applied.

Publish If unchecked, the 'publish' button will not be displayed when users are logged in.

Tools If unchecked, the 'tools' button will not be displayed when users are logged in.

Edit Pages If unchecked, the 'edit page' button will not be displayed when users are logged in.

Edit Contents If unchecked, the design contents icons will not be displayed when users are
logged in.

Approve Comments  If unchecked, users cannot approve reader comments when logged in.

Edit Value Lists If checked, users can edit value lists for 'list' fields within datasets.

Editing a Security Group
Deleting a Security group
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Editing a Security Group

Follow the instructions below to edit a security group.
1. Open the Help System
2. If you are not already logged in, log in as an administrator with 'tools' permissions.

3. Click the 'Tools' button to display the 'tools’ form.

i Backup i, Properties
& Users -2{:' Security Groups
——— : &0 < s

I_I \!l'arla_lﬂﬁ ) ) ‘1.-—7-_-: Sk'"s st Bt ol
== Page Templates el Styles
G g 2

t HelpConsole

ﬂ llra.lllls_\lla_tlun.s ﬂ h

4. Click 'Security Groups' to display the Security Groups form.

B Security Groups

5. Click on a security group name to edit it. The 'Security Group Detail' form will be displayed.

6. The name field will be disabled. Specify the Default Skin and permissions for this security group. Click 'save' to update the security Group.

Security Group

e Resalion
CefadtSon: | Coean =

Pubish
Tois

#| g Pages
£ Cormenty
o Commerris
Edbt Yalue Lsis:

Option Description
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Name

Default Skin

Publish

Tools

Edit Pages

Edit Contents

Approve Comments

See also

Adding a Security Group
Deleting a Security group

Defines the name of the security group. Once the security group is added, the
name cannot be changed.

Defines which skin will be displayed when a user belonging to the security group
logs in. If this property is set to '[default]’, the skin defined in properties will be
applied.

If unchecked, the 'publish’ button will not be displayed when users are logged in.
If unchecked, the 'tools' button will not be displayed when users are logged in.

If unchecked, the 'edit page' button will not be displayed when users are logged
in.

If unchecked, the design contents icons will not be displayed when users are
logged in.

If unchecked, users cannot approve reader comments when logged in.
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Deleting a Security group

Follow the instructions below to delete a security group.
1. Open the Help System
2. If you are not already logged in, log in as an administrator with 'tools' permissions.

3. Click the 'Tools' button to display the 'tools’ form.

i Backup &J Properties
Users }f Security Groups

I_I \Tl'arla_lﬂﬁ )

== Page Templates Styles
[ Enimee.. g

ﬂ llra.lllls_\ll.a_tlun.s

4. Click 'Security Groups' to display the Security Groups form.

B Security Groups

5. Click the 'delete' icon beside security group hame. When prompted to delete, click OK.

:Me-sslg-eﬂnmmw 2 o]
[ |
9 Delete Security Group ‘Fesellen T

See also

Adding a Security Group
Editing a Security Group
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Variables

Variables act as placeholders for text that might change in the future. Some examples where variables may be used are:

« Product Name

« Product version

« Product Tag line

« Company Address
« Phone numbers

Variables can also contain HTML code, therefore can be used to insert dynamic content such as:

. Company logo

« Product logo

« Javascript events

« iFrames to other webpages
« Flash Animations

User Defined Variables ~ System Variables

See also

Movies & Animations
Users

Security Groups
Language Support
Page Templates
Styles

Reports

Conditional Content
Comments

Import

Page Objects
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User Defined Variables

Variables act as placeholders for text that might change in the future. Some examples where variables may be used are:

« Product Name

« Product version

« Product Tag line

« Company Name

. Company Address

« Phone numbers

« Sales & Support email addresses

Follow the instructions below to add a variable.

1. Open the Help System

2. If you are not already logged in, log in as an administrator with 'tools' permissions.

3. Click the 'Tools' button to display the tools menu.

‘ Backup ", Properties

Users ;f Security Groups
I_I ‘.:l'alla_lﬂﬁ - ) I—T_—_--__ Skins
== Page Templates . Styles
Translations About HelpConsole

4. Click 'Variables'

5. The 'Variables' list will be displayed.

- To add a new variable, click the 'add' button

- To edit an existing variable, click the variable name in the list.
- To delete a variable, click the red X beside the variable name.

Extreme Exse Software

suppor e xiremesase. com

555,555, 5555
Rt Fermrm gxciremesase com

hitp:/ Frrmrer exctremesase compheipimovdedgebase |

- 25 A db b

6. The variable editor will be displayed.
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7. Enter a name for the variable.

8. Enter a value for the variable. The value can be strai

ght text or can contain various elements such as images, flash videos, tables, etc.
0 ¥

Copyght © 2010 Extreme Ease Sofeware e, Al Righes Reserved.

9. Click the 'save' button to save the variable.

7. Variables can be inserted into any page by either typing the variable name in square brackets (eg. admin) or selecting the variable from the 'Insert
Variable' list.

Sl Page Lt
Sl Jeart Lt

Variables in Edit Mode Variables in Live Mode
(not translated) (Translated)
'3.- [Ty e ey r;-l ] [ e o e T e -ﬁ ]

R | S —— I R B g

We at [company] are commited We at Extreme Ease Software are
to providing the best service commited to providing the best
Possible service Possible

EEr——— e

[y ———r

Varaibles can also contain html elements such as images, tables, flash animations, etc.

Logo Variable in Edit Mode Logo Variable in Live Mode

(not translated) (Translated)
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[T e e | =T

T T e — TRl 7 AT B = F

B L L R —" LR ERE RN LRl ot b S st B LR il

P — bR o i [ = ——— 7

= 8 Product Logo:

(&N 2010
- HelpConsole
- R o e s b -

See also
System Variables
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System Variables

HelpConsole 2010 includes several built-in variables such as '‘page name' and 'project name' which can be added to any page at any time.

To insert a built-in variable, click the 'Insert Variable' icon and select the variable in the list.

Chervt Login
Cgntents Tabs
Carmgary

Suppert_Enal
SLPOOT_PRene
Wehate UAL
Knowiedpehase LRL
Copyright
Breadaumbs

ikl Page List

Chlld Boon st
Silng Page Lst
Slng Joon Lt

System Variables Overview

Variable Name

Project Name

Username

Short Date

Long Date

Short Time

Long Time

Fullname

Application Name Short

Application Name

Popular Pages

Popular Pages and Views

Value

helpconsole 2010

admin

17/06/2010

June-17-10

11:22 AM

11:22:03 AM

Administrator

HelpConsole

HelpConsole 2010 - Professional Edition

Welcome

General Questions
Service Pack History
Installing 11S

Getting Started
Installing the Software
System Requirements
Installation

Basic Functions

How to run the software

Most Popular Pages  Views
Welcome 8828

General Questions 2633

Description

The name of the help system project

The username of the person currently
logged in

The current short date

The current long date

The current short time

The current long time

The full name of the user currently
logged in

The application name without the
version or edition

The application name with the version
and edition

The top 10 most viewed pages

The top 10 most viewed pages and
views displayed in a table format
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Service Pack History 2134
Installing 1S 2020
Getting Started 1476
Installing the Software 1465
System Requirements 1408
Installation 1396
Basic Functions 1285

How to run the software 1285

Search Displays a search box

ProjectURL localhost/helpconsole2010/helpconsole Displays the URL to the project folder
2010/default.aspx

Breadcrumbs Home > Advanced Functions > Variables > System Displays a breadcrumb trail to the

Variables

current page

Child Page List

Child Page 1
Child Page 2

Displays a list of children pages of the
current page.

Child Icon List

o o

(3 (3

Child Page 1 Child Page 2

Displays icons of children pages of the
current page.

Sibling Page List

User Defined Variables

Displays a list of pages at the same
level as the current page. Excluding
the current page.

Sibling Icon List

g

&

User Defined Variables

Displays icons of pages at the same
level as the current page. Excluding
the current page.

Menu

User Defined Variables
System Variables

Child Page 1

Child Page 2

Displays sibling and child pages of the
current page in a menu format

Article Details

Article Information

Author:  admin

Created: 30/05/2008 1:16 PM
Modified: 30/03/2010 2:24 AM

Page Details displayed in a table format

Views: 970
Page Name System Variables The name of the current page
Page Views 970 The number of times that the current
page has been viewed
Author admin The username of the person that

created the page

Date Created

30/05/2008 1:16 PM

The date that the page was created
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Date Modified

30/03/2010 2:24 AM

The date that the page was last
modified

Parent Page Link Variables Displays a link to the parent page
Popular Child Pages « Child Page 1 The top 10 most viewed child pages
. Child Page 2 under the current page
Comments Allows readers to submit comments for
& Administrator said: the page.
This is an example of a comment
25/03/2009 3:07:27 PM
Page URL localhost/helpconsole2010/helpconsole Displays the URL for the currently
2010/default.aspx?pageid=System_Variables displayed page.
See also

User Defined Variables
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Home > Advanced Functions > Variables > System Variables > Child Page 1

Child Page 1
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Home > Advanced Functions > Variables > System Variables > Child Page 2

Child Page 2
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Home > Advanced Functions > Language Support

Language Support

HelpConsole 2010 provides full language translation to almost any language. All aspects of the interface can be translated including tooltips, dialog
headings, etc.

-
”

Language Translation

See also

Movies & Animations
Users

Security Groups
Variables

Page Templates
Styles

Reports

Conditional Content
Comments

Import

Page Objects
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Language Translation

HelpConsole 2010 provides full language translation to almost any language. All aspects of the interface can be translated including tooltips, dialog

headings, etc.

Follow the steps below to translate a help system from English to another language such as Japanese:

1. Open the Help System

2. If you are not already logged in, log in as an administrator with 'tools' permissions.

3. Click the 'Tools' button to display the "tools’ form.

i Backup
& Users
J Variables

Ea Page Templates
" |t fang iy

b Translations

i Properties

8‘) Security Groups

= Skins

2 Styles

ﬂ About HelpConsole

]
e
A—tA) S
~—LADURL
LA T FRR
A EAN
A TR
WARFELATIHI AL
ol
LT
Vv W ER
Usemame: 2~ 7 — &
Pasweedt 1120 —F
Logee L5
Search for: EHTR

g unkc
Page L1

Ve Makdhes Fourd For:

A Somment

Cormeed Do

Personall Comment onky vasble o
St

S PR PSR

4. Click 'Translations' to display the language translation form.

Laived Seplaped sive Cments

L Bspha il vE KEnword Db
Labed Bpplapesl e panchiemdts
Capbon of prinkicon in sl
Capton of ek won in dan

Capton of bodkmart on in dan

Pagge Uk dhakoey acing

Parge Ik dhalog capien

Seanch « e el found Fdisadn

el C oty ba e Capin,

el ey chaing) headirg
Cowrmerst [aing 0000 test
Copmmnairdy Bk B g [ledmen )

Teet For pOpl QRS 87 wawy it
Terct For opudar s and vt wariatie:
Userruame: label for ‘clers login' variable
panzwcrd label for 'dent logr’ variable
Livgs bt capriion o “cert logn’ varishle.
Search teat bl -

5. Enter a translation in the 'Value' field for each row. The description states what the translation is and where it is displayed.

6. Click 'save'

7. All aspects of the user interface will be displayed in the new language, except for the page names in the contents and the page content, which can

be chanaed bv editina the contents and editina each paae.
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B s s . P by e 1 ey TR Sy R s e |
T T ro— SECIELL | P =

Tramin e s fadp P by iy e 8~ @ b Ly T @

S =

[ p—————

See also
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Home > Advanced Functions > Page Templates
Page Templates

Templates define the default layout and content when creating a new project or adding new pages to the project. Templates save you time because
you don't have to retype the same content each time.

If you, or other authors will be creating several Help Systems, it may be useful to modify the project template for your specific application. If most of the
pages that you add to your help system have the same format, it may also be useful to modify the page template.

Customizing a Page Creating a Page Customizing the PDF
Template Template Template

Movies & Animations
Users

Security Groups
Variables

Language Support
Styles

Reports

Conditional Content
Comments

Import

Page Objects
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Customizing a Page Template

If most of the pages that you add to your help project have the same format, or elements that are the same, it may be useful to customize an existing
page template or create a new one.

Follow the steps below to customize the 'Help Page' template.

1. Login to your help project as an administrator with the ‘tools' permission.

2. Click the tools button to show the 'Tools' menu.

i Backup i Properties
Users 2!‘« Security Groups
B R

'I \!falla_lﬂe-s )

Ea Page Templates

ﬂ Translations ﬂ About HelpConsole

3. Select 'Page Templates' to display the ‘Page Templates' form.
B FageT

Page Templates

» Pyt Temgiates

X Helo Page

Note: To delete a template, click the 'delete" icon.

4. Use the template editor to modify the content. You may want to include your product or company logo to the top of each page, as shown in the
example below. Click 'save' to save the template.
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2010
HelpConsole

[page name]

[T cparing panagrac should descrbe: e Seadre St you e Gacamendng: Explan bow i & commory used and what e Serwits we For
[rcamgs Ther ekt Mmater aomasd ok o 'y el oo maphion o ch Sk I WO KA s e 7T gy ¥,
#u frare Fuak vou e documendng can be bet exclared by sakeng e resde Srah tim By siep. Use screershon o sk sie e v
=here oo

T e by

L Onte et o, ookt
1

5. Each new page added to your help system will be created from this customized template.

am-mhwm-mymuu...- - e Sl |
L+ I Y p—— BRG] L
N T 1 a——r T REE L Ry

= | @y
i ™ HelpCof&de

[page name]

See also
Creating a Page Template
Customizing the PDF Template
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Creating a Page Template

If your help system will have different types of pages with with elements that are the same, it may be useful to create a page template for each type of
page. Page templates are located in the project folder and have the format:

Follow the steps below to customize the 'Help Page' template.

1. Login to your help project as an administrator with the ‘tools' permission.

2. Click the tools button to show the 'Tools' menu.

i Backup i Properties

Users 2!‘« Security Groups
Y Y
'I \!falla_lﬂe-s ) ] I—.:—_ Skms et ot
== Page Templates 2 Styles

Translations About HelpConsole

3. Select 'Page Templates' to display the ‘Page Templates' form.
B FageTe

Page Templates

5 = Page Tesgiates

X Helo Page

T ——
4. Click the 'Add' button to display the 'Template Editor'. Click the 'copy' icon if you wish to create the template based on an existing template.

5. Use the template editor to create the paae content. Click 'save' to save the new template.
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2010
HelpConsole

[page name] '

[T cparing panagrac should descrbe: e Seadre St you e Gacamendng: Explan bow i & commory used and what e Serwits we For
armgsa: Thar wietgut réormartion abo dich SR IS W N et s 7O Compay. ¥,
#u frare Fuak vou e documendng can be bet exclared by sakeng e resde Srah tim By siep. Use screershon o sk sie e v
=here oo

T e by
1 Ontw varts s, do
E

6. Each new page added to your help system will be created from this customized template.

am-mhwm-mymuu...- - e Sl |
L+ I Y p—— BRG] L
N T 1 a——r T REE L Ry

= | @y
i ™ HelpCof&de

[page name]

See also

Customizing a Page Template
Customizing the PDF Template
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Home > Advanced Functions > Page Templates > Customizing the PDF Template

Customizing the PDF Template

The look and feel of the PDF manual can be customized by editing the PDF Manual template. Follow the instructions below to edit the PDF template.
1. Open the Help System

2. If you are not already logged in, log in as an administrator with ‘publish’ permissions.

3. In the contents window, expand the '"Admin’ node until the 'PDF template’ pages are visible.

4. Select the PDF template page that you want to edit and click 'Edit Page’
e e e e

A Te—— <T 8 [ ¢ 0 e 7
o Pt v B by P e 1533 B0 -0 e ey T @ 7

- Wy Lol e Pl b b 290 T

6. Edit the page as needed. Click 'Save' to save changes.

Default PDF Pages

Page Description

PDF Cover Page When printed, this is the outer cover page of the manual.

PDF Blank Page 1 | This blank page is included after the cover page so that the title page always appears on the
right side when the reader opens the manual.

PDF Title Page The title page normally introduces your product or service. You might include the author's
name, company name, company logo, copyright information, etc.

PDF Blank Page 2 | This blank page is included after the title page so that the Table of contents always appears
on the right side when the reader opens the manual.

PDF Table of The table of contents lists the pages included in the manual along with page numbers.
Contents

PDF Chapter Title | This page is displayed before each chapter.

Page

PDF Headers and | Determines what will be displayed at the top and bottom of the page. Normally the page
Footers number, chapter name and the title of the help system.

PDF Index Displays the keyword list for the help system. Readers can click a keyword to jump to the

associated page.

PDF Back Cover The back cover usually just displays the product name or logo, with a tag line. You could
also include something like "Printed in Canada"
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See also
Customizing a Page Template
Creating a Page Template
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Home > Advanced Functions > Styles

Styles
The look and feel of your help pages or table of contents can be customized by editing the style sheet. You can customize any of the following:

. Page Margins

« Background colors

« Background images

« Default Font (size, color, type)
. Table formating

. Etc.

HelpConsole 2010 uses the following stylesheets:

AppStyles.css - Styles applied to all help systems.

PageStyles.css - Styles applied to the specific project.
Style_{skinname}.css - Styles applied to a specific skin for a specific project.

Application Styles Page Styles Skin Styles Applying Styles Editing the 'Apply
Styles' List

Movies & Animations
Users

Security Groups
Variables

Language Support
Page Templates
Reports

Conditional Content
Comments

Import

Page Objects
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Application Styles

Styles can be applied at the application level that are applied to all projects.Some of the styles that you might want to customize for your project are:

. Page Margins

« Background color

« Background image

« Default Font (size, color, type)
. Etc.

Follow the instructions below to edit application styles (AppStyles.css):
1. Open the Help System
2. If you are not already logged in, log in as an administrator with 'tools' permissions.

3. Click the 'Tools' button to display the 'tools' form.

Properties

o Variables

== Page Templates

b

B [rmstsone

4. Click 'Styles' to display the stylesheet editor. The stylesheet 'PageStyles.css' is displayed by default.

5. Select 'AppStyles.css' in the list.

5. Modify anv existina stvles or add new stvles.
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Ealvecics, sans-serif;)

5. Click 'Save' to save the styles in 'AppStyles.css'

See also

Page Styles

Skin Styles

Applying Styles

Editing the 'Apply Styles' List
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Page Styles

Each help project contains a stylesheet named "PageStyles.css" which contains styles that are applied to the specific project. These styles can override
and/or compliment styles in "AppStyles.css”. Some of the styles that you might want to customize for your project are:

. Page Margins

« Background color

« Background image

« Default Font (size, color, type)
« Etc.

Follow the instructions below to edit page styles (PageStyles.css):

1. Open the Help System

2. If you are not already logged in, log in as an administrator with ‘tools' permissions.

3. Click the 'Tools' button to display the 'tools' form.

i Backup . Properties
& Users 3‘} Security Groups

J Variables '1.--_-:.- Skins

Ea Page Templates
] ot e see st

(i Tronsionons

4. Click 'Styles' to display the stylesheet

. Modify any existing page style or add new styles.

e Modify the 'page_body' stylm to change font, [aQN BATELN, WTC. =—ee= *F

sass-sarLls

. Helvetles, ssss-serlis

5. Click 'Save' to save the styles in 'PageStyles.css'

See also
Application Styles
Skin Styles
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Applying Styles
Editing the 'Apply Styles' List
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Skin Styles

Each help project can have multiple skins. Each skin has a corresponding stylesheet in the format "style_{skinname}.css". These styles can override
and/or compliment styles in "AppStyles.css", and "PageStyles.css". Some of the styles that you might want to customize for the skin or page are:

Styles can be applied at the application level that are applied to all projects.Some of the styles that you might want to customize for your project are:
. Page Margins
« Background color
« Background image

« Default Font (size, color, type)
. Etc.

Follow the instructions below to edit skin styles (Style_{skinname}.css):
1. Open the Help System
2. If you are not already logged in, log in as an administrator with 'tools' permissions.

3. Click the 'Tools' button to display the 'tools' form.

Properties

‘?Q Security Groups

ﬂ Translations ﬂ About HelpConsole

4. Click 'Styles' to display the stylesheet editor. The stylesheet 'PageStyles.css' is displayed by default.

5. Select the skin stylesheet in the list.

5. Modifv anv existina stvles or add new stvles.
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scTgrousd-
erberder-rl

5. Click 'Save' to save the styles in the skin stylesheet.

See also

Application Styles

Page Styles

Applying Styles

Editing the 'Apply Styles' List
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Applying Styles

You can apply certain predefined styles to elements on the help page such as text, links, images, tables, etc.
For example, to apply a style named 'Yellow_Background' to text on the page, do the following:

1. Open the Help System

2. If you are not already logged in, log in as an administrator with 'tools' permissions.

3. Select a page and click 'Edit Page'

4. Click the 'Show More Tools" icon to show additional functions.

5. Highlight the text on the page that you want to apply the style to.
B U _ -

AR KA LA

8 - .

[ ‘.‘\\l [project name]

Online Help

‘Wepioome o the [praject name] crine helc wyster. Srpmen Erough S beko pages by clcking an B oo
tarics or peirctng pages n e table of contends ko B lefe. To quickéy hnd mpech product riormason, e
mparch crteria in the seanch bow sbhosw and cick the search button

O

A
{Sirg Loon L] Ask Us u

¥ wraire urabie 5 g what 5

7. If the 'yellow_background' style is modified in the future, any text with this style applied will be automatically updated. Refer to "Editing the 'Apply
Styles' list " for more information.

See also

Application Styles

Page Styles

Skin Styles

Editing the 'Apply Styles' List
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Editing the 'Apply Styles' List

Sizer B U -

DEDCRF-"'™Eel

g

You can customize which styles are available in the "Apply Style' list. Here's how to do it:
1. Open the Help System
2. If you are not already logged in, log in as an administrator with 'tools' permissions.

3. Click the 'Tools' button to display the 'tools' form.

i Backup i, Properties
& Users 2{:] Security Groups
——— : &0 < s

P Variables = skins
== PFage Templates .l Styles
ﬂ Translations ﬂ About HelpConsole

4. Click 'Styles' to display the style editor. The 'PageStyles.css' styesheet is displayed by default.

5. To include a style that will apply a yellow background with black text, type the following. Make sure that you include /*stylelist*/ after the style name.
This specifies that it will be included in the apply style list:

|. yel | ow_background /*stylelist*/ {background-col or:yellow, col or: bl ack}

6. Click 'Save' to save the stylesheet.
Note: The /*stylelist*/ attribute can be included for styles in "pagestyles.css", "AppStyles.css" or the skin stylesheet.

7. Click the browser refresh button to reload your help project so that this new style takes effect.
8. Click the 'edit page' button to display the editor toolbar.

9. Hiahliaht the text that vou want to apply the stvle to. and select the 'vellow backaround' stvle in the ‘applv stvle' list.
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L] Saex B
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i‘ N [projedt name]

Online Help

‘Wepioome o e [prajest nama] crine helc wysters. Brpsasn Bough B helo: pages by clcking on B oo
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See also
Application Styles
Page Styles

Skin Styles
Applying Styles
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Home > Advanced Functions > Reports

Reports

The following reports are included with HelpConsole 2010

;\j ;\j ;\j ;\j ;\j
Activity Log Report  Page Status Report Unused Images Report Pending Comments  Customizing a report
Report

See also
Movies & Animations
Users

Security Groups
Variables

Language Support
Page Templates
Styles

Conditional Content
Comments

Import

Page Objects
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Home > Advanced Functions > Reports > Activity Log Report

The "Activity Log Report' lists reader and administrative actions. This can be useful to track reader trends such as which pages are most commonly
viewed or what readers are searching for. Follow the instructions below to view the ‘Activity Log' report.

1. Open the Help System

2. If you are not already logged in, log in as an administrator with 'tools' permissions.

3. Expand the 'Admin’ node to view the predefined reports. The reports included may be different depending on the project template that your project
was created from.

Contents & 0 o [esavea(x]

® | Gatting Started

# {j | Basic Functions
[# |y ) Adwvanced Functions
¥ {} | Tutorials

)| FAQ

Admin
& Reports
& Page Summary
& Activity Log
& Pape Status
& Urused Images
& [Pending Comments
[# == POF Template

4. Click 'Activity Log' to view the activity log report.
Note: If there are no entries displayed, then the "Activity Log' setting in project properties is most likely set to 'Record No Actions'. To change this, click
"Tools > Properties" and then change the 'Activity Log' setting to 'Record All Actions' or '‘Record Admin Actions'.

| EctFage | .
Activity Log
w s [ | -
P fadiess
Clear Log
Lisrusess: | @edmin
Deesoripbon
T Uger Decrioon
I LSRR admn {1I7.0.0.1) Echted Fage TAJ
L2009 LSETIPM admin (12700, 1) Sared Page FALY
L5A273000 T:41=43 PM admin {137.0.0.1) Changed page id fom ‘reports” 1o ‘admin_reporis’
VR0 3AT00 PM sk [137.0.8.1) Changed page il Fom “actvity_log b adein_acthity_log
EHI2009 3400 P admn (127.0.0.1) Changed pege i Fom ‘page_sammary o 'admin_page_summany’
ZHOLIN A IEZIPM admn (LI7.0.0.1) Fage Addsd PO Template’ (d: pdf_templase)
2HO1010 4 2048 PM admin (127.0.0.1) Page Added VOF Cover Page” {d: pdf_cover_paget)
IO AITEEPM admn [1270.0.1) Pisge Addhed POF Back Covr’ ek gl bastk,_sivar 1)
LU0 &ZEH admn [1270.0.1) Page Added POF index’ it pdf_index1)
2HOLI0 42356 P admin {137.0.0. 1) Fage Added Help Fages] (di (help_pages)1)
220010 42256 PM admin {137.0.0. 1) Page Added POF Hesdens and Foaters” (x: paf_fetiders_and _footers 1)
TR AT P admn (LI7.0.0.0) Pusge Added TOF Table of Contents! (ck paf_tubleof_contersal)
IO 4ITH P admn [1270.0.1) Page Added PO Dlark Page ' {d: pdf_blank_page_21)
VL0 £ 225 P admn {13700, 1) Page Added TOF Titke Page’ i pdf_Stie_pege 1}
IROL0A0 ATEEEPM s (127.0.0.1) Page Added POF Blank Page ¢ (! pof bk pae 11)
SR AT P aden (13700010 Eckted B "adrin_reponts’
22012010 42801 P admin (L3700 1) Edited Page ‘pdf_template’

5. By default, only the activity for the current day is displayed, however you can change the date and time to display acvities for the last week, or the
last year. You can also filter the report by IP address, username or activity type.

Tips:

- To filter the list to display only reader searches, enter 'Searched' for ‘description’ and then click 'Run Report'.
- To display activities since January 1 2009, enter ">1/1/2009" in the 'time’ field.

- To display activities for a specific reader, enter a specific IP address in the 'IP Address' field.

See also

®* Page Status Report

# Unused Images Report

# Pending Comments Report
# Customizing a report
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Home > Advanced Functions > Reports > Page Status Report

Page Status Report

This report is used to list help pages that have a specific status assigned. For example, you can list all pages that have a status of 'incomplete’. Follow
the instructions below to view the 'Pending Comments' report.

1. Open the Help System
2. If you are not already logged in, log in as an administrator with 'tools' permissions.

3. Expand the 'Admin’ node to view the predefined reports. The reports included may be different depending on the project template that your project
was created from.
Conterits & €3 2 [ save s [x]:
B vicicom |

11| Gettng Started

1) Bask Funclions

1) Advanced Functions

{1 Tutorials

i) FaQ

Admin
4 Reports
& Pags Summary
& Activity Log
& Page Status
& Urnsed Images
& Pending Comments
¥ <= POF Template

4. Click 'Page Status' to view the page status report.
Ov I Fttpe s poltesrsconacia.com Toss ! delsut sipeUnemarme: 52 -| Bl x | ’-‘_l Google 2o

7 Favorites i Teutd . Prweed by HelpContale 2100 Sic @ -0 # v Bagew Seleyr Toohr @

Coments L3 Bl | Punk e 0 Dookmark Pt

[
Page Status

« Change the 'Status Filter' to display pages with a specific status, or to display all pages.
« Click 'Print' to print the report.
« Click the page link to load the page.

See also

Activity Log Report
Unused Images Report
Pending Comments Report
Customizing a report
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Home > Advanced Functions > Reports > Unused Images Report

Unused Images Report

This report is used to list images that are currently not used within the project. This allows you to review and remove unneeded images. Follow the
instructions below to view the 'Unused Images' report, and remove unneeded images.

1. Open the Help System
2. If you are not already logged in, log in as an administrator with 'tools' permissions.

3. Expand the 'Admin' node to view the predefined reports. The reports included may be different depending on the project template that your project
was created from.

Contents & €3 2 [ save s [x]:

L

# lj | Getting Started
() | Basic Functions
[# 1) Adwanced Functions
(| Tutorisls

* {1 FaQ

Admin
4 Reports
& Page Summary
& Activity Log
& Page Status
& Urnsed Images
& Pending Comments
¥ <= POF Template

4. Click 'Unused Images' to view the unused images report. The report will list Images that are not found in the following:
- Help Pages
- Page Templates

- Variables
- Stylesheets
- Contents (pagename.gi
Heolptomole 3855 - 18 -
)™ [ e tecaom s coscde a0 W ool AL ekt s v @] [ |3 oo I
g Frverim | ) Vet onscle D0 - P by HepComcle 318 | Bi-B - & - e ieys Tgehe @ 7
Corteras K7D L B gl bk dndes 7 Bockmark e Pent 2]
e O
w1 e Seed Unusedl
; . The =t o s, o atien. )
;E:ﬁ-— _'m:ﬂ":u;m S Hbain s, i (agE ek e s Fat
) e Furciors
' ] Tober Rt
) Mgy 1 55, o ke P - 3003 b orme of + AN :
. | Desete Setecied images
o L Adee o
9\'..-,_. I %, | Bsmgr ke Permmsons « 2003 rgit o e gl
© Pagt Sy :
| Aty log | =]
oy e 7| Bamign irsn Parmesmiona - dck bl comiralgif
:nnn-.n—n ::_'_:lan-lr—r--r@xddltbﬂ
_wwm-whnﬂrmr
([P Y p——
l_!w'h"---'lh'i‘lﬂldﬁ--v‘
Deee: i Locl stumet | Proteciod Mode. DF Rt

5. Select the images that you want to delete (or click 'Select All'), and then click 'Delete Selected Images'.

Note: Click the image thumbnail to display the full-size image.

See also

Activity Log Report

Page Status Report
Pending Comments Report
Customizing a report
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Home > Advanced Functions > Reports > Pending Comments Report

Pending Comments Report

This report is only used if you allow readers to submit comments to your help pages. When a reader adds a comment to a page, the comment will be
assigned a status of 'pending’, 'visible' or 'hidden'. This report lists all comments that have been submitted for your help project which can be filtered by
comment status.

Follow the instructions below to view the 'Pending Reader Comments' report.

1. Open the Help System

2. If you are not already logged in, log in as an administrator with 'tools' permissions.

3. Expand the 'Admin’ node to view the predefined reports. The reports included may be different depending on the project template that your project
was created from.

Contents & € 2 [esaves [x]:

.

¥ ) | Gatting Started
() | Basic Functions
1# 1)) Advanced Functions
(| Tutorials

® 4 FAQ

Admin
4 Reports
4 Page Surmary
& Activity Log
& Page Status
& Unused Images
& Pending Comments
¥ <= POF Template

4. Click 'Pending Comments' to view the pending comments report.

GU- L U T U W — [ &[4[ AU Gougie A

i Frosties |8 Test . Powered by HelpCerasle B Epw D = 2 - Bigew Sibetye Tosho @
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 Wenlcame
[Ip——— Pending Reader Comments e Potes = [Free] s
¥ {3 e Pureers
[y Te———— e e Comrant
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* e Ry P s bl reflalieg o Windows Sels. W reseeedheg T oo o
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« Change the 'Status Filter' to display comments with a specific status, or to display all comments for the help project.
« Click 'Print' to print the report.
« Click the page link to load the page. Once the page is loaded, you can change the status for the specific comment.

See also

Activity Log Report
Page Status Report
Unused Images Report
Customizing a report
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Customizing a report

Some reports can be customized such as the 'Page Summary' report. This report could be customized to include an '"HTML' field that will show a preview of
the page content. Follow the steps below to customize a report:

1. Open the Help System
2. If you are not already logged in, log in as an administrator with 'tools' permissions.

3. Expand the 'Admin’ node to view the predefined reports. The reports included may be different depending on the project template that your project
was created from.
Contents @ © o [esaven)[x]:

*® (| Getsng Started

# ) Basic Functions

& (1) Advanced Functions
® f}) Tutorials

® () FAQ

4. Click the report that you want to customize. For example the 'Page Summary' report:

5. Click 'Edit Paie'. The reiort will be disilaied in edit mode.

[page name)

Caanat £ g
Ren Heped
avated by
TR e
mdidied by
ccisie date
ok 10 o i
L oresnend by resied Sate seifed by el dane:
(oporce] [omoraind bn]  foeocoeied detr]  fewoodtedy]  omnowsdted det]

6. Click the 'Click here to add Fields' label to display the 'Find Properties' window.

7. Click the 'HTML' field to add it to the report. It will be added to the end of the detail row and a search field will be added.

50U Query: gebect * from [_help page:
Sart Feld:
Show Al [

8. Click 'Save' to save the report.

9. Now when the report is run, a preview of the paae will be displaved:
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See also

#* Activity Log Report

#* Page Status Report

#* Unused Images Report

#* Pending Comments Report
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Conditional Content

You can control which pages are displayed or what text is displayed on each page based on the current skin. For example if you had two similar products
'Widget Master Lite' and 'Widget Master Pro’, you could create a single project that generates help systems for both products.

Conditional Pages  Conditional Content byConditional Content byConditional Content by Conditional Variables
Skin User Query

See also

Movies & Animations
Users

Security Groups
Variables
Language Support
Page Templates
Styles

Reports
Comments

Import

Page Objects
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Home > Advanced Functions > Conditional Content > Conditional Pages

Conditional Pages

Let's say that you have a software product with two editions, "Widget Master Lite Edition" and "Widget Master Professional Edition" and you want to
generate a separate help system for each product edition. Most of the content will be the same, however some features are included in the professional
edition but not the lite edition.

1. In this scenario, you would create two skins, one named "Widget Lite" and one named "Widget Professional”. See Managing Skins
e ]

et Lite
YWidget Pro
More Skins...

2. Add two 'welcome' pages to the table of contents "Welcome to Widget Master Lite" and "Welcome to Widget Master Professional”. See Adding a Page

Skin

3. Click the properties icon.

4. Select the "Welcome to Widget Master Lite" page, and then check the "hide" checkbox for the "Widget Pro" skin. This will cause this page to be
hidden when the "Widget Pro" skin is applied. Do the same for the "Welcome to Widget Master Pro" page.

antents 0 0 o [Esavei<i Contents O 0 o s
Bl Welcome ho Widget Master Lite
| Wekome to Widget Master Pra
® |} | Gating Started ® 4| Getng Started
F )| Bask Functions # )| Bask Functions
# |y | Advanced Functions % |y) Advanced Functions
# | Tutorials & ) Tutorials
® )| FAQ #® ) FAQ
&y Admin & O Admin
B Standard B standard
Page Mame;  Vilcome to Wisget Master Lie FageMame;  VWeleame o Witget Master Pra
Page ID: welcome_to_widget_master_Ke Page ID: welcome_to_widget_master_pro
Stahs: |; St lL
Fagelcon: [Aul) [=] Pagelcon:  [Aul] [=]
Type: HTML Page: Type: HTML Page:
B Eeywords B Keywords
B Visibility by Skin B Visibility by Skin
ride Lock Skin
W] [y Wicipet_Lite
] t_Pro

'Hide/Lock' Overview:

Hide - If checked, the page will be hidden for this skin and will not be displayed in the contents, breadcrumbs, system variables, etc., however can still
be displayed by passing the pageid in the URL, or from a link from another page.

Lock - If checked, the page cannot be viewed by specifying the pageid in the URL (or a link from another page).

Widget Lite skin applied in live mode Wldget Pro skin applied in live mode

Welcome to Widget Master Lite R Welcome to Widget Master
Professional

s A - LT B
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See also

Conditional Content by Skin
Conditional Content by User
Conditional Content by Query
Conditional Variables
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Conditional Content by Skin

Conditional Content
Let's say that you have a software product with two editions, "Widget Master Lite Edition" and "Widget Master Pro Edition" and you want to generate a
separate help system for each product edition. Most of the content will be the same, however some features are included in the professional edition but not
the lite edition.

1. In this scenario, you would create two skins, one named "Widget_Lite" and one named "Widget_Pro". See Managing Skins

2. Select the page that you want to add conditional text to.
Contents ) & 0 | Save . ||x|

3. Click the 'More' button on the toolbar to show additional functions.

4. Click the icon to display the 'Insert Condition' dialog.

Select e shins that this condibional | Inse
et will be visbiz for, L -

Widget_Lite
CIwidges_Pro

5. Select the skin(s) that this conditional content will be visible for, and click ‘Insert’

6. The conditional content will be contained within orange start and end tags. In the example below, a condition was added for each skin to display the
product title.

Widget Master Lite
Widget Master Pro

7. This is how the page will look in live mode:

Wldget Lite skin applied in live mode Wldget Pro skin applied in live mode
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Notes:

- If you want to remove a condition, just delete the start and end tags.

- If you want to edit a condition to include another skin, double click the 'IF' tag and type the skin name. Make sure that skins are separated by commas.
- Conditions can include pretty much anything including text, images, flash animations, variables, iframes, etc.

See also
Conditional Pages

Conditional Content by User
Conditional Content by Query

Conditional Variables
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Conditional Content by User

Enter Conditional Content Here

The "conditional content by user' function is useful if you want to display information or other content for certain users but not others. Follow the steps below to insert
conditional content for one or more specific users.

1. Select the page that you want to add conditional text to.
Contents R X ] | Save ||x

2. Click the 'More' button on the toolbar to show additional functions.

3. Click the E icon to display the 'Insert Condition' dialog. Select the 'Username’ tab.

Usu'ndm“ “

Select the umers that the cordiioral |
et wll be visile For. L

g,

4. Select the users that this conditional content will be visible for, and click ‘Insert’

5. The conditional content will be contained within orange start and end tags. In the example below, a message will be displayed if a user logs in as 'Admin’.
SEFEEE-P T

(i“q [project I'-1dIT'IE]
Online Help

Hello Administrator

This massage is crily visible when logged in as ‘Admin'

6. This is how the page will look in live mode:

Not Logged in Logged in as Admin
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Notes:

- If you want to remove a condition, just delete the start and end tags.

- If you want to edit a condition to include another user, double click the 'IF' tag and type the username. Make sure that users are separated by commas.
- Conditions can include pretty much anything including text, images, flash animations, variables, iframes, etc.

See also

Conditional Pages
Conditional Content by Skin
Conditional Content by Query
Conditional Variables
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Conditional Content by Query

The 'conditional content by query" function is similar to the ‘conditional content by user' function, however instead of selecting specific users from a list,
a query determines which users the content will be visible for. Follow the steps below to insert a condition based on a query:

1. Select the page that you want to add conditional text to.
Contents [+ X ] |= Save || X

# ) b
+ d.'I_IM" 1A
H {j| Tutorials
(1| FAQ

2. Click the 'More' button on the toolbar to show additional functions.

3. Click the m

icon to display the 'Insert Condition’ dialog. Select the 'SQL' tab.
TrEaE-PF !

E I -

Soacify & SO0 Statesent that mi Ins
produce 8 ket of uiens that tha L r
ciarnditaongl teat wll be viskie for.

USSERARS LXOE [_UBeT
lmacurisy group]l = "ad

4. Enter the query that will generate a list of users. The query should generate one column which is the ‘username' column. Click 'Insert’

5. The conditional content will be contained within orange start and end tags. In the example below, a message will be displayed if a user is logged in
and is assigned to the

admin' security group.

L/‘ \\ | [projedt name)

Online Help

Hello, Your username is assigned to the "Admin' group.

6. If the user is loaaed in and the username is assianed to the 'Admin' aroup. thev will see the conditional messaae:
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Online Help

Hells, Yiour ussmamne [ assigred to the “Admin’ group.

Notes:

- If you want to remove a condition, just delete the start and end tags.

- If you want to edit the query within the condition, double click the 'IF' tag and revise the query.

- Conditions can include pretty much anything including text, images, flash animations, variables, iframes, etc.

See also

Conditional Pages
Conditional Content by Skin
Conditional Content by User
Conditional Variables
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Conditional Variables

Conditional content can be included in user-defined variables. If you have conditional content that you want to include on several pages, this will save time
because the condition doesn't have to be re-inserted each time. Follow the steps below to create a conditional variable and insert it into a page.

1. Click the 'Tools' button to display the ‘Tools' menu.

‘ Backup 4 Properties

Users ;(\ Security Groups
o . > . i -
& - &g o
F} Variables E Skins
== Page Templates . Styles
[ o
L Ttans_»la!:lon.s ﬂ .ﬁfbc:ut HelpCmsoIe
% . ehing trel B uaars

2. Click 'Variables'

3. Click 'Add"

4. Click the 'Show Toolbar' button

5. Click the 'Insert Condition' icon.

Sedect the sins that this conditional |
tewt will be vishle for, L

Midges_Lite
[CIvwidges_Pro

6. Select the skin(s) that you want the conditional content to be displayed for.
7. Click "insert"

8. Enter a name for the variable (eg: "Msgl1"

This message is displayed when the "Widget_Lite' skin is applied,

9. Click the 'Save' button to save the variable.
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10. Close the 'Variables' form.

11. Select the page that you want to add the conditional variable to. Click 'Edit Page' to switch to edit mode.

12. Type the name of the variable in square brackets. (eg: [Msg1])

Gﬁq [project name]
Online Help

See also

Conditional Pages

Conditional Content by Skin
Conditional Content by User
Conditional Content by Query

| ek  Index  <'yBockmark (M Print

7R

This message is displayed when the "Widget_Lite' skin

is applied.

lisadean

Online Help
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Home > Advanced Functions > Comments

Comments

The 'Comments' feature allows readers to submit comments about the page that they are currently reading. These comments could be anything from
informing the author about a spelling or gramatical error, feedback about the specific feature, reporting an incorrect step in the instructions, or a note
that may help other readers in the future.

-1 N

@ Ay

!.wmmmuvhmﬁwMMnmw
G_ T

I T

T ] 8 PRI LT bk T o Winadou: VI St T She
Takka bk o P Followng ar ke Rt oo Lrronoft com kb S-S

There are two types of comments: Personal Comments and Public Comments.

!\i
Adding Comments

See also

Movies & Animations
Users

Security Groups
Variables

Language Support
Page Templates
Styles

Reports

Conditional Content
Import

Page Objects

Jooa

Personal Comments Approving Comments Managing Comments
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Adding Comments

If a page contains the "[ comments ]" system variable, readers will be able to submit comments for the page. To submit a comment, do the following:

1. Click the 'Add Comment' button
| Add GComment |

2. Type your comment and then click 'Add Comment'.

1 discovered that Helplonoods chn fuf of Winddws 7 S4hit, but the ‘Enable 32-
bit Applications” setiting must be set bo True. Take & look 2t the l'nlkmmﬂ articke:
http: Feceens extremessse comphelpknowdedgebass/defaut s
pageid=jet_sledb_provider_not_registered

Pargonal Comment orly visble by admn ||

3. By default comments are displayed right away, however this can be configured so that comments must be approved before being displayed.
IR Wy N [= 1

Coraerns o

9wmmmmnfbimﬁmwMMnmh’m

Weicame
= (] Gemng St
= A lreulaver Co e -
Lpiien bourerels
W ) Srisalleg 15
# {1 Asmgring rie Pememcrs
Creaang o irkaal Dreciary
: i Lt
pgradeng Fom FeipConsle 2007 L—
BT T AL Gy e
T 2 dacmaned Fat FslpCoraoks can b rum on Windosss, mmrmnm:.wm:ﬂmm-wuw "
- T 8 ok ot Erh:mr:.:\:k Bt aupper tmerose e com
LFL Paramater .
Servion Fack Histary
= L e Fungmong
B (L] ddvanced Purchons R nenpme
B | Teole Seteee Thanks for S informator. 1pe S emor “The Mcroeoft Jet/ OLEDE. 4 1) prowcier i mot regetsred o the ool machre”, and
w [y Fad ey Bl et fued the probles.
£t weort B s ity o Wirckoms 2008,
‘ Anarrpraus Sad
Thanks. This morked Gres®
A S
-
Notes:

- Only administrators with the '‘Approve Comments' permission can delete public comments.
- Only administrators with the 'Approve Comments' permission can change the status of a comment.
- Administrators can use the 'Pending Reader Comments' report to list pending comments.

See also
Personal Comments
Approving Comments
Managing Comments
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Personal Comments

If a user is logged in, and the page contains the "[ comments ]" system variable, the user will be able to submit either public comments or personal
comments for the page.

Public Comment: Visible to everyone.
Personal Comment: Only visible to the user that added it.

To submit a personal comment, do the following:

1. Click the 'login' link and enter your username and password.

Username:  [joe

Passward: 'nuun|

2. Select the page that you want to add comments to.

3. Click the 'Add Comment' button
| Add GComment |

4. Type your comment, check the 'Personal Comment only visible to {user}' checkbox, and then click ‘Add Comment'.

Add irstructions for how 1 configure on Windows Vists w64 and Windows 2003
wi4. Provide screenshots where appropaiate.

Personal Comment onky visble tojoe [+

5. The comment will be displayed right away and will only be visible to the username that you are logged in as.
oo - = e —

L b i

e i e ¥ e o )

_——

Rice Smitth (personal) Said: Stahs :Persunsl v:);
A insbructions for how b configune on Windows Vista 64 and Windows 2003 K54, Provide
screershots where appropriabe.

W2E2009 4:10:32 PM

6. Users can delete a personal comment by clicking the delete icon beside the comment.

Notes:
- Administrators with the 'Approve Comments' permission can delete personal comments.
- Administrators with the 'Approve Comments' permission can change a personal comment to a public comment.

See also
Adding Comments
Approving Comments
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Managing Comments
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Approving Comments

By default, comments are visible immediately after they are added, however administrators may want to be able to approve comments before making
them visible. To configure comments to require approval, do the following:

1. Open the Help System

2. If you are not already logged in, log in as an administrator with 'tools' permissions.

3. Click the 'Tools' button to display the 'tools' form.

i Backup i, Properties

Users 2{« Security Groups
"I ‘.:l'alla_lﬂﬁ ) . ) I—‘_—T--_ Sk:l_n_s o

== Page Templates .l Styles

dﬂ Translations About HelpConsole

4. Click 'Properties' to display the 'Project Properties' form.
=] i

Project Properties
SurtPage: |Fust Page] Select |

Dt St | Blue [=]
actratyloge | Record No Actions [=]
Hep Farmat | Frames [=]
Allow Sripts: | Falsa =]
Default Page Status 3
Detnt Canberits Mode: | Edf [«]
Dafault Comment Statae  \Vigsbie 3
Users Datsszt: [=]

TP Servers

5. Change 'Default Comment Status' to 'Pending’

Default Comment Status:

6. Click 'Save'

Note: Administrators can use the 'Pending Reader Comments' report to list pending comments.

See also

Adding Comments
Personal Comments
Managing Comments
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Home > Advanced Functions > Comments > Managing Comments

Managing Comments

Administrators with the 'Approve Comments' permission can manage comments.

Change Comment Status

To approve a comment, simply change the status from 'Pending'’ to 'Visible'. This is done by selecting 'Visible" in the drop down list. The change will be

saved automatically.
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.. I dcoversd that HelpConsela can be run on Windows Vista G4bit, but the Enall
vl AoplcalBions' setting maust be set to True, Toke & ook ot the folowing rtde:

y. 3/25/2009 2:47:13PM

T

Delete a Comment

To delete a comment, click the 'delete’ icon beside the comment.

See also

Adding Comments
Personal Comments
Approving Comments

helpconsole 2010



228 . Advanced Functions

Home > Advanced Functions > Import

Import

//H ‘ //H ‘ //H ‘
Importing a Word  Importing HTML Pages Importing a Robohelp
Document Project

When creating a help system, you may have existing Word or HTML documents that you want to include in your help system. Content from various
sources can be imported into HelpConsole, avoiding the need to re-enter the information manually. In most cases, images, links and formatting is
retained.

EE ©

See also

Movies & Animations
Users

Security Groups
Variables

Language Support
Page Templates
Styles

Reports

Conditional Content
Comments

Page Objects
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Home > Advanced Functions > Import > Importing a Word Document

Importing a Word Document

Follow the steps below to import a Word Document into a HelpConsole project:
1. Open the document in MS Word that you want to import into your HelpConsole project.

2. Click the 'Office button' and then click 'Save As'

] e docx - -
do-g ) nitaling the Software.docr - Micrasolt Word x
Priew Wi
_'-l . ave s oy of He dorumend
- =, iy Wore Document AaEnOche AsstCce AaBbO
2 Is.mn-mmmwmm T 1 10w Spari | Hesding 1. 3
| o frmpiat Sty
l I ot 5o the danummt 51 S 1ARplSs that on i B .
B wigd 16 formil Putur 30umirls.

[y Wore 19.3080 Disrumant
Miﬂ. L3 S8 3 (O OF the Cacsment Bt i fully
camalishe mith Waid 97.2003,
P 1 L [ind acd-ine for o ke formass
o wacast B3chirs B3 1094 11 DARAT
5 fachi i POF ¢ KP3.

ﬁﬁﬁw Femat
mmwm‘mm MT'HHFO::I:—::;A.:‘::*-MMM
gl s
x-' Pyghn ® N T e
.
] et

4] weesdOptoms || 3 Egewaa EEam

3. Browse to the 'Import’ folder within your project folder. For example if your project is named 'myproject’ then the path will be c:\program
files\helpconsole 2008\myproject\import\
2 Irport F
e Local Disk (C:) ~
) Program Files
3 HelpConsok: 2010
) MyProject
[ izt
e Local Disk {D:)
b DVD-RAM Drive (E:)
S he200adey on nokeback2007' (W)
S hoenedirs on ‘extreme’ (1) o

4. for 'Save as type', select "Web Page, Filtered (*.htm, *.html)"
File pame: | Inctaling the Software_him v
Save a5 byme: | yieb Page, Fikered (=, him; *.bire) ¥
tad

. [Word 57-2003 Tempiate (*.dot)
Page s | e Fle Wb Bage (*mit; *mhtnd)
‘Web Page (™ him; " k1

Plain Text (*.bt)

5. Click the 'Save' button

6. You may see a confirmation prompt. Click 'Yes'

s Sttt AR 1 et 1 el vt e, Sy ik b Ll s e e 1 0 T
WW . et Paga, Fitered) g L

iﬂ ® Tomawe, cho e

= Vot Prmmatmineg chch b, Thett vt I Qi i it Puspt LaPonat (HEML).

C= C=]

7. Important: Close MS Word. If the document remains open in MS Word, an error will occur during the import process, because the document is locked.

8. Open your help project in HelpConsole. If your project is named 'MyProject' then you can open the project with the url
"localhost/helpconsole2010/myproject”

9. Click ‘Login'. Enter your username and password to login.

10. You should see a flashina ‘Import’ icon on the ‘contents' toolbar. Click this icon to import the files.
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11. After the import is complete, the page(s) will be added to the bottom of the contents, and can then be dragged to any location within your table of
contents.
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See also
Importing HTML Pages
Importing a Robohelp Project
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Importing HTML Pages

Follow the steps below to import existing html pages into a HelpConsole project. These could be pages exported from a website, another help system,
etc.

1. Use Windows File Explorer to copy the html pages and associated images to the 'Import' folder within your helpconsole project folder. Image files can
be located in the same folder as the HTML pages or a sub folder. If for example, your project is named 'MyProject' then you will copy the html files to

c:\iroiram files\heliconsole 2010\MiPr0'ect\Imiort\

Fle Edt View Favontes Tooks Hsp [
@m Q¥ Psewn ‘[L thleﬁ‘ G-
Aidress |23 Ci\Program Fles|HelpConsele 201 0lMyProfectimpart v B
h' *x " Y =9 ] = M~
e ——— - R R - - -

E £ _engina docs images skinimages Jndexhbm_seanch.btm Swards bt Company, htm

. bin .

[ ) Example Help Syshem y Y

® ) Example Reseler Cons @ @ re

[ HelpConsode 2010dev — conkerks.htm  contents_d... customers.hin

[# I3 Master Websibe

= I MyPraject

Qe e e @

2 dors
# L3 Import
12 skinimages 1 | |
® ([0) Releasebictes @_ g g

# 1 kemplabe_Help System

e @ 3 @ @ e @ E

>

2. Open your help project in HelpConsole. If your project is named 'MyProject' then you can open the project with the url
"localhost/helpconsole2010/myproject”

3. Click 'Login'. Enter your username and password to login.

4. You should see a flashing 'Import' icon on the ‘contents' toolbar. Click this icon to import the files. Please be patient. If there are more than 40 pages,
the import may take a couple of minutes.

| e K
B-80 -

miypraject

Online Help

L e Functors d Local s armt -

5. After the import is complete, the pages will be added to the bottom of the contents, and can then be dragged to any location within your table of
contents.

helpconsole 2010



232 . Advanced Functions

e
" ntaracit. o o Lin

B

e s e g b e

g
Freciac wnd St e 0
Caspany Vi st Mlisakon

S e st 4 T i o

g S e e e

o B v a2 CHratinty Do T eLer ared dorcnrty 2 B
ewcisara.

e v, o e maar

o o e ] g e e e

See also
Importing a Word Document
Importing a Robohelp Project
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Home > Advanced Functions > Import > Importing a Robohelp Project

Importing a Robohelp Project

Follow the steps below to import an existing Robohelp project.

1. Use Windows File Explorer to copy the contents of the Robohelp project folder to the 'Import' folder in the HelpConsole project folder. If for example,
both the Robohelp project and the HelpConsole project are named 'MyProject' then you will copy the files:
From: My Documents\My Robohelp Projects\MyProject\ (note: Copy all files and folders except "!Langua kinSubFolder!" and "!1SSL!")

Ble Edt Yew Favortes Jook  Help
Qo - © (| O sowen | roos | -

x\dd-ess_ My Documentsipty Fobohelp ProjectsiMyProdect|
Felders ot -
@‘D&ﬁmp -~ l—-J
= 2} My Documents
® | Flash Shideshow Maker
# [2) Flash Shideshow Maker Professions
& ) My HelptncManual Projects
=) My s
® (2 hy Pickures
By Wideas
& ) PaDGen
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Bl Edt yew Fgvoates ook b L
&y
Qo - ©  (F| Psoer |2 1o | (-
Aghdrase q_'. :\Program Eiles\HelpConsale 20101MyProjectimport "': = e
Feldars ty E:l s
) HelpandManusla ~ -
¥ [0 HelpConscle 2008 readme bt
¥ g HelpConscle 2007
¥ () HelpConscle 2007 {old wel
B () HelpConsole 2007 (oid) ‘
B [0 HelpConsole 2007 Demos
= LD HelpConsole 2010
) _engine
2 bin
# I Example Help Systam
# 1) Example Reseler Cons
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) images
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2. Open your HelpConsole project. If your project is named ‘MyProject' then you can open the project with the url
"localhost/helpconsole2010/myproject”

3. Click 'Login'. Enter your username and password to login.

4. You should see a flashing ‘Import' icon on the ‘contents' toolbar. Click this icon to import the files. Please be patient. If there are more than 40 pages,
the import mav take a couple of minutes.
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5. After the import is complete, the pages will be added to the bottom of the contents, and can then be dragged to any location within your table of
contents.

o FEE = e T Saimik: -

i T8 et | O oy vy e Suatr . s o ey
v by orgarusoars ¥ S BTEL Y I IR 1 ORIty PORTTG T e ind drcansin s

-, X R e e o e A

irriopbme 7508 e o e

B c 1, J008 Company Visis o Migaien

ot e 200 parn. o i 1 R

e L . S i Mrmat e 4 L A e e e s & e e e st e

o= usarn 2 e L S e ey

See also
Importing a Word Document
Importing HTML Pages
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Page Objects

Page Objects are similar to page variables but are more complex. The following page objects can be inserted into a help page:

Dataset: A customizable database form consisting of a find screen and a detail screen.
Dataset Summary: Provides a summary view of a specified dataset.

File Folder: Allows administrators and/or users to upload and manage files and documents.
Toggle Panel: Allows readers to click an expand icon to view additional information.

Report: Use the report designer to design reports with parameters.

See also

Movies & Animations
Users

Security Groups
Variables

Language Support
Page Templates
Styles

Reports

Conditional Content
Comments

Import
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Home > Advanced Functions > Page Objects > Dataset

Dataset

A dataset is a customizable database form consisting of a find screen and a detail screen. An example of a dataset is a simple support ticket form,
allowing customers to submit support issues.

- - - - - -

A 7] 7] 7] 7] 7]
A A A A A i 3

Adding a Dataset Adding a Detail Field  Adding a Find Field Dataset Find Dataset Detail Dataset Field
Properties Properties Properties

- -

A 7]
A i 3

Dataset File Email Triggers
Attachments

See also
Dataset Summary
File Folder
Toggle Panel
Report
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Adding a Dataset

Datasets can be added to your help system to collect and manage data. Examples of datasets might include any of the following:
- Support Tickets

- Bug Reports

- Feedback

- Survey form

- Download form

Follow the steps below to add a dataset to existing page:

1. Select the page that you want to add the dataset to.

2. Click 'Edit Page'
Edit Page
3. Click the 'Insert Page Object' icon.

4. Select 'Dataset’ in the list and then click 'Insert".

Select & page object and then didk She rsert’ button.

Dratas et Surmemany
FileFolder
OnAdd Email
OniDelete Email
OnEdit Email
Report
TegglePanal

5. The dataset will be added to the page.
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6. At this point you can add detail fields, or add find fields.

7. If no additional fields are added. this is what the dataset will look like in live mode.
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8. If you want to delete a dataset from the page in the future, simply delete the find panel and the detail panel.

See also

Adding a Detail Field
Adding a Find Field
Dataset Find Properties
Dataset Detail Properties
Dataset Field Properties
Dataset File Attachments
Email Triggers
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Home > Advanced Functions > Page Objects > Dataset > Adding a Detail Field

Adding a Detail Field

Follow the steps below to add detail fields to a dataset:
1. Select a page containing a dataset, and click 'Edit Page'.
2. Click anywhere on the 'Dataset Detail' panel to display the 'Dataset Detail' properties.

3. Click the 'Text', 'Date’, '"Number', 'Check’, ‘"Memo', or 'List' button to add a field.
Dataset Detal Properties

Cata Source:

Suppon_tickets v

Chck a button below o add a field to the detal form.

HedEa -

Chek o ingart an gsting figld:

suTmary
_Created By
Created Cate

4. When prompted, enter a name for the field.

Explorer User Prompt

Sicript Prompt: ox,
Fleass enter & name for the field
|Producy

5. The following example contains the following fields:
- Summary (Text)

- Product (List)

- Ticket Number (Number)

- Date Added (Date)

- Details (Memo)

- Closed (checkbox)

(}\Supporﬁ Tickets Detail [ o= ]
s

Summany: _.
proucts #|
Detads:

6. Any of these fields can be repositioned or resized using your mouse.

7. Additional detail form properties and detail field properties can be set in the properties window.

8. Click the 'save' icon on the toolbar to save changes to the dataset.

See also

Adding a Dataset
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Adding a Find Field
Dataset Find Properties
Dataset Detail Properties
Dataset Field Properties
Dataset File Attachments
Email Triggers
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Adding a Find Field

Follow the steps below to add find fields to a dataset:
1. Select a page containing a dataset, and click 'Edit Page'.

2. Click anywhere on the 'Dataset Find' panel to display the 'Dataset Find' properties.

3. Click a field in the list to add it to the find form.
Dataset Find Properties

4. When a field is clicked, it will be added as a textbox and as a column in the search results.

Dataset Fing
Q[page name] Search [~ ]
N
Sermnary: |
Product |
Ticket Hurier -_
Choond |
hbeldded-_
| gumioaddfedy
Summary Product Ticknthumber  Closed Datn Added |
» lopenisummary]  [spencroduct]  [openTicket [open:Clased] [open:Cate Added]

5. Any of these fields can be repositioned or resized using your mouse.

6. Additional find form properties and find field properties can be set in the properties window.

7. Click the 'save' icon on the toolbar to save changes to the dataset.

See also

Adding a Dataset

Adding a Detail Field
Dataset Find Properties
Dataset Detail Properties
Dataset Field Properties
Dataset File Attachments
Email Triggers
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Dataset Find Properties

Follow the steps below to set properties for a dataset find form:
1. Select a page containing a dataset and click 'Edit Page'

2. Click anywhere on the find form to display properties.
Dataset Find Properties #2 (<)

SEL Query: |

Sort Feld: |
Shaw All: D

Property Description

Click to Insert... Click a field in the list to add it to the find form. This list contains
fields that were previously added to the detail form.

SQL Query By default, the find form displays results from the dataset table, but
you can specify your own custom query such as "select * from
[support_tickets]". This query can contain multiple tables.

Sort Field Enter the name of the field that the results will be sorted by.
Example: "Product”

Show All If checked, all records in the dataset will be listed. If not checked,

users must enter search criteria to display any records.

3. After setting properties, click 'save' to save changes.

See also

Adding a Dataset

Adding a Detail Field
Adding a Find Field
Dataset Detail Properties
Dataset Field Properties
Dataset File Attachments
Email Triggers
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Dataset Detail Properties

Follow the steps below to set properties for a dataset detail form:

1. Select a page containing a dataset and click 'Edit Page'

2. Click anywhere on the detail pano isplay properties.

Dataset Dotal Properties

Cata Source:

| suppon_ticksts

Chck & button below & add a field to the detad form

ki

=
Texi Hame

‘Chick B insert an exssting feid:

| sammary
Prochct
Tuckiet Number
Closed
Dste Added
Detndy
_Created By
_Created Date
_Modifad By
_Modifed Date
0

Redrect LEWL: |

Property

Data Source

Add Field Buttons

Click to Insert...

Redirect URL

Description

This is the database table where records are stored. When a dataset is
added to a page, the database table is automatically craeted when the
page is saved.

Click the 'Text', 'Date’, ‘Number', ‘Check’, ‘"Memo' or 'List' button to add a
new field to the detail panel. This will create a new field in the database
table.

Click a field in the list to add it to the detail form. This list contains fields
that were previously added.

When the 'save' button or the ‘cancel’ button on the detail form is clicked,
this is the page that will be loaded. This can be a full URL such as
http://www.google.com or a relative url such as "Page.aspx?pageid=faq"

3. After setting properties, click 'save' to save changes.

See also

Adding a Dataset

Adding a Detail Field
Adding a Find Field
Dataset Find Properties
Dataset Field Properties
Dataset File Attachments
Email Triggers
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Home > Advanced Functions > Page Objects > Dataset > Dataset Field Properties

Dataset Field Properties

Follow the steps below to set properties for a detail or find field:

1. Select a page containing a dataset and click 'Edit Page'

2. Click a field on the detail form or the find form to display properties.

(F)\ [page name] Detail
s

a
Sy
o

Cosed: 7]

3. The field properties window will be displayed

Dataset Field Properties

2}l x]

Field Name: summary
Field Typa: Text

Default Value:

width: |

Height:

Requined:

[ENE]

Disabled:

Property

Field Name

Field Type

Default Value (detail field)

Default Value (find field)

Width
Height

Required

Disabled

Description

Readonly - Shows the name of the field. The field cannot be renamed here,
but can be renamed in the 'dataset detail properties' window.

Readonly - Show the field type (Text, Date, Number, Check, Memo, or
List). The field type cannot be changed once the field is added.

The detail field will be populated with this value when a new record is
added.

The find field will be populated with this value when the find form is first
displayed. If one or more find fields have default values, a search will
automatically be performed and search results will be displayed based on
those find field values.

Defines the width of the field
Defines the height of the field

If checked, the detail field cannot be blank when the record is saved. The
record will not be saved until a value is entered.

If checked, the detail field will be disabled. The value cannot be changed or
removed.

3. After setting properties, click 'save' to save changes.
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See also

Adding a Dataset

Adding a Detail Field
Adding a Find Field
Dataset Find Properties
Dataset Detail Properties
Dataset File Attachments
Email Triggers
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Home > Advanced Functions > Page Objects > Dataset > Dataset File Attachments

Dataset File Attachments

You can add the [ File Attachments ] variable to a dataset to allow users to upload and manage files.

Add Variable

Follow the steps below to add the [ File Attachments ] variable to a dataset:

1. Select the page containing the dataset.

2. Click 'Edit Page'
Edit Pae

3. Type "File Attachments" in square brackets within the detail panel (usually at the bottom).
Dataset Detai

' [_see |
Q[page name] Detail —

Summary: | J

s i —

4. Click the 'save' icon to save the changes.

Attach a File

Follow the steps below to attach a file to a dataset record:
*Important: Files can only be attached to existing records, this means that files cannot be attached while adding a new record.

1. Click an existing record to open the detail form.

Q FAQ Search [~ ]

2. When the record is displayed, click the 'browse' button.

()\ FAQ Detail —C—
N

Surmmary: | Widget Master 2000

File Attachmients

3. Select the file to attach and then click ‘open’.
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EB e 4KB ASPNET Server Page  SIZ7L
5o | Bl addpage o | 2KB Compressed (gppe...  SZ7%
0| i) apphcation dat TSKE DAT Fie 8712
2 b appistyles. css 6KB Cascadng Stylesh.. S8
=] efaukampx BEE  ASPNET Server Fage B4
My Documerts | (2 defauk.m 6KB  HTML Document 64121
defaul 15 LISKE  JSeript Soript File Siz6lk
2] defauk_project.aspx 11K ASP.NET Server Page  5[2S)
2 derins_back. of 2KB GIFFile szt
My Computer | (2] sdithst. apic 1KE ASP.NET Server Page 4270
I B¥E  ASP.NET Sarver Page  5/26f o
. | >
My Hetwosk  Fie pame |addPage =0 =
Fibes of lypas: [A1 Fles 1) =

4. The file will be added to the list. At this point, it can be opened, downloaded, or deleted.

i

(M FAQ Detail
N

Susmmary: | WiGpt Master 2000

File Attachments

i

Note: If the user does not have 'edit' permissions for the dataset, the ‘delete’ icon will not appear and files cannot be deleted.

See also

Adding a Dataset

Adding a Detail Field
Adding a Find Field
Dataset Find Properties
Dataset Detail Properties
Dataset Field Properties
Email Triggers
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Home > Advanced Functions > Page Objects > Dataset > Email Triggers

Email Triggers

Email triggers can be added to a dataset page to send an email when a record is added, edited or deleted. Follow the steps
below to add an email trigger.

1. Select the page containing the dataset.

2. Click 'Edit Page'
Edit Page
3. Click to position the cursor at the bottom of the page.

4. Select 'OnAdd Email', 'OnEdit Email' or 'OnDelete Email' and then click the 'Insert' button.

Insert Page Object

Select a page object and then dick the insert’ button.

Dataset
DatasetSummany
FileFaolder

Onadd Email
OnDelete Email
OnEdit Email
Repon
TogglePansl

L L B - taiit =

L T TR A

o o o s b
e p—
. s b g

b e G bt

6. Populate the email trigger with the following information:

Field Description

Prompt This heading will be displayed when the email prompt appears. If this field is
blank, the email will be automatically sent without prompting.

From Email address of the sender. This can be any valid email address. If the recipient
replies to the email, this is the address that the reply will be sent to.

To Email address of the recipient.
Subject Subject of the email.
Body Body of the email.

Detail field values can be used in any of the email fields above. The format is [field:{fieldname}]. For example, if there as a 'status' field, you could
display the value in the email body with the following text "The status is [field:status]”
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(=2 On Add Email
Prompt: Do you wigh to send an email?

From: John@Company.com
To: Alice ECompany.com
Subject: Mew Widget Record Added

Body: Hi Alice,

Thiz iz an automated emal to let you know that a new widget record has been added.

Kind Regards,
John
Email Form
When a new record is added, the followini email form will aiiear. If the 'Promit' field was left blank, the email will be sent transparently.
S
Ta: AlicefCompany. cam
Frien John@Comparry com
Subgect:  Mew Widget Record Added: Widget Master 2000
Bodr: Forit hame * Sure = (Ll T A e
H Akce,
Thes is an automated emal to let you know that a new widget record has been added.
¥ind Fugards,
Juhn
# oLy
See also

Adding a Dataset

Adding a Detail Field
Adding a Find Field
Dataset Find Properties
Dataset Detail Properties
Dataset Field Properties
Dataset File Attachments
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Dataset Summary

A dataset summary provides a way to display information in various ways from the project database. If for example you had a dataset for managing
support tickets, you might create a dataset summary to display a summary view of only open support tickets that are 3 days or older. A dataset
summary can also be used to display information from system tables within the database. The following example displays a list of user accounts:

1. Select the page that you want to add the dataset summary to.

2. Click 'Edit Page'
| Edit Page |

3. Click the 'Insert Page Object' icon.

8

4. Select 'Dataset Summary' and then click 'Insert’

Insert Page Object

Select a page object and then chdk the “nsert’ button.

Dataset

DatasetSummany w._
FileFolder \
OnAdd Email

OnDelete Email f
OnEdit Email 3
Report 4
ToggleFanel

5. Click anywhere on the 'Dataset Summary' panel to display properties.
6. In the 'Datasource’ list, select 'SQL Query"

7. Enter the query: "select * from [ users]" and then click 'OK"

Explorer User Prompt

Seript Prompt:
SOL Query:
Cancel

|s=|ec>1 " from [_usess]

8. The 'Click to Insert' list should now contain a list of fields.

9. Click 'UserName'. 'FullName' and then 'Security Group' to add those columns to the dataset summary.
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u.lutl' from [_ussrs] -
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Full Mame
Picidvetnd
Fearfy o
3
N Em
S ool indranmt i Raes v
10. Click 'Save' to save and switch to live mode.
11. You should see a list of usernames.
John John Smith Aedimin
Alice Alice Jones Addmin
adrin Adernistrator adrin
Dataset Summary Properties
Property Description

Data Source

Click to Inse

Open Page

Allow Add

rt...

Allow Delete

See also

Dataset

File Folder
Toggle Panel
Report

This is the database table that data will be displayed from. A custom SQL

query can be defined by selecting 'SQL Query"

Click a field in the list to add it to the dataset summary. This list is
generated based on the Datasource.

This is the page that will be displayed when a record is clicked in the
dataset summary. Only pages containing datasets will be listed.

If checked, the 'Add Record' button will be displayed allowing users to add

records to the associated dataset.

If checked, the delete icon will be displayed allowing users to delete
records from the associated dataset.

helpconsole 2010



252 . Advanced Functions

Home > Advanced Functions > Page Objects > File Folder

File Folder

A file folder can be added to any page within your help system. File Folders provide a way to easily upload documents, images, and other files to the
project allowing end users to view or download the files. File folders are secure meaning that only users with the appropriate permissions can access the
files.

Adding a File Folder

Follow the steps below to add a file folder to a page:

1. Select a page that you want to add the file folder to.
2. Click 'Edit Page' to switch to edit mode.

3. Click the 'Insert Page Object' icon on the toolbar.

4. Select 'File Folder' and then click 'Insert'.

Select a page object and then cidk the “nsert’ button.

Dataset
Dataset Summ.

Onédd Email
OnDelete Email
QOnEdit Email
Regport

TogglePanel

5. Click 'Save' to save the page and switch to live mode.

6. Click the 'Browse' button to select a file to add from your harddrive or your network.

(= HelpConsele JO0E SP31c - lesid 56 - Windows Internet Explorer

= i Fres ADL fiUrited Inberet. B | Fre Hotnad @

8 HlpCorasle 2008 5P 1¢ - BedtiSE.

Dushe Creshed Date Hodfed

BI0/00 1454 P BI0/Z00% X 1454 P
10205 15403 B 1000 B 1507
/1072000 31400 P 102000 2 1809 P
G000 ks 3N B0/ 308228
107208 % 1537 I 107300 % 1537 P

HalpConscla 2008 - Enterprise Edition

7. After a file folder has been added to a page, permissions for that file folder can be set in "Tools > Security Groups"

See also

Dataset

Dataset Summary
Toggle Panel
Report
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Toggle Panel

A Toggle Panel provides a way to display a minimal amount of information, but allow the reader to click an 'expand' icon to display additional information.
Toggle Panels can contain pretty much any html element including images, flash videos, tables, iframes, links, etc.

Here's an example of a toggle panel:

<= Click the expand icon to display more info about "Static Help System"

Advantages:

« Faster than a dynamic help system

« Can be run anywhere with a standard browser

« Can be distributed on a CD or within a setup file

« Fewer files

« Can be run on any web server such as Apache, Linux, etc.
« Supports all browsers right back to Netscape 1.0 and IE 1.0

Disadvantages:

« Not editable (Updates require re-publish)

« 'Most Popular Pages' feature not supported
« 'Reader Comments' feature not supported
. 'Page views' feature not supported

« Dynamic conditional content not supported
« Dynamic skins not supported

Follow the steps below to add a toggle panel to a page:

1. Select the page that you want to add the toggle panel to.

2. Click 'Edit Page'
Edit Page
3. Click the 'Insert Page Object' icon.

4. Select 'TogglePanel' in the list and then click 'Insert'.

Insert Page Object

Select a page object and then chdk the nsert’ button.

Dataset

Dataset Summany
FileFolder

OnAdd Email
OnDelete Email
OnEdit Ermnail
Rep

5. Tvpe the toaale panel headina and bodyv.
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L Index 7 Bockmark M Pret P Link Search: |

Advantages:
-

Disadvantages:

Faster than a dynamec help system

Can be run anywhere with a standard browser

Can be dsirbuted on a CD or within a setup file

Fewer fies

Can be run an any web server such as Apache, Linux, ete.
Supports all browsers right back to Netseape 1.0 and IE 1.0

# Mot editable (Updates require re-pubksh)
= ‘Mast Popular Pages” feature not supported
= ‘Reader Comments' feature not supported
» Poage views' feature not supporbed

+ Dynamic conditional content not supparted
# Dynamic sking not supported

# < m

6. Click the 'Save' button to save the page and switch to live mode.

See also

Dataset

Dataset Summary
File Folder
Report
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Home > Advanced Functions > Page Objects > Report

Report

The built in report designer allows administrators to design summart reports which pull information from various dataset tables and other tables within
the project database. A report could be created to display a list of user accounts for the project. Follow the steps below to create a simple report listing
user accounts:

1. Select the page that you want to add the report to.

2. Click 'Edit Page'
Edit Page
3. Click the 'Insert Page Object' icon.

4. Select 'Report' and then click 'Insert

Select a page object and then cick the “nsert’ button.

Dataset

D ey
FileFolder

OnAdd Email

OnDelete Email

OnEdit Email

[$2]

. Click anywhere on the report panel to display properties.

[<2]

. For 'SQL Query' enter "select * from [_users]"
7. You should then see a list of fields that can be added to the report.
8. Click 'Username’, 'Full Name' and 'Security Group' to add them to the report. The field will be added as a column and a matching parameter field will

also be added. If the parameter field is not required, you can simply delete the textbox and label.
= Hai "

Ee Ede  Yew Fyeoribes Jook  Help
wr Favorber | g = A Fros 800U B Unlented bternst 8 Free ol 8

hicenngemane]  [ooendFul hame]

Helplonsale Enterprize Edition

9. Click the 'Save' button to save the page and switch to live mode.

10. Bv default. all records will be listed. You can filter the report bv enterina a parameter and then clickina 'Run Report'.
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User Accounts

Security Group | |

dhdl
j
]

g

] Andres Bloomburg

Todd Frigan

!
FEEEEEEY

FEy

Note: When the report is printed, the 'Run Report' button will not be displayed.

Page Names in Reports

The 'Page Name' field is not located in any table in the project database, however it is possible to include page names in your reports by entering an SQL
Query with PagelD with the alias "PageNameFromID". For example, to create a report that lists page names and associated page views, the SQL Query
would be: SELECT Pagel D AS PageNanmeFrom D, Views FROM [ _Page Vi ews]

Page Views
Fags Mame il
Support Thckels m
Wekome [+]
Tutorais -
Fag 3
Tutoral 2

See also

Dataset

Dataset Summary
File Folder
Toggle Panel
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Toolbar Reference

System Toolbar

Welcome Administrator 4 ¥ Tools Fublish

Contents Toolbar
Contents TR A _ Save |

Function Toolbar
P Link: Index 7 Bookmark (& Print 2

Editor Standard Toolbar

Skin Editor Toolbar

Variable Editor Toolbar
FE® Q5 N-H DB 1:homa = Sze= B U 75 -

Page Template Editor Toolbar
FE 2 EH-B B 1shoma

A\ A A A A

Skin Editor Toolbar

System Toolbar Contents Toolbar Function Toolbar Editor Toolbar

A\

Page Template Editor
Toolbar

See also
Welcome

Getting Started
Installation

Basic Functions
Advanced Functions
FAQ

[search children]

A

Variable Editor Toolbar
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Home > Toolbar Reference > System Toolbar

System Toolbar

The 'System Toolbar' is displayed when the user is logged in and has at least 'tools' or 'publish’ permissions.

Fublish

il - Click the "'Submit Suggestion' icon to submit suggestions directly to the HelpConsole
2010 development team to improve the software.

B Click the 'help’ icon to open the HelpConsole 2010 help system.

Click the 'Tools' button to display the project tools form to perform functions such
as backing up a project, manage skins, set permissions, etc.

Publish Click the 'Publish’ button to publish a static help system or PDF manual. For more
= information, see Publishing a Static Help System or Publishing a PDF Manual

Select a skin in the skin list to apply a different skin. Select 'More Skins..." to
download a skin from the Extreme Ease 'Skin Collection'. For more information,
see Skins

More Skins. ..

See also

Contents Toolbar

Function Toolbar

Editor Toolbar

Skin Editor Toolbar

Variable Editor Toolbar

Page Template Editor Toolbar
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Home > Toolbar Reference > Contents Toolbar

Contents Toolbar

Contents € B [ Save |

0 Add page

9 Delete Page

L=t Set Page Properties

. Save Saves any changes made to the HelpConsole project. When the button is red, save is required.
See also

System Toolbar

Function Toolbar

Editor Toolbar

Skin Editor Toolbar

Variable Editor Toolbar

Page Template Editor Toolbar
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Home > Toolbar Reference > Function Toolbar

Function Toolbar

. unk | Index "7 Bookmark i Print :P-_l

Function Toolbar Reference

icon/button

I_ Edit Page J

o Inidlesx

<7 Add to Favorites

(% Print Page

& Link

Seach| @]

See also

System Toolbar

Contents Toolbar

Editor Toolbar

Skin Editor Toolbar

Variable Editor Toolbar

Page Template Editor Toolbar

If the user is logged in and has 'edit pages' permissions, the 'Edit page' button
will be visible. This button will not be visible when external pages are
displayed.

Click the 'Index" icon to display the index for the help system. The index is
generated from keywords that are assigned to help pages via page
properties. For more information, see: Keywords and Index

Click the 'Add to Favorites' icon to bookmark the current page in the favorites
list of your browser. If the page was added while in edit mode, the page will
be reopened in edit mode.

Click the 'Print Page' icon to print the currently displayed page. A printer
dialog window will appear allowing you to select the printer and set other
printing options.

Click the 'Link' icon to display the URL for the current page. Examples of
various link types with HTML code are provided.

Enter search criteria and click the 'Search' button to perform a search. the
results will be displayed in the contents window.
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Editor Toolbar

R 1 -

= HO B4

Toolbar Function Reference

Switches the page back to live mode. If changes were made to the
page, you will be asked if you want to save.

A Close Toolbar

H Save Page Saves the page.

o)

Link page Allows authors to add a link to another page in the help project.

Inserting a table works similarily to Microsoft Word?. Click the 'Insert
Table' button and select how many rows and columns are

desired. The table will be inserted at the current cursor position. See
also: Working with Tables

E Insert Table

Pressing this button will open the image dialog which allows you to
E Image Manager manage images. From this form, images can be inserted into the
page. Images can also be uploaded from a local harddrive or network

Sets the font typeface. This dropdown allows you to change the font

Font Name
of the selected text.

Sets the font size. This dropdown allows you to change the font size

Font Size of the selected text.

Applies bold formatting to the selected text. Select the text and
B Bold press this button to apply bold formatting. If the cursor is positioned
in a single word, pressing this button will bold the entire word.

Applies underline formatting to selected text. Select some text and
press this button to apply underline formatting. If the cursor is

u Underline positioned in a single word, pressing this button will underline the
entire word.

= Align Left Aligns the selected paragraph to the left.

= Align Center Centers the selected selected paragraph.

= Align Right Aligns the selected paragraph to the right.
Foreground Changes the color of the selected text. This dropdown allows you to
color change the font color of the selected text.

. Toggle Toolbar Toggle between standard toolbar and full toolbar

Pressing this button to display the default printer dialog box. Press
. Pri [OK] or Print , to print the current page in your web browser.
= rint . ) o

You can set your printer properties before printing.
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Spell Check

Find & Replace

Global Search &
Replace

Hyperlink
Manager

Remove Link

Insert Variable

Insert
Conditional Text

Sticky Note

Flash Manager

Media Manager

Document
Manager

Format Stripper

Show / Hide
Border

Set Absolute
Position

Cut

The spellchecker is a tool which checks the spelling of the written
text. It works the same way as in Microsoft Word?. When launched,
the spellchecker dialog will appear and the checking will start
automatically from the beginning of the document. If there is a
misspelled word, it will appear in the spellchecker dialog, where you
can either [Ignore] the suggestion or [Change] the word with the
suggested one.

Opens the Find and Replace dialog. This dialog allows you to search
for and/or replace specific text on the page. See also: Page Search
and Replace

Allows authors to search and replace text or html code across all
pages in the help project. See also: Global Search and Replace

Assigns a hyperlink to the selected text or image. The hyperlink
dialog window will open. It allows you to choose the type of link you
want to insert: Hyperlink, Anchor or E-mail. See also: Links

Removes the hyperlink from the selected text or image. See also:
Links

Inserts a user defined or system variable. Variables act as
placeholders for content that might change in the future. When the
page is displayed in live mode, the variable value will be displayed.
See also: Variables

This button will insert conditional text that will be visible for
selected skins. For more information see: Conditional Text

Inserts a sticky note that can be placed anywhere on the page. This
is typically used by the author to remind themselves to complete
certain tasks. Sticky notes are not visible in live mode.

The flash dialog is used for working with flash files - inserting and
uploading animations. See also: Adding a Flash Animation

The Windows media dialog is used for inserting and uploading media
objects (AVI, MPEG, WAV, etc.). It also lets you set the object?s
properties. See also: Adding a Media Animation

Pressing this button will open the 'Document Manager' dialog which
allows you to link the selected text with another page. See also:
Adding Page Links

Strips (removes) the formatting from the selected text. Removes
Word?, custom or all formatting.

Toggles borders of all tables within the editor ON and OFF. The ON
function works on tables which have hidden borders.

This button toggles the positioning type for a selected object.
Pressing this button will allow you to drag and drop an object (image,
table or media) freely within the editor.

The default positioning type is relative, which means that an object is
positioned inline (or relative) to other objects. When the positioning
type is absolute, the object can be placed anywhere on the page

Cuts the selected content and copies it to the clipboard. The [Cut]
button works on selected text, image and/or table. Select the
content and then [Cut] it.

When using this tool, the cut text or image will be removed from the
page and will be stored in the clipboard for later use. Please, note
that only the last cut (or copied) item will be stored in the clipboard.
This tool is very helpful if you have decided to change the place of a
piece of text in the sentence or in the page.

Copies the selected content to the clipboard. The [Copy] button
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Style -

Mormnal -

Copy

Paste

Paste from
Word

Paste from
Word cleaning
fonts and sizes

Paste Plain Text

Paste as HTML

Undo

Redo

Style

Paragraph Style

Italic

works on selected text, image and/or table. Select the content first
and then [Copy] it.

When using this tool, the content will be stored in the clipboard for
later use. Note that only the last copied (or cut) item will be stored in
the clipboard.

This tool is very helpful if you need to type the same text many
times: just select the text, press the button, place the cursor on the
new place and press the [Paste] button. This procedure works for
images and/or tables as well.

Pastes copied content from the clipboard into the editor. After you
have either [Cut] or [Copied] an item (text, image, etc.), you can
[Paste] it using this button. Place the cursor where you want the item
to appear and press the [Paste] button.

Pastes copied content from the clipboard into the editor. After you
have either [Cut] or [Copied] an item (text, image, etc.), you can
[Paste] it using this button. The editor will clean all unnecessary
Microsoft Office related tags. Place the cursor where you want the
item to appear and press this button.

In case the user is trying to paste Word content with the regular
Paste button or Ctrl V, a dialog will prompt whether the Word markup
should be cleaned. If the Clipboard content does not come from
Word, the dialog will not be shown.

Pastes copied content from the clipboard into the editor. After you
have either [Cut] or [Copied] an item (text, image, etc.) in Microsoft
Word ?, you can [Paste] it using this button. The editor will clean all
unnecessary Microsoft Office related tags plus font formatting. Place
the cursor where you want the item to appear and press this button.

Pastes copied content from the clipboard into the editor. After you
have either [Cut] or [Copied] an item (text, image, etc.), you can
[Paste] it using this button. The [Paste Plain Text] button works
similarly to [Paste from Word] , but it removes all HTML formatting
and pastes plain text, preserving the line breaks.

After you have either [Cut] or [Copied] an item (text, image, etc.),
you can [Paste] it using this button. This tool allows you to paste the
HTML content of the Clipboard as code, which may be quite
convenient for developer-oriented applications (e.g. support
systems, forums, etc.) The pasted text will look something like this:

<IMG src=" originalAttribute="src" originalAttribute="src"
originalPath=" originalAttribute="src" originalPath="""
logo.gif'><BR><BR><FONT face="Arial"><STRONG>What's new in
this version</STRONG></FONT>

Undoes the previous action. Pressing this button will [Undo] the last
action you have made in the editor. This includes but is not limited to
inserting tables, moving images and formatting text.

Pressing the down arrow next to this button will open a dropdown
where you can select from a list of previous actions.

Redoes the last undone action. Pressing this button will [Redo] the
action you have just undone. Pressing the down arrow next to this
button will open a dropdown where you can select from a list

of actions that can be redone.

Applies predefined styles to a selected element such as text, image,
table, etc. This dropdown menu contains predefines styles contained
in the project stylesheet. See also: Styles

Applies standard or predefined text styles to the selected
paragraph. Click anywhere in the paragraph you want formatted and
select the preferred style from the dropdown.

Applies italic formatting to the selected text. Select some text and
press this button to apply Italic formatting. If the cursor is positioned
in a single word, pressing this button will apply italic to the entire
word.
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Pressing this button will justify the selected paragraph to the left and
to the right at the same time.

Justify

Background Changes the background color of the selected text. This dropdown
Color allows you to change the background color of the selected text.

&

This button indents a paragraph to the right. Each time this button is

Indent pressed, the paragraph will be indented further to the right.

Decreases paragraph indent to the left. This button works only if
indent has been applied to a paragraph beforehand. To use this
button, click anywhere in the paragraph you want indented to the
left and press the button.

Outdent

Creates a numbered list from the selection. Select some text or place
the cursor inside a paragraph and press this button to make the text
a numbered list. Pressing this button again will turn the numbered list
into a regular paragraph of text.

i= Numbered List

Creates a bulleted list from the selection. Select some text or place
= Bullet List the cursor inside a paragraph and press this button to make the text
= a bulleted list. Pressing this button again will turn the bulleted list into

a regular paragraph of text.

Makes text or numbers appear as superscript. When typing text, you
may press this button to make the text that follows superscript. The
button also works on selected text. You have to press the button
again to switch to normal text typing.

X SuperScript

Makes text or numbers appear as subscript. When typing text, you
may press this button to make the text that follows subscript. The
button also works on selected text. You have to press the button
again to switch to normal text typing.

X, SubScript

Applies strikethrough formatting to selected text. Select some text
and press this button to apply strikethrough formatting. If the cursor
is positioned in a single word, pressing this button will strikethrough
the entire word.

* Strikethrough

Inserts a new paragraph. There is a difference between pressing this
button and pressing [Enter]. The latter creates a new line keeping
= the paragraph formatting whereas [new paragraph] creates a new
= New Paragraph paragraph, with different paragraph settings which can be changed
later on. This feature is important when you apply indentation and

justification to text.

Inserts special characters. Pressing this button will display a drop-

@ Insert Symbol down menu, displaying the special characters that can be added to
the page. The special character will be inserted at the location of the
cursor.

Inserts a form element such as a text box, checkbox, button, etc.

Iﬁ' Insert Form Pressing this button will display a drop-down menu allowing you to

- Element select the form element that you wish to insert.

Pressing this button will insert a horizontal line at the
Horizontal Ruler | current cursor position.

”
ili

Pressing this button inserts the current date at the current
| Insert Date cursor position.

Pressing this button inserts the current time at the current
1% Insert Time cursor position.

helpconsole 2010



266 . Toolbar Reference

See also

System Toolbar

Contents Toolbar

Function Toolbar

Skin Editor Toolbar

Variable Editor Toolbar

Page Template Editor Toolbar
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Home > Toolbar Reference > Skin Editor Toolbar

Skin Editor Toolbar

Skin Toolbar Reference

E Image Pressing this button will open the image dialog which allows you to
Manager manage images ? inserting, uploading and setting image properties.

Hyperlink Assigns a hyperlink to the selected text or image. The hyperlink dialog
% M);’?la er window will open. It allows you to choose the type of link you want to
9 insert: Hyperlink, Anchor or E-mail. See also: Links

Pressing this button will open the 'Document Manager' dialog which

@ aocument allows you to link the selected text with another page. See also: Adding
anager :
Page Links

Inserting a table works similarily to Microsoft Word?. Click the 'Insert
Table' button and select how many rows and columns are desired. The
table will be inserted at the current cursor position. See also: Working
with Tables

E Insert Table

Sets the font typeface. This dropdown allows you to change the font of

Font Name the selected text.

Sets the font size. This dropdown allows you to change the font size of

Font Size the selected text.

Applies bold formatting to the selected text. Select the text and press
B Bold this button to apply bold formatting. If the cursor is positioned in a single
word, pressing this button will bold the entire word.

Applies underline formatting to selected text. Select some text and
press this button to apply underline formatting. If the cursor is

u Underline > . h ) ) ) ’ )
= positioned in a single word, pressing this button will underline the entire
word.
Applies italic formatting to the selected text. Select some text and press
I Italic this button to apply Italic formatting. If the cursor is positioned in a

single word, pressing this button will apply italic to the entire word.

& Background Changes the background color of the selected text. This dropdown
Color allows you to change the background color of the selected text.
= Align Left Aligns the selected paragraph to the left.

Align Center Centers the selected selected paragraph.

= Align Right Aligns the selected paragraph to the right.
A Foreground Changes the color of the selected text. This dropdown allows you to
color change the font color of the selected text.
Cuts the selected content and copies it to the clipboard. The [Cut]
button works on selected text, image and/or table. Select the content
and then [Cut] it.
ﬁ-‘-. cut When using this tool, the cut text or image will be removed from the

page and will be stored in the clipboard for later use. Please, note that
only the last cut (or copied) item will be stored in the clipboard. This tool
is very helpful if you have decided to change the place of a piece of text
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ke

See also

System Toolbar
Contents Toolbar
Function Toolbar
Editor Toolbar
Variable Editor Toolbar

Copy

Paste

Paste Plain

Text

Undo

Redo

Page Template Editor Toolbar

in the sentence or in the page.

Copies the selected content to the clipboard. The [Copy] button works
on selected text, image and/or table. Select the content first and then
[Copy] it.

When using this tool, the content will be stored in the clipboard for later
use. Note that only the last copied (or cut) item will be stored in the
clipboard.

This tool is very helpful if you need to type the same text many times:
just select the text, press the button, place the cursor on the new place
and press the [Paste] button. This procedure works for images and/or
tables as well.

Pastes copied content from the clipboard into the editor. After you have
either [Cut] or [Copied] an item (text, image, etc.), you can [Paste] it
using this button. Place the cursor where you want the item to appear
and press the [Paste] button.

Pastes copied content from the clipboard into the editor. After you have
either [Cut] or [Copied] an item (text, image, etc.), you can [Paste] it
using this button. The [Paste Plain Text] button works similarly to [Paste
from Word] , but it removes all HTML formatting and pastes plain text,
preserving the line breaks.

Undoes the previous action. Pressing this button will [Undo] the last
action you have made in the editor. This includes but is not limited to
inserting tables, moving images and formatting text.

Pressing the down arrow next to this button will open a dropdown where
you can select from a list of previous actions.

Redoes the last undone action. Pressing this button will [Redo] the
action you have just undone. Pressing the down arrow next to this
button will open a dropdown where you can select from a list of actions
that can be redone.
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Home > Toolbar Reference > Variable Editor Toolbar

Variable Editor Toolbar

Variable Editor Toolbar Reference

-

icon/list Name

E Insert Table

= Image Manager

Font Name
Font Size
B Bold
u Underline
= Align Left
= Align Center
= Align Right
Foreground
A color
= | Print
? Spell Check
B Find & Replace
% Hyperlink
Manager
&' Remove Link

Inserting a table works similarily to Microsoft Word?. Click the 'Insert
Table' button and select how many rows and columns are

desired. The table will be inserted at the current cursor position. See
also: Working with Tables

Pressing this button will open the image dialog which allows you to
manage images. From this form, images can be inserted into the
page. Images can also be uploaded from a local harddrive or network

Sets the font typeface. This dropdown allows you to change the font
of the selected text.

Sets the font size. This dropdown allows you to change the font size
of the selected text.

Applies bold formatting to the selected text. Select the text and
press this button to apply bold formatting. If the cursor is positioned
in a single word, pressing this button will bold the entire word.

Applies underline formatting to selected text. Select some text and
press this button to apply underline formatting. If the cursor is
positioned in a single word, pressing this button will underline the
entire word.

Aligns the selected paragraph to the left.

Centers the selected selected paragraph.

Aligns the selected paragraph to the right.

Changes the color of the selected text. This dropdown allows you to
change the font color of the selected text.

Pressing this button to display the default printer dialog box. Press
[OK] or Print , to print the current page in your web browser.
You can set your printer properties before printing.

The spellchecker is a tool which checks the spelling of the written
text. It works the same way as in Microsoft Word?. When launched,
the spellchecker dialog will appear and the checking will start
automatically from the beginning of the document. If there is a
misspelled word, it will appear in the spellchecker dialog, where you
can either [Ignore] the suggestion or [Change] the word with the
suggested one.

Opens the Find and Replace dialog. This dialog allows you to search
for and/or replace specific text on the page

Assigns a hyperlink to the selected text or image. The hyperlink
dialog window will open. It allows you to choose the type of link you
want to insert: Hyperlink, Anchor or E-mail. See also: Links

Removes the hyperlink from the selected text or image. See also:
Links
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Flash Manager

Media Manager

Document
Manager

Format Stripper

Show / Hide
Border

Set Absolute
Position

Cut

Copy

Paste

Paste from
Word

Paste from
Word cleaning
fonts and sizes

Paste Plain Text

The flash dialog is used for working with flash files - inserting and
uploading animations. See also: Adding a Flash Animation

The Windows media dialog is used for inserting and uploading media
objects (AVI, MPEG, WAV, etc.). It also lets you set the object?s

properties. See also: Adding a Media Animation

Pressing this button will open the 'Document Manager' dialog which
allows you to link the selected text with another page. See also:
Adding Page Links

Strips (removes) the formatting from the selected text. Removes
Word?, custom or all formatting.

Toggles borders of all tables within the editor ON and OFF. The ON
function works on tables which have hidden borders.

This button toggles the positioning type for a selected object.
Pressing this button will allow you to drag and drop an object (image,
table or media) freely within the editor.

The default positioning type is relative, which means that an object is
positioned inline (or relative) to other objects. When the positioning
type is absolute, the object can be placed anywhere on the page

Cuts the selected content and copies it to the clipboard. The [Cut]
button works on selected text, image and/or table. Select the
content and then [Cut] it.

When using this tool, the cut text or image will be removed from the
page and will be stored in the clipboard for later use. Please, note
that only the last cut (or copied) item will be stored in the clipboard.
This tool is very helpful if you have decided to change the place of a
piece of text in the sentence or in the page.

Copies the selected content to the clipboard. The [Copy] button
works on selected text, image and/or table. Select the content first
and then [Copy] it.

When using this tool, the content will be stored in the clipboard for
later use. Note that only the last copied (or cut) item will be stored in
the clipboard.

This tool is very helpful if you need to type the same text many
times: just select the text, press the button, place the cursor on the
new place and press the [Paste] button. This procedure works for
images and/or tables as well.

Pastes copied content from the clipboard into the editor. After you
have either [Cut] or [Copied] an item (text, image, etc.), you can
[Paste] it using this button. Place the cursor where you want the item
to appear and press the [Paste] button.

Pastes copied content from the clipboard into the editor. After you
have either [Cut] or [Copied] an item (text, image, etc.), you can
[Paste] it using this button. The editor will clean all unnecessary
Microsoft Office related tags. Place the cursor where you want the
item to appear and press this button.

In case the user is trying to paste Word content with the regular
Paste button or Ctrl V, a dialog will prompt whether the Word markup
should be cleaned. If the Clipboard content does not come from
Word, the dialog will not be shown.

Pastes copied content from the clipboard into the editor. After you
have either [Cut] or [Copied] an item (text, image, etc.) in Microsoft
Word ?, you can [Paste] it using this button. The editor will clean all
unnecessary Microsoft Office related tags plus font formatting. Place
the cursor where you want the item to appear and press this button.

Pastes copied content from the clipboard into the editor. After you
have either [Cut] or [Copied] an item (text, image, etc.), you can
[Paste] it using this button. The [Paste Plain Text] button works
similarly to [Paste from Word] , but it removes all HTML formatting
and pastes plain text, preserving the line breaks.
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Style -

Mormnal -

I~

X,

Paste as HTML

Undo

Redo

Style

Paragraph Style

Italic

Justify

Background
Color

Indent

Outdent

Numbered List

Bullet List

SuperScript

SubScript

After you have either [Cut] or [Copied] an item (text, image, etc.),
you can [Paste] it using this button. This tool allows you to paste the
HTML content of the Clipboard as code, which may be quite
convenient for developer-oriented applications (e.g. support
systems, forums, etc.) The pasted text will look something like this:

<IMG src=" originalAttribute="src" originalAttribute="src"
originalPath=" originalAttribute="src" originalPath="""
logo.gif'><BR><BR><FONT face="Arial"><STRONG>WAhat's new in
this version</STRONG></FONT>

Undoes the previous action. Pressing this button will [Undo] the last
action you have made in the editor. This includes but is not limited to
inserting tables, moving images and formatting text.

Pressing the down arrow next to this button will open a dropdown
where you can select from a list of previous actions.

Redoes the last undone action. Pressing this button will [Redo] the
action you have just undone. Pressing the down arrow next to this
button will open a dropdown where you can select from a list

of actions that can be redone.

Applies predefined styles to a selected element such as text, image,
table, etc. This dropdown menu contains predefines styles contained
in the project stylesheet. See also: Styles

Applies standard or predefined text styles to the selected
paragraph. Click anywhere in the paragraph you want formatted and
select the preferred style from the dropdown.

Applies italic formatting to the selected text. Select some text and
press this button to apply Italic formatting. If the cursor is positioned
in a single word, pressing this button will apply italic to the entire
word.

Pressing this button will justify the selected paragraph to the left and
to the right at the same time.

Changes the background color of the selected text. This dropdown
allows you to change the background color of the selected text.

This button indents a paragraph to the right. Each time this button is
pressed, the paragraph will be indented further to the right.

Decreases paragraph indent to the left. This button works only if
indent has been applied to a paragraph beforehand. To use this
button, click anywhere in the paragraph you want indented to the
left and press the button.

Creates a numbered list from the selection. Select some text or place
the cursor inside a paragraph and press this button to make the text
a numbered list. Pressing this button again will turn the numbered list
into a regular paragraph of text.

Creates a bulleted list from the selection. Select some text or place
the cursor inside a paragraph and press this button to make the text
a bulleted list. Pressing this button again will turn the bulleted list into
a regular paragraph of text.

Makes text or numbers appear as superscript. When typing text, you
may press this button to make the text that follows superscript. The
button also works on selected text. You have to press the button
again to switch to normal text typing.

Makes text or numbers appear as subscript. When typing text, you
may press this button to make the text that follows subscript. The
button also works on selected text. You have to press the button
again to switch to normal text typing.

Applies strikethrounh formatting to selected text. Select some text
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A Strikethrough
+—

= New Paragraph
@ Insert Symbol
If Insert Form

= Element

”
ifli

Horizontal Ruler

Insert Date
(%= Insert Time
See also

System Toolbar

Contents Toolbar

Function Toolbar

Editor Toolbar

Skin Editor Toolbar

Page Template Editor Toolbar

and press this button to apply strikethrough formatting. If the cursor
is positioned in a single word, pressing this button will strikethrough
the entire word.

Inserts a new paragraph. There is a difference between pressing this
button and pressing [Enter]. The latter creates a new line keeping
the paragraph formatting whereas [new paragraph] creates a new
paragraph, with different paragraph settings which can be changed
later on. This feature is important when you apply indentation and
justification to text.

Inserts special characters. Pressing this button will display a drop-
down menu, displaying the special characters that can be added to
the page. The special character will be inserted at the location of the
cursor.

Inserts a form element such as a text box, checkbox, button, etc.
Pressing this button will display a drop-down menu allowing you to
select the form element that you wish to insert.

Pressing this button will insert a horizontal line at the
current cursor position.

Pressing this button inserts the current date at the current
cursor position.

Pressing this button inserts the current time at the current
cursor position.
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Home > Toolbar Reference > Page Template Editor Toolbar

Page Template Editor Toolbar

Page Template Editor Toolbar Reference

E Image Pressing this button will open the image dialog which allows you to
Manager manage images ? inserting, uploading and setting image properties.

Hyperlink Assigns a hyperlink to the selected text or image. The hyperlink dialog
& Y window will open. It allows you to choose the type of link you want to

Manager insert: Hyperlink, Anchor or E-mail. See also: Links
D Pressing this button will open the ‘Document Manager' dialog which
Iy ocument : . X ’
@ M allows you to link the selected text with another page. See also: Adding
anager :
Page Links
Inserting a table works similarily to Microsoft Word?. Click the 'Insert
E Insert Table Table' button and select how many rows and columns are desired. The
table will be inserted at the current cursor position. See also: Working
with Tables
Font Name Sets the font typeface. This dropdown allows you to change the font of
the selected text.
Font Size Sets the font size. This dropdown allows you to change the font size of

the selected text.

Applies bold formatting to the selected text. Select the text and press
B Bold this button to apply bold formatting. If the cursor is positioned in a single
word, pressing this button will bold the entire word.

Applies underline formatting to selected text. Select some text and
press this button to apply underline formatting. If the cursor is

u nderlin: > . h B A ) A )
= Underline positioned in a single word, pressing this button will underline the entire
word.
Applies italic formatting to the selected text. Select some text and press
r Italic this button to apply Italic formatting. If the cursor is positioned in a

single word, pressing this button will apply italic to the entire word.

& Background Changes the background color of the selected text. This dropdown
Color allows you to change the background color of the selected text.
= Align Left Aligns the selected paragraph to the left.

Align Center Centers the selected selected paragraph.

= Align Right Aligns the selected paragraph to the right.
A Foreground Changes the color of the selected text. This dropdown allows you to
color change the font color of the selected text.
Cuts the selected content and copies it to the clipboard. The [Cut]
button works on selected text, image and/or table. Select the content
and then [Cut] it.
a-. cut When using this tool, the cut text or image will be removed from the

page and will be stored in the clipboard for later use. Please, note that
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EE] Copy

F=Y Paste

Ei% s_Zitte Plain

) Undo

) Redo
See also

System Toolbar
Contents Toolbar
Function Toolbar
Editor Toolbar

Skin Editor Toolbar
Variable Editor Toolbar

only the last cut (or copied) item will be stored in the clipboard. This tool
is very helpful if you have decided to change the place of a piece of text
in the sentence or in the page.

Copies the selected content to the clipboard. The [Copy] button works
on selected text, image and/or table. Select the content first and then
[Copy] it.

When using this tool, the content will be stored in the clipboard for later
use. Note that only the last copied (or cut) item will be stored in the
clipboard.

This tool is very helpful if you need to type the same text many times:
just select the text, press the button, place the cursor on the new place
and press the [Paste] button. This procedure works for images and/or
tables as well.

Pastes copied content from the clipboard into the editor. After you have
either [Cut] or [Copied] an item (text, image, etc.), you can [Paste] it
using this button. Place the cursor where you want the item to appear
and press the [Paste] button.

Pastes copied content from the clipboard into the editor. After you have
either [Cut] or [Copied] an item (text, image, etc.), you can [Paste] it
using this button. The [Paste Plain Text] button works similarly to [Paste
from Word] , but it removes all HTML formatting and pastes plain text,
preserving the line breaks.

Undoes the previous action. Pressing this button will [Undo] the last
action you have made in the editor. This includes but is not limited to
inserting tables, moving images and formatting text.

Pressing the down arrow next to this button will open a dropdown where
you can select from a list of previous actions.

Redoes the last undone action. Pressing this button will [Redo] the
action you have just undone. Pressing the down arrow next to this
button will open a dropdown where you can select from a list of actions
that can be redone.
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FAQ

The 'FAQ' section includes answers to common questions, 'tips and tricks' and solutions to difficulties that users have previously encountered.

Al Al

General Questions  Installation Questions

See also
Welcome

Getting Started
Installation

Basic Functions
Advanced Functions
Toolbar Reference
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Home > FAQ > General Questions

6 General Questions

" Is there a way to temporarily move a Project to my notebook while I'm out of the office?

& Yes. as long as you have HelpConsole 2010 installed on your notebook, you can create a backup of the project from the web
server and then upload it to HelpConsole 2010 on your notebook. See Backing up Your Project and Uploading a Project

""" Can the HelpConsole 2010 branding be removed from the published Help System?

& Yes, you can remove all of the ExtremeEase branding. The company name and product name are displayed on some skins,
but this can be easily changed to your branding or just removed. This is done by editing the Skin.

" Can | hide pages in the Table of Contents until I've finished writing the content?
& Yes, pages can be temporarily hidden via the 'Page Properties' dialog. For more information, See Conditional Content

" Is there a way to insert <p>instead of <br>when the enter key is pressed?

& No. Some html editors insert a <p> tag when the enter key is pressed, however mostly for the sake of simplicity, the
HelpConsole editor inserts a <br> tag when the enter key is pressed. To quickly insert a <p> tag, press CTRL M, or click the
‘add paragraph’ button on the toolbar.

" Can | customize the icons in the "Sibling Icon List" and the "Child Icon List"?

& Yes. By default folder icons are displayed, but you can display custom icons by placing your own images in the 'images’ folder
with the format <pagename=.gif. For example if you had a page named "my page" then the image would be named "my
page.gif". For more information, see Customizing Page Icons

See also
Installation Questions
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@ Installation Questions

" Can HelpConsole 2010 be run on my company Intranet?

& Yes. HelpConsole 2010 can be installed on an internal Intranet web server. Employees at any office branch can run the software via a Standard

browser. The URL will be one of the following:
<IP Address>/HelpConsole2010 example: 102.5.3.100/HelpConsole2010
<Server Name>/HelpConsole2010 example: WebServerl/HelpConsole2010

“" Does HelpConsole 2010 run on a Unix web server such as Apache?

& You can publish a static help system that will run on any server including Unix, Linux, etc. However in order to run the help editor or run a dynamic
help system, the software must be installed on a Windows based server running I1S. See System Requirements for more details.

See also
General Questions
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